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CHAPTER 1

GETTING STARTED 
WELCOME! 
Thank you for evaluating EasyCatalog for Adobe InDesign. 

65bit Software are committed to providing high quality software for Adobe InDesign, 
and appreciate the time you have taken to evaluate our product. All feedback is 

welcome, good or bad. Please email any comments to support@65bit.com or use our 
support form on the website. We promise to respond to every one!

WHAT IS EASYCATALOG? 
EasyCatalog is a complete database publishing solution, and provides a bi-drectional 
link between data from a variety of sources to content in an InDesign document. Any 
changes made in the document may be reflected back to the original source of the 
data.

Document content is constantly tracked, enabling you to determine which records and 
fields are placed. Document tracking offers a number of benefits:

 Ҙ Increased productivity:

Data can be acquired from a variety of data sources quickly and efficiently. Time is 
not spent re-keying or importing data.

• Errors are reduced, as data on the page is coming directly from the data 
source without being re-keyed.

• Errors are detected. EasyCatalog can highlight all fields that differ to the 
original data, and either automatically correct them or highlight them for manual 
correction in the document.

• Data can be filtered and grouped to only show data relevant to a particular 
section of the publication, for instance.  Filtering your data reduces the amount of 

time spent searching through data that is not relevant to the task you’re currently 
performing.

• Data that has been changed on the database can be updated in the document 
instantly  – ideal for deadline-critical publications.

• Records can be dragged and dropped to the page using pre-defined templates 
stored in libraries.  Placeholders in the templates show EasyCatalog where and 
how each field should appear, and complex page layouts containing live linked 
data can be constructed in seconds.

 Ҙ Powerful pagination facilities

EasyCatalog contains of wealth of facilities for both data driven and design driven 
publications.

• Formatting may be applied to fields, ensuring that all prices, for instance, 
appear in a consistent format throughout the publication. Any prices that do 

mailto:support%4065bit.com?subject=EasyCatalog%20Support%20Request
https://www.65bit.com/support/
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not obey these formatting rules will be highlighted as part of the error-checking 
procedure.

• Library styles may be defined for records, ensuring records appear in a 
consistent manner. See ‘Templates and Libraries’

• EasyCatalog offers powerful tabular data functionality, allowing tables to be 
created from your data at the click of a button.

• Using the optional pagination module,  EasyCatalog can automatically create 
a flow of several hundred pages.

• EasyCatalog leverages the typographical and layout features of InDesign, so 
the layout and style of your publication doesn’t have to suffer.

 Ҙ Reduced cost of ownership

• EasyCatalog is a front-end for existing databases – you purchase the plug-
in and we, or a systems integrator, provide Data Provider plug-ins to access 

your data. Data can be imported from a delimited file (such as a comma or tab-
delimited file), ODBC database or an XML file.

• As there is no new ‘production’ database to integrate with, there will be no 
integration issues, or unwanted database licenses. 

• As EasyCatalog is tightly integrated with Adobe InDesign, there is no new 
application environment to learn.  

30 DAY TRIAL VERSION 
Your EasyCatalog plug-in will run in demo mode until a valid registration code is entered. 
The EasyCatalog trial is valid for thirty days from the date it is first run.  

Thank you for taking time to evaluate EasyCatalog – if you have any questions or would 
like further information, please visit our web site at www.65bit.com.

We are here to help you with during your evaluation so if you have any questions 
whatsoever, please contact us using the support form on our website.

We aim to respond to all enquiries within one working day of receiving them.

Whilst you are evaluating EasyCatalog, the ‘About EasyCatalog’ dialog will appear 
each time you launch InDesign showing the number of days remaining in your trial 
period.

PURCHASING EASYCATALOG
If you’ve purchased or downloaded EasyCatalog from one of our partners, please 
obtain your serial number through them.  Alternatively if you downloaded from the 65bit 
web site, serial numbers can be purchased through our web-store.

https://www.65bit.com/pricing/buy-upgrade/

Serial numbers purchased via our web-store will be issued on completion of the credit 
card transaction, and will activate in around 5 - 10 minutes.

http://www.65bit.com
https://www.65bit.com/support/
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The number of days remaining in your trial period 
are shown in the ‘About EasyCatalog’ dialog.

Once you have purchased a serial number, use 
the ‘Activate’ button to activate your copy of 

EasyCatalog.

ACTIVATING EASYCATALOG
Following purchase, you will be supplied with a serial number for each of the modules 
that you have purchased. 

EasyCatalog uses internet activation to validate your license codes, which typically 
takes a few seconds to process.  Once registered, all limitations of the demo version 
will be lifted.  

Internet activation offers many advantages, including the ability to purchase additional 
licenses at a later date whilst retaining the same serial number.  Internet activation 
also helps to ensure that you do not unintentionally violate your EasyCatalog license 
agreement.

To activate, select ‘About EasyCatalog’ from the InDesign application menu (on the 
Macintosh), or from ‘Help’ menu (on Windows).

When the ‘About EasyCatalog’ dialog appears, press the ‘Activate’ button to enter 
the serial numbers you have been issued. The serial number should be entered exactly 
as it appears in your order confirmation email, including the hyphens.  

If you have an active internet connection, your serial number will be validated on our 
servers and your software will activate after a few seconds. 

ACTIVATING WITHOUT AN INTERNET CONNECTION

If you do not have an active internet connection, alternative options will be offered after 
you have entered your serial number:

• Activation using a web-browser on your InDesign machine

• Activation using a web-browser on another machine (with a valid internet connection).

On-screen instructions will step you through the above processes:  the website you are 
sent to will issue you with an Activation Code, which should be entered into the Manual 
Activation wizard that appears.

COMMON ACTIVATION ERRORS

An attempt was made to activate an unknown serial number.  If you have recently 
purchased this serial number, please wait around 15 minutes before trying again.  If 
the problem persists, please contact your vendor.

The most common cause of this error is entering the serial number incorrectly.  Please 
ensure that you enter the complete serial number (including all dashes). EasyCatalog 
serial numbers do not contain the letters ‘I’, ‘O’, ‘U’ or ‘Z’ as these can be confused 
for other characters. Try copying and pasting the serial number from your order 
confirmation email into the activation dialog.

Sometimes, if you’ve recently purchased the serial number through our web store, you 
may need to wait 10 - 15 minutes before the serial number will activate. 

An attempt was made to activate a blacklisted serial number.

The serial number you have entered has been blacklisted and cannot be used to activate 
EasyCatalog.  Please contact the vendor who sold the license for further information. 
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An activation attempt failed due to the maximum number of allowable activations 
being met.

The number of allowable activations for this serial numbers has now been reached 
and this EasyCatalog serial number cannot be activated.  If you are installing onto a 
new machine, please ensure that you de-activate your serial number and wait 10 - 15 
minutes before attempting to activate on your new machine.  See ‘Transferring an 
Activation’ below.

If you need further assistance please contact us using the support form.

An error occurred trying to install the eSellerate engine. Please purchase via the 
Web store or contact support@65bit.com for more information.

The e-commerce component of EasyCatalog (eSellerate) could not be installed. 

The most common cause of this issue is insufficient user privileges.  On Windows 
machines, right click on the InDesign application icon and select ‘Run as Administrator’.  
Once registered, InDesign can be started without Administrator privileges.

In the event of this error persisting, please download and install the ‘eSellerate Engine’ 
from: http://www.esellerate.net/update

TRANSFERRING AN ACTIVATION
To transfer an activation for all registered modules, press the ‘Deactivate’ button on the 
‘About EasyCatalog’ dialog.

To transfer an activation for an individual module, highlight the serial number that you 
would like to transfer in the list of active modules and press the ‘Deactivate’ button.

Transfer an activation using the ‘Deactivate’ 
button.  This button will only be available when 

all modules shown in the list are activated.

To deactivate a specific serial number, select 
it in the list and then press the ‘Deactivate’ 

button.

After a few seconds your serial number will deactivate and you should be able to 
activate the serial number on another machine in around 5 - 10 minutes.

If you have any problems with activation, please contact us using the support form on 
our website.

KEEPING UP TO DATE
Periodically, bug fixes and enhancements are released on our website.  Please use the 
‘Check for Updates’ button on the ‘About EasyCatalog’ dialog to ensure that you are 
always running the latest version of EasyCatalog.

https://www.65bit.com/support/
http://www.esellerate.net/update
https://www.65bit.com/support/
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SUPPORT QUESTIONS
All support issues should, in the first instance, be directed to your system integrator or 
local reseller.  Alternatively, visit us at www.65bit.com, or contact us using the support 
form on our website.

INTEGRATION OPPORTUNITIES
EasyCatalog has been designed for easy integration into third- party database and 
asset management systems. Systems integrators who are interested in integration 
opportunities should contact us at sales@65bit.com

RESELLERS
Please contact sales@65bit.com if you are interested in reselling EasyCatalog, or are 
considering including EasyCatalog as part of your solution.

https://www.65bit.com/support/
https://www.65bit.com/support/
mailto:sales%4065bit.com?subject=EasyCatalog%20Integration
mailto:sales%4065bit.com?subject=EasyCatalog%20Integration
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CHAPTER 2

IMPORTING YOUR DATA 
INTRODUCTION 
The first stage in the process, importing your data is the most critical and key area 
when using EasyCatalog.  The quality of your source data has a direct impact on the 
quality of the results that can be achieved using EasyCatalog.

By directly importing your data into InDesign, you eliminate re-keying errors and 
significantly reduce the amount of time required to produce your publication.

Once your data has been imported, it is shown in a spreadsheet-style panel that sits 
alongside your other InDesign panels.  Multiple EasyCatalog panels can be open at any 
time, allowing you to work on publications that use data from multiple sources.

SUPPORTED DATA SOURCES 
EasyCatalog uses Data Providers - other InDesign plug-ins written to interface with 
EasyCatalog - to import your data. Examples of data sources are CSV (comma 
separated) files, a Google Docs Spreadsheet, or a MySQL database.

Data Providers are provided as separate modules that must be installed alongside 
EasyCatalog. All of the Data Provider plug-ins are available for installation during the 
EasyCatalog installation process.

Data sources you’ve 
previously configured

Import new data 
using on of the 
installed Data 

Providers

Each of the available Data Providers are shown on the File→New→EasyCatalog Panel 
menu.  This menu is split into two sections: the top half allows you to import data from 
a new source; the bottom allows you to create a new panel from an existing data 
snapshot. 

The configuration required to import your data depends on the type of data you are 
importing:

 Ҙ Delimited Files

Delimited files include comma and tab delimited files. These types of files can 
typically be exported from most databases and applications such as Microsoft 
Excel.  Further information on importing delimited files can be found on page 15.

 Ҙ Excel Spreadsheets

EasyCatalog can directly import Microsoft Excel files (either .xls or .xlsx files). 
Only the textual content of the file is imported; any formatting is ignored.  Further 
information on importing Excel spreadsheets can be found on page 17.

 Ҙ Google Docs Spreadsheets

If your data is stored in the cloud in a Google Docs Spreadsheet, EasyCatalog can 
connect directly to it and import your data in the same way as importing a local 
Excel file.  Further information on imported data from a Google Docs Spreadsheet 
can be found on page 18.
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 Ҙ Data from an ODBC-compliant Database

The optional ODBC Data Provider module enables EasyCatalog to connect directly 
to an ODBC database such as MySQL, Microsoft SQL Server, FileMaker or Access.  
An appropriate ODBC driver is required. On Windows, these are typically provided 
by the database vendor; on Macintosh, you may need to purchase a driver from 
a third-party vendor such as Actual Technologies or OpenLink Software.  Further 
information on importing from an ODBC database can be found in the “ODBC Data 
Provider User Guide” which can be downloaded from our website.

 Ҙ XML

Using the optional XML Data Provider module EasyCatalog can import an XML 
structure either from a local file or by connecting to a URL endpoint. The location of 
each record and field within the XML structure is defined using XPath.  Please see 
the XML Data Provider User Guide for further information on importing XML data. 

Support for the following data types is provided by the optional Enterprise Data 
Provider module.  Further information on configuring the Enterprise Data Provider 
module can be found in the “Enterprise Data Provider User Guide” which can be 
downloaded from our website.

 Ҙ Elvis

Assets stored in your Elvis DAM can be directly imported into EasyCatalog. Images 
are downloaded on demand via HTTP, and all metadata for the assets is shown in 
the EasyCatalog data panel.

 Ҙ ADAM

Connect directly to your ADAM PIM database.

 Ҙ Salsify

Import data from Salsify channel directly into EasyCatalog.

 Ҙ Sales Layer

Import data directly from Sales Layer into EasyCatalog.

Additionally, the optional Relational Module can be used to join multiple EasyCatalog 
data sources together in a single panel. It also has the ability to import data from an 
SQLite database.

For System Vendors, Custom Data Providers can be written and tailored to your 
requirements - please contact us for further information.

DATA CONCEPTS
Regardless of the source of your data, there are a number of concepts that are common 
to all data that is imported into EasyCatalog: 

 Ҙ Fields

A field is a singular piece of information, such as a person’s name, job title or zip 
code. Analogous with a cell in an Excel spreadsheet. 

 Ҙ Records

A record is a collection of related fields which, when combined, describe something 
or someone.  For example, a ‘customer’ record would contain ‘name’, ‘address’, 
and ‘telephone’ fields.  Combined, these fields describe a single customer.

 Ҙ Rows and Columns

When arranged in a grid, or spreadsheet-style view, each record is represented by 
a row in the table; each field is a cell.  Therefore, a column is a collection of fields 
and all fields in the column contain the same type of information (i.e. all fields in the 
‘address’ column will contain address information).

 Ҙ Field Types

Each field that is imported into EasyCatalog has a ‘type’ that determines both 
how it appears in the document and how it is treated when it is sorted, grouped, 
etc. Field types are defined on a column-by-column basis, so all fields in the same 
column will share the same type information.

Field types typically fall in to one of two categories, each with further refinements.

http://www.actualtech.com
http://www.openlinksw.com
https://www.65bit.com/software/easycatalog/documentation/
https://www.65bit.com/software/easycatalog/documentation/
https://www.65bit.com/support/
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Alphanumeric fields can contain both text and numeric information, and will be 
sorted alphabetically on a character-by-character basis.

Numeric fields can only contain numeric information, although additional formatting 
can be applied to show currency symbols, thousands and decimal separators, etc. 
Numeric fields are sorted based on their numeric content.

 Ҙ Key Fields

To keep track of each record in your data source, EasyCatalog needs a way to 
uniquely identify each record. To do this, we use a ‘key field’.

!
The choice of key field is critical to the operation of 
EasyCatalog.  The key field is used to uniquely identify 
each record from the data source and must never 
change.

The content of the key field must uniquely identify each record and must never 
change for the life of the record.  Typically key field candidates can be a stock code, 
SKU, etc.

If the key field value for a record changes, EasyCatalog will determine that a record 
has been deleted (with the old key field value) and a new one created (with the new 
key field value).  Fields placed in a document linked to the old key field value will be 
shown as ‘in error’.

More than one field can be selected as the key field.  In this case, the combination 
of all of the chosen fields is used to determine the uniqueness of each record. As 
with a single key field selection, the content of all key fields must remain constant 
for the life of the record.

Choosing multiple fields can sometimes be necessary if the same record appears 
more than once in the data.  In this case, it is necessary to identify an instance of 
each record using a combination of fields. 
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IMPORTING FROM A CSV/DELIMITED FILE 
➀ The process begins by selecting ‘New File Data Source’ from the File→New→New 
EasyCatalog Panel menu option.

➁ Select your data file using the standard InDesign file selection dialog.

EasyCatalog will now examine the file to determine the best settings for importing your 
data - these will be presented in the configuration dialog.  Don’t panic! This is by far the 
most complex stage in configuring EasyCatalog - for the majority of users, the settings 
determined by EasyCatalog will suffice.

Example File

The Field Delimiter: the character used to 
separate each field in the file (in this example, a 

comma)

The first row in this file contains the names of each of the columns, so the ‘First Record contains field 
names’ check-box should be set.

The Record Delimiter: the character used to 
separate each record in the file (in example, a 

carriage-return)

The name which will be used to identify this data 
source ➊➋

➌ ➍

➊ Location

Shows the path to the selected file, and allows a new file to be chosen.  Use the 
‘Reveal’ button to go to the file in Windows Explorer (Windows) or the Finder 
(Macintosh).
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➋ Content

The menus in this area allow you to specify how the file is structured.  When 
importing a file for the first time, EasyCatalog will attempt to automatically determine 
the correct settings for each of these pop-ups by inspecting a sample of the file.

Setting Description

File Encoding
Specify the type of file being used - either ASCII or Unicode.  

EasyCatalog provides full support for importing unicode files and can import 
UTF-8 and UTF-16 encoded Unicode files.

Field Delimiter Specify the character that’s used to separate each field in the file

Record Delimiter Specify the character that’s used to separate each record in the file

First record contains 
field names

Typically, most data files contain the names of the columns in the first row/
record.  

If your data file does not contain this information, un-check this box.  Default 
field names will be assigned to each column when the data is imported.  It is 
strongly recommended that field names are included in your data file to ensure 
the links to fields in the document are not broken if extra columns are added 
to your data at a later date.

Automatically Detect 
Type of New Fields

When this option is set, EasyCatalog will attempt to determine the type 
(whether the field is alphanumeric, numeric, etc) of each field. Turn this 
option off to default all fields to alphanumeric. 

➌ Sample

Each time any of the ‘Content’ settings are changed, the ‘Sample’ pane will change 
to show how the file will be imported using the current configuration. If you are 
unsure of the settings to specify, you can experiment until the desired results are 
shown in the ‘Sample’ pane.

The Sample pane is also used to allow columns to be selected to specify column 
data type/content information. Select a column in the table to activate the settings in 
the ‘Field Information’ pane. Note that clicking anywhere in the column will highlight 
the entire column.

➍ Field Information

Select a column in the Sample pane to enable the Field Information options. 

Key

Before importing your data, you need to define a ‘key’ column.  The content of this 
column determines the uniqueness of each records being imported, and the choice 
of key field is critical to the successful operation of EasyCatalog.  EasyCatalog will 

attempt to automatically determine which of the columns could be used as a key 
by looking for columns containing unique values.  However, it is critical that you 
confirm that the correct column has been chosen before working with your data 
source.

For further information, see ‘Key Fields’ on page 14. 

To define a key field, select the column in the ‘Sample’ panel and check the ‘Key’ 
checkbox.

Formatting Fields

Wherever possible EasyCatalog attempts to set the type of each field by looking at 
the content of each column.  The field type can be adjusted using the ‘Options...’ 
button.

Further information on formatting data using the Field Options dialog can be found 
on page 22.

Once you are happy with the configuration options, press the OK button to import 
the file.  If the configuration is correct, a new EasyCatalog panel will open showing 
a spreadsheet-style view of your data.  Further information on working with the 
EasyCatalog data panels can be found in the ‘Panels’ chapter.
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IMPORTING FROM AN EXCEL SPREADSHEET
➀ The process begins by selecting ‘New Excel Data Source’ from the File→New→New 
EasyCatalog Panel menu option.

➁ Select your data file using the standard InDesign file selection dialog.

The name which will be used to identify this data source ➋

➌

➊

➍

➊ Location

Shows the path to the selected file, and allows a new file to be chosen.  Use the 
‘Reveal’ button to go to the file in Windows Explorer (Windows) or the Finder 
(Macintosh).

➋ Content

Choose which sheet to import from the Excel workbook using the ‘Sheet’ pop-up. 
Alternatively, select ‘All sheets’ to import data from all sheets in the workbook. 
EasyCatalog will create a unique list of field names from across all sheets and create 
a ‘Sheet Name’ field for each record that will be populated with the name of the 
sheet that the record belongs to.

The ‘Range’ popup shows the data ranges defined in the Excel worksheet and 
allows a portion of the records and fields in the sheet to be imported.

‘Ignore Rows With One Cell of Data’ will ignore any rows in the spreadsheet where 
only a single cell is populated.  This setting is generally used for spreadsheets where 
headers have been inserted amongst the data in Excel. 

➌ Sample

The sample pane shows a preview of the data as it will be imported by EasyCatalog. 
When a column is selected in this area the Field Information pane will be available. 

➍ Field Information

Before importing your data, you need to define a ‘key’ column.  The content of 
this column determines the uniqueness of each records being imported, and the 
choice of key field is critical to the successful operation of EasyCatalog.  For further 
information, see ‘Key Fields’ on page 14. 

To define a key field, select the column in the ‘Sample’ panel and check the ‘Key’ 
checkbox.

Formatting Fields

Wherever possible EasyCatalog attempts to set the type of each field based on the 
format of the cells in Excel.  

For example, fields that are numeric in Excel will also be numeric in EasyCatalog.  To 
change the format of a column, select it in the ‘Sample’ pane and use the ‘Options...’ 
button to display the Field Options dialog. Further information on formatting data 
using the Field Options dialog can be found on page 22.

Once you are happy with the configuration options, press the OK button to import 
the file.  If the configuration is correct, a new EasyCatalog panel will open showing 
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a spreadsheet-style view of your data.  Further information on working with the 
EasyCatalog data panels can be found in the ‘Panels’ chapter.

Common Errors and Warnings

Common Errors and Warnings can be found on page 20.

IMPORTING FROM A GOOGLE DOCS SPREADSHEET
➀ The process begins by selecting ‘New Google Docs Spreadsheet Data Source’ 
from the File→New→New EasyCatalog Panel menu option.

➁ Press the ‘Authenticate’button on the configuration that appears.

To connect to your Google Docs account you must first authorize EasyCatalog to 
access it by pressing the “Authenticate” button.  This needs to be done for each 
Google Doc Spreadsheet data source you configure.  As authentication is required 
for each new data source, it is possible to import data from multiple Google Docs 
accounts.

Authentication is via a web browser using the standard Google Docs authentication 
mechanism.  On the web page that appears you will be shown the information 
EasyCatalog is attempting to access.  If at any time you need to prevent EasyCatalog 
from accessing your Google Docs account, you can remove EasyCatalog from “My 
Account” in Google Docs.

After pressing the “Authenticate” button, EasyCatalog will wait for a response from 
Google.  During this time, a “Waiting for Authorization” dialog will appear: do not 
cancel this dialog until you have logged in via the browser window, or unless you 
want to canel the log-in. You should be switched back in to InDesign once you’ve 
completed the authorization process in your browser.

The name which will be used to identify this data 
source ➊ ➋

➌ ➍
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➊ Authentication

Once authenticated, your Google Docs user name will be shown here. Occasionally 
it is necessary to re-authenticate: the can happen, for example, if you remove 
EasyCatalog’s access to your Google Docs from your Google account.

➋ Content

Select the name of the spreadsheet you would like to import using the “Spreadsheet” 
pop-up.  You can then choose to import an individual sheet from inside of the 
spreadsheet using the “Sheet” pop-up. Alternatively you can select “All Sheets” to 
import data from all sheets within the spreadsheet. A ‘Sheet Name’ field will also be 
created and populated with the name of the sheet that the record belongs to.

The ‘Range’ popup shows the data ranges defined in the spreadsheet using the 
‘Data→Named Ranges’ menu option in Google Docs. Only data defined by the 
selected range will be imported into your new data source.

➌ Sample

The sample pane shows a preview of the data as it will be imported by EasyCatalog. 
When a column is selected in this area the Field Information pane will be available. 

➍ Field Information

Before importing your data, you need to define a ‘key’ column.  The content of 
this column determines the uniqueness of each records being imported, and the 
choice of key field is critical to the successful operation of EasyCatalog.  For further 
information, see ‘Key Fields’ on page 14. 

To define a key field, select the column in the ‘Sample’ panel and check the ‘Key’ 
checkbox.

Formatting Fields

The field type for all fields imported from Google Sheets is set to ‘Alphanumeric’. To 
change the format of a column, select it in the ‘Sample’ pane and use the ‘Options...’ 
button to display the Field Options dialog. Further information on formatting data 
using the Field Options dialog can be found on page 22.
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COMMON ERRORS AND WARNINGS 
Common import problems, along with possible resolutions are shown below:

A data source of this name already exists in your workspace folder.  Do you want to 
overwrite it?

You are attempting to open a data source with the name of a data source that already 
exists.  You may continue by answering ‘yes’ to this dialog, but the previous version of 
the data source will be deleted.

A data source of the same name is already open.  Please use another name or close 
all related panels and try again.

You are attempting to open a new data source using the name of a data source that 
already exists.  Although similar to the above error message, you cannot continue as 
panels for the old data source are still open.  To overwrite the old data source, close its 
data panels using the ‘Close Panel’ menu option - you may need to show hidden data 
panels using the ‘EasyCatalog Panels’ menu on the Window menu.

A duplicate key was detected (value).  Please check your data provider configuration 
and try again.

EasyCatalog idenitifes each field in the document using a combination of the data 
source name, field name and key field value.  Therefore, each of these elements must 
be unique in order to indentify every placed field.

In the column(s) you have nominated as the key field(s), you have duplicate values (the 
value that is duplicated is shown in the error).  To overcome this, remove duplicate keys 
from the source data or check that your key field configuration is correct.

Field names must be unique - ‘(field name)’ appears more than once

EasyCatalog idenitifes each field in the document using a combination of the data 
source name, field name and key field value.  Therefore, each of these elements must 
be unique in order to indentify every placed field.

In your configuration you have selected ‘First record contains field names’, but the first 
record contains multiple fields with the same name (shown in the error).  To remedy this 
you must change your source data so that it does not include duplicate field names.

Field names must be unique - ‘’ appears more than once

Where no field name is shown in the above error, this usually indicates that your records 
contain more fields than there are field names.  This error will only occur when ‘First 
record contains field names’ is selected.  

To rectify this problem, ensure that each record in the file contains the same number 
of fields, and that the number of fields matches the number of field names supplied in 
the first row/record of the file.

Duplicate records were found and have been removed

Records that contain exactly the same content cannot be imported, as each would 
have the same key field values.  This error is informative, and the duplicate records 
will be removed and the file imported.  You should check to see whether you need to 
import these missing records and, if so, include exta information in the source data to 
differentiate between each record. 

Data cannot be loaded because blank field names were found

All fields imported must have a name, and this error is indicating that one or more have 
empty names.  This error will only occur when ‘First record contains field names’ is 
selected.  Check the source data to ensure that each field has a name, and that the 
number of fields in each record does not exceed to number of field names specified in 
the first record/row of the file.
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DATA CACHING AND THE WORKSPACE FOLDER 
EasyCatalog does not require a permanent connection to your data - by caching your 
data in a local ‘workspace’ folder, you are able to continue working with EasyCatalog 
even when your data source is unavailable.

Your workspace folder also contains all of the settings for each data source you create, 
allowing you to close and re-open data sources without having to re-configure them 
each time.

Caching the data locally also offers other benefits, including highlighting differences in 
the data when new data is retrieved. 

By default, your workspace folder will be configured to be:

Macintosh: Documents:EasyCatalog Workspace 
Windows: My Documents/EasyCatalog Workspace

SPECIFYING A WORKSPACE FOLDER

The location of your workspace folder can also be changed - this can be anywhere on 
your local machine, provided that EasyCatalog always has access to it.

See the ‘Application Preferences’ chapter for further information on how to specify the 
EasyCatalog workspace folder.

Once you have finished with a data source, it can be deleted using the ‘Delete’ button 
from the Information dialog.  To access the ‘Information’ dialog, hit the 
‘info’ button at the bottom of one of the data panels.

Use the Delete button on the Information dialog to permanently delete a data source 
from your workspace folder.
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CHAPTER 3

FIELD OPTIONS  
INTRODUCTION 
EasyCatalog provides facilities for fields to be formatted before placement in a 
document.  By setting Field Options you can, for instance, ensure that your price fields 
are formatted to use the correct currency symbol and number of decimal places.

In addition to text fields, EasyCatalog can also import pictures.  Using the Field Options 
dialog, you can specify whether a picture should be scaled, aligned, etc. when imported.

OPENING THE FIELD OPTIONS DIALOG
The Field Options dialog can be accessed in a number of ways:

 Ҙ When creating a new data source

Select a column in the 'Sample' pane on the Data Source Configuration dialog and 
press the 'Options...' button at the bottom of the dialog.

 Ҙ From the 'Field Options' menu on the data panel's pop-out menu

 Ҙ By holding the Alt key while double-clicking on the field's column header.

AVAILABLE FIELD OPTIONS
The Field Options dialog is split into a number of sections:

 Ҙ Format

The Format pane allows you to define the field type, or how it is formatted when 
it appears on the page. Fields can be defined as Alphanumeric or Numeric, with 
additional options such as importing HTML-formatted text available.  See page 
"The Format Pane" on page 23.

 Ҙ General

Options such as 'prefix' and 'suffix' can be found here, in addition to 'cleansing' 
which can be used to clean-up data before it is formatted.  For further information 
see page "The General Pane" on page 28.

 Ҙ Picture Content

In addition to importing textual content, EasyCatalog can also import pictures either 
from a folder or from a URL.  Additional options such as how the image should be 
scaled and aligned can also be found on the Picture Content pane.  For further 
information see page "Picture Content Pane" on page 30.

 Ҙ Advanced

Advanced field options generally don't need to be configured as the defaults are 
generally correct.  However, options such as the ability to exclude the field from 
certain operations (such as "Update Document") can be found on this pane.  For 
further information go to page "Advanced Pane" on page 33. 
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 Ҙ Database Update

The settings used here are only used when working with a data source that has 
been created using the ODBC Data Provider.  This pane enabled you to specify 
an 'update' statement that is used to update your database (when data has been 
changed in InDesign).  Please refer to the ODBC Data Provider manual for further 
infromation on this pane.

 Ҙ Custom Field

Custom Fields are fields that only exist within EasyCatalog and are populated using 
one of our inbuilt functions.  Please refer to the "Custom Fields" chapter on page 
124 for further information.

THE FORMAT PANE

The Format pane allows you to specify the field's type. The type of the field determines 
how, for example, a field will appear on the page and also how its content is sorted. 
The field type can be selected in the pop-up at the top of the Format pane:

 Ҙ Alphanumeric

Fields that are defined as being ‘Alphanumeric’ will be output to the document 
unchanged - use this option if your field is being formatted correctly by the original 
source of the data, such as a database.

 Ҙ Strip Whitespace

White space, such as tabs, spaces, etc will be stripped from the start and end 
of the field's content.

 Ҙ Formatted

If your source data contains formatted text (text with formatting tags such as 
<b>, <i>, etc) turn on the Formatted check box. For further information see 
'Formatted Text' on page xxx.

 Ҙ Ignore Whitespace Changes

Selecting this option allows minor modifications to be made to the field in the 
document without it being shown as ‘in error’ in the panel.

When checked, this option allows white space to be inserted into the field in 
the document, such as additional carriage-returns, tabs, etc.  Additionally, the 
‘Update Panel’ menu option will only update the field in the panel when non-
white-space characters have been modified.

The list of characters to ignore is can be defined in the text field beneath the 
check box. InDesign metacharacters can be used for characters such as carriage 
return, etc.  For a full list of supported metacharacters see page "InDesign 
Metacharacters/Special Characters" on page 30. 
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 Ҙ Exclude from Panel Updates

The characters listed in the edit field will not appear in the field content when 
using the 'Update Panel' menu option.  This is useful, for example, if you need 
to exclude characters used only by InDesign from appearing in your data source 
content.

 Ҙ Preserve Whitespace on Update

EasyCatalog will attempt to keep the characters listed in the edit field during an  
'Update Document' operation.  This can be used in instances where you need to 
manually insert characters that affect the formatting of the text in the document 
that you would not want to be removed when you update the field.  Note that 
depending on how the source data changes and what needs to be updated it's 
not always possible to correctly preserve the position of these characters.

 Ҙ Number

Specify the number of decimal places required using the 'Format' pop-up.  

 Ҙ Percentage

Decimal values will be converted to percentages with the number of decimal places 
specified by the 'Format' pop-up.  For example, '0.1' will be output as 10%. 

 Ҙ Currency

A number of pre-defined currency formats are available in the 'Format' pop-up. 
For those currencies not listed, please use the 'Custom' field type where you can 
specify currency symbols, the decimal separator to use, etc. 

 Ҙ Custom

Where your needs are not met by any of the available options, the ‘Custom’ option 
allows a number format to be specified either through the use of a formatting string 
or using special keywords. 

➊ ➋

Common formatting strings are defined in the 'Example' pop-up.  Where none of the 
examples are suitable you can define your own in the text field below.

A formatting string should be defined for when the field contains ➊ a positive number 
and ➋ a negative number. The two formatting strings are separated by a semi-colon.

The following characters have special meaning in format strings, all other characters 
will appear untranslated in the output.

Character Meaning

# The most used character, the ‘#’ indicates where digits from the source data should 
appear. 

.
Decimal point. Specifies where the decimal point should appear and, by the use of 
the ‘#’ character after the point, how many decimal places the number should be 
formatted to. No rounding will be performed on the value.
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Character Meaning

, May or may not be present as a divider between groups of digits, such as thousands, 
millions, etc.

*
Used after the decimal point, this character indicates the minimum number of 
characters that must appear.  For example, you can specify that a field must appear 
with at least two decimal places, but more will be output if required.

Examples

The use of the formatting string is best explained by the use of examples:

Format String Your data source 
contains...

Field will be formatted in the document 
as...

$#.## 123456.123456 $123456.12

Only two positions are available after the decimal point.

$###,### 123456.123456 $123,456

The comma may be used to separate groups of digits. No decimal point is provided in the format string, 
therefore the value will appear as a whole number.

$#.#### 123456.123456 $123456.1234

Four places are available after the decimal point – the output value is truncated, not rounded.

# USD 123456.123456 123456 USD

As the characters ‘USD’ do not have any special meaning, they appear untranslated in the output.

###.##* 123456.1 123456.10

123456.1234 123456.1234

Here, the position of the ‘*’ character specifies that a minimum of two decimal places are required.

Custom Formatting Keywords

Instead of the custom formatting string, keywords can also be included to control 
characteristics such as the character(s) used as a decimal point.

Keyword Description Example

PREFIX
Specifies the characters to be 
inserted before the numeric content 
of the field.

[PREFIX=€]

The field will be prefixed with the euro symbol

SUFFIX
Specifies the characters to be 
appending to the numeric content 
of the field.

[SUFFIX=¢]

The field will have a ¢ suffix

Keyword Description Example

DECIMAL Specifies the decimal separator 
(radix point) character(s) to use.

[DECIMAL=,]

The decimal separator will be the comma - e.g.

199,99

PRECISION Specifies the number of digits that 
will appear after the decimal point.

[PRECISION=2]

Values will be formatted to two decimal places

THOUSANDS

Specifies a character or characters 
to use to as the thousands separator.  
The thousands separator is used to 
divide the value into groups of three, 
right-to-left from the decimal point. 

[THOUSANDS=.]

Values greater than a thousand will use a 
comma as a thousands separator - e.g.:

1.234.567

REMOVE
Characters can be optionally 
removed when the content of the 
field matches the specified criteria. 

[REMOVE=0.(<1)]

For values less than 1, remove “0.”

The 'Configure...' button can also be used to automatically enter these formatting 
keywords.

 Ҙ Hyperlink

EasyCatalog can also insert text and image hyperlinks into the document which will 
be included when exporting to document to an interactive PDF.
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➊

➋

The Hyperlink pane is split into two sections:

➊ Text

When inserting a text-based hyperlink, the contents of this edit field will appear in 
the document.  You can either use static text, as shown in the example here, or 
include the content of other fields (see below).  This setting is ignored when inserting 
a hyperlink on an image box.

➋ URL

The URL to hyperlink to is specified in this box. This hyperlink can include values 
from other fields by including the field name in { brackets }.  In the example shown 
here the contents of the SKU field will be included at the end of the hyperlink. You 
can also use Custom Field commands to build the URL.  Further information on 
these commands can be found on page 124.

 Ҙ Imported Text

EasyCatalog can also import formatted text such as RTF or InDesign Tagged Text 
from a file or from the content of a field by setting the field type to ‘Imported Text’.

EasyCatalog supports all of the text import types provided by InDesign.

! Fields of type ‘Imported Text’ will not be updated as part of 
the ‘Update Panel’ operation.

➊

➋
➌

➍

➊  Field Content

If the contents of the field contains the formatted content select the 'Field 
Content' radio button.  
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➋  Externally Referenced

If the field contains the name of a file to import, or a full path to a file, select the 
'Externally Referenced' radio button.  

 Ҙ If the field contains a full path to the file to import:

No further configuration in ➌ or ➍ is required.

 Ҙ If the field contains only the filename of the file to import:

Specify the folder than contains the file in ➌. If the content of the field does not 
contain the file extension, specify this in ➍.

 Ҙ Date/Time

EasyCatalog also supports the re-formatting of date and time fields. By changing a 
field’s type to be ‘Date/Time’, EasyCatalog is able to sort data correctly in the panel.  
In some situations the output format should be the same as the input format: this 
is useful when the panel should be sorted by date or time.

➊
➋

➊ The 'Input Format' defines the format of the date in your source data. The 
required date output format is specified in ➋. Common formats are shown in the 
pop-ups.

Specifier Description Example

%a Abbreviated weekday name Thu

%A Full weekday name Thursday

%b Abbreviated month name Aug

%B Full month name August

Specifier Description Example

%c Date and time representation Thu Aug 23 
14:55:02 2001

%C Year divided by 100 and truncated to integer (00-99) 20

%d Day of the month, zero-padded (01-31) 23

%D Short MM/DD/YY date, equivalent to %m/%d/%y 08/23/01

%e Day of the month, space-padded ( 1-31) 23

%F Short YYYY-MM-DD date, equivalent to %Y-%m-%d 2001-08-23

%g Week-based year, last two digits (00-99) 01

%G Week-based year 2001

%h Abbreviated month name  (same as %b) Aug

%H Hour in 24h format (00-23) 14

%I Hour in 12h format (01-12) 02

%j Day of the year (001-366) 235

%m Month as a decimal number (01-12) 08

%M Minute (00-59) 55

%n New-line character (‘\n’)

%p AM or PM designation PM

%r 12-hour clock time 02:55:02 pm

%R 24-hour HH:MM time, equivalent to %H:%M 14:55

%S Second (00-61) 02

%t Horizontal-tab character (‘\t’)

%T ISO 8601 time format (HH:MM:SS), equivalent to %H:%M:%S 14:55:02

%u ISO 8601 weekday as number with Monday as 1 (1-7) 4

%U Week number with the first Sunday as the first day of week one (00-53) 33

%V ISO 8601 week number (00-53) 34

%w Weekday as a decimal number with Sunday as 0 (0-6) 4

%W Week number with the first Monday as the first day of week one (00-53) 34

%x Date representation 08/23/01

%X Time representation 14:55:02

%y Year, last two digits (00-99) 01

%Y Year 2001
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Specifier Description Example

%z ISO 8601 offset from UTC in timezone (1 minute=1, 1 hour=100) 
If timezone cannot be determined, no characters +100

%Z Timezone name or abbreviation 
If timezone cannot be determined, no characters CDT

%% A % sign %

! If the incorrect Input Format is specified, the field's content 
will be set to '???'

THE GENERAL PANE
The 'General' pane contains options that apply to fields regardless of their type. For 
example, a field prefix or suffix can be applied here.

➊ ➋ ➌ ➍

➎

➏

➊ Style

The character style sheet specified in this pop-up is applied to the field when it 
is inserted into the document. The Character Styles for the current document, or 
the default character style sheets if there is no document open, will be listed in this 
popup.

When inserting the field into the document, you must ensure that the character style 
sheet is available. A warning will be displayed if it is not, and the field will be inserted 
without applying the style sheet.

➋ Prefix
➌ Suffix

Any characters that should included before the content of this field should go in the 
'prefix' field; any that should be included after should go in the 'suffix' field.  The 
prefix and suffix is only applied to non-empty fields.

➍ Sorting

Where your data contains non-English data, select the language in the ‘Sorting’ 
pop-up.  This will force EasyCatalog to use a linguistic sort when sorting this field, 
but should only be used when necessary as it can have a significant impact on 
performance.
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➎ Content Is Tracked

Turn this check box off if you do not want the content of this field to be tracked in 
the document. When off, the field will not be enclosed inside of our field marker 
characters in the document and so cannot be updated with new data.

➏ Cleansing Options

EasyCatalog allows the content of each field to be ‘cleansed’ before it is used in the 
document. ‘Data Cleansing’ is a simple search-and-replace that is applied to the 
data during import and before any formatting options are applied.

The cleansing options are specified by way of a string in the following format:

{replace this}={with this};

#=£;

All of the ‘#’ characters will be replaced with ‘£’

Multiple cleansing options may be also specified:

#=£;*=•;

Multiple cleansing options are separated by a semi-colon

Characters may also be stripped by not specifying a replace-with character:

#=;

Specify nothing on the right-hand side of the cleansing option to strip the character 
on the left.

Character strings can also be cleansed:

ESY=EasyCatalog;

All occurrences of ‘ESY’ will be replaced with ‘EasyCatalog’

If ';' or '=' appears in either the left or right part of the cleansing string, double them 
up:

a==b=a equals b;

Replaces all occurrances of a=b with 'a equals b'.

Regular Expressions

For advanced users, regular expressions can be specified in the Cleansing Options 
window:

REGEX:^p$=;

All ‘new paragraph’ characters at the end of the field will be stripped (replaced 
with nothing).

Note that the ̂  character is interpreted as an InDesign meta-character, so ̂ ^ should 
be used for the regular expression ^ character:

REGEX:^^a=b;

Replace ‘a’ at the start of the string with ‘b’.

Further information on regular expressions can be found on the internet, using a 
reference such as:

http://en.wikipedia.org/wiki/Regular_expression

Importing Cleansing Options

Commonly-used cleansing options can be stored in a plain text file and imported using 
the ‘Import’ button above the cleansing text area.

http://en.wikipedia.org/wiki/Regular_expression
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INDESIGN METACHARACTERS/SPECIAL CHARACTERS

InDesign metacharacters, such as those used in the Find/Change dialog, can also 
be used as part of the cleansing statement and within the prefix and suffix fields.  
Metacharacters begin with a caret (^) and represent special characters in InDesign, 
such as a bullet point.

*=^8;

All instances of the asterisk (*) will be replaced with the InDesign bullet character.

A full list of metacharacters supported by EasyCatalog is shown on the in the table 
below.

!
Some InDesign metacharacters refer to formatting rather 
than content. Only the metacharacters shown in the list 
below are supported by EasyCatalog.

Code Description

^# Auto Page Numbering

^x Section Marker

^8 Bullet •

^^ Caret ^

^2 Copyright Symbol ©

^p End of Paragraph

^n Forced Line Break

^7 Paragraph Symbol ¶

^r Registered Trademark Symbol ®

^6 Section Symbol §

^t Tab

^\ End Nested Style

^y Right Indent Tab

^i Indent to Here

^_ Em Dash —

continued....

Code Description

^m Em Space

^= En Dash –

^> En Space

^f Flush Space

^| Hair Space

^s Nonbreaking Space

^< Thin Space

^- Discretionary Hyphen

^~ Nonbreaking Hyphen -

^{ Double Left Quotation Mark “

^} Double Right Quotation Mark ”

^[ Single Left Quotation Mark ‘

^] Single Right Quotation Mark ’

^k Discretionary line break

PICTURE CONTENT PANE
In addition to inserting textual field content into an InDesign text flow, EasyCatalog 
can also be configured to import images into picture boxes. The picture to import is 
specified by the content of each field.

The 'Picture Content' pane is split into two sections: how the image will be imported 
and where it will be imported from.

➊ ➋

➎➏

➌

➍

➊ Scaling

This option determines how the image will be scaled to fit into its containing box.

Scaling Description

None The picture will not be scaled when it is imported

Proportionally Fit
The picture will be proportionally scaled to fit its containing picture box. There 
may be white space around the image if the image frame has a different aspect 
ratio to the image.

Fill Frame
The picture will be scaled to fit the picture box but, unlike ‘Proportionally Fit’, it will 
completely fill the box ensuring there is no white space around the image.  The aspect 
ratio of the original image will not be maintained when using this option.

continued....
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Scaling Description

Fill Proportionally
The picture will be proportionally scaled to fill the picture box but, unlike 
‘Proportionally Fit’, it will completely fill the box ensuring there is no white space 
around the image. Some of the image may be outside of the box. 

Fixed Scale Pictures will always be imported and scaled to the percentage specified by the 
‘Scale’ pop-up.

Field Specified If your data also contains picture scaling information, this option can be used to 
nominate the field containing this value.

➋ Alignment

After the image has been imported into the frame, it can be aligned to any of its 
containing frame’s corners or edges.

➌ X Offset / Y Offset

These options are used to offset the image within its containing frame by an amount 
specified in the selected field.  Specify the name of a field containing the X and/
or Y offset that must be applied to the image. The field should also contain the 
measurement system (e.g. 'mm') to ensure the offset it applied correctly.

➍ Content Color

Monochrome TIFF images can be recoloured when imported: specify a field that 
contains the name of a swatch to apply to the image.

➎ Clipping Path

A clipping path can be automatically applied to the image when it is imported.

Clipping Path Description

None No clipping path will be applied.

Default The default clipping path settings will be used - i.e. the settings that were selected 
during the last import on the 'Show Image Import Options' dialog.

Photoshop The first Photoshop clipping path will be applied to the imported image.

➍ Preserve Size and Position On Update

By default when re-importing an image during an "Update Document" operation 
the alignment, scale, etc will all be re-applied.  When this option is selected the new 
image will be imported into the box but the options specified above will be ignored.

●A ●B ●C

●D

●F●E
●A  Location

Images can be imported from either a folder on a file system or by downloading 
them from a URL.  Select either 'Folder' or 'URL' in the 'Location' pop-up.

 Ҙ Folder

 Ҙ If the field contains a full path to the file to import:

No further configuration in ●B  or ●D  is required.

 Ҙ If the field contains only the filename of the file to import:

Specify the folder than contains the file in ●B . If the content of the field does not 
contain the file extension (e.g. '.jpg','.gif',etc), specify this in ●D .

The path to the folder containing the images can be selected using the 'Choose' 
button ●C . It can also be dyamically built using one of EasyCatalog's inbuilt 
Custom Field functions (see page "Custom Fields Reference" on page 124). 
For example, the following example will pick out the fourth and fifth character 
from the 'code' field:

Macintosh HD:Images:SUBSTR(code, 4,2):

Specify multiple file extensions in ●D  by separating them with semi-colons:
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.jpg;.pdf;.eps;.gif

Where multiple file extensions are specified, EasyCatalog will attempt to import 
a file with each file extension in turn.  In this example it will look for a '.jpg' file, 
then a '.pdf' file.  This can be useful in situations where multiple files exist with 
different file extesions: specify the order you would like to search with the most 
preferred format first in the list.

 Ҙ URL

EasyCatalog can also download images from a URL.  Images that are downloaded 
are cached in the EasyCatalog Workspace folder.  

Images will be automatically downloaded as required, so an attempt to insert 
a picture that has not previously been cached will result in the image being 
downloaded.  If you’re using the optional Pagination Module, all images required 
will be downloaded before the pagination commences.

The 'extension' option ●D  is ignored when importing from a URL.

 Ҙ If the field contains a full path to the file to import:

No further configuration in ●B  is required.

 Ҙ If the field contains a partial URL, or the URL needs to be built from the 
contents of one of the record's other fields:

The Image URL field can also be built from the contents of the record’s other 
fields using EasyCatalog's Custom Field functions (see page "Custom Fields 
Reference" on page 124).  For example:

http://www.65bit.com/images/FIELDSTR(key).jpg

‘FIELDSTR(key)’ will be replaced with the contents of the ‘key’ field.  

DOWNLOADING IMAGES

EasyCatalog will download images on demand and cache them in your 
EasyCatalog workspace folder.  When one of the fields in the data source has 
'URL' based images a new sub-menu will be available on the data panel's pop-
out menu: 'Images'.

 Ҙ Download All

Download and cache all images referenced in the panel. 

 Ҙ Download Missing

Download images referenced in the panel that have not previously been 
downloaded.

 Ҙ Always Download Latest

Once an image has been downloaded and cached in your workspace folder, it will 
never be downloaded again unless this menu item is checked.  It is advisable to 
enable this option prior to running the ‘Update Document’ operations to ensure 
the images you have cached locally are the latest available from the server.

●E  Replacement Image

When an image cannot be found (or downloaded), the image specified in the 
'Replacement Image' field will be used instead.  The 'Replacement Image' is often 
used as a placeholder in the document to indicate that an image isn't yet available.

The field will be shown as 'in error' in the panel to indicate that the correct image is 
not being used.

DATABASE UPDATE PANE
The options shown here are used in conjunction with the ODBC Data Provider, and are 
covered separately in the ODBC Data Provider manual.
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ADVANCED PANE
The 'Advanced Options' pane contains settings that ordinarily will not require any 
adjustment.

➊

➋

➌

➊ Source Data Number Format

This option allows you to specify the thousands and decimal separators used in your 
source data.  For example, if your data source outputs numeric data using a ‘.’ as 
a thousands separator and a ‘,’ as the decimal separator, these should be specified 
on the ‘Advanced’ pane.

When first configured, fields will default to the settings specified in the ‘Regional 
and Language Options’ control panel on Windows, or the ‘International’ System 
Preference on Macintosh.

➋ Field Group

The ‘Field Group’ parameters are used to group fields together so that some 
operations can operate on multiple fields simultaneously.  For example, if you have 
sets of fields for English, French and German text, three groups could be created 
that contain the relevant fields for each language. ‘Replace Fields’, for example, can 
use these Field Groups to replace all fields in a group with fields from another group.

‘Group Name’ is the name of the group (e.g. ‘English); ‘Identifier’ is used to specify 
part of a field name that all fields in the group have in common. For example, if all 
English fields begin with ‘en_’, enter ‘en_’ as the Identifier. When replacing field 
content, this identifier will be used to determine which fields relate to one another 
(e.g. EasyCatalog will to identify that en_Description equates to de_Description).

Language

This option is used to identify the language of the field content. The language specified 
here will be set on the text that's inserted into InDesign, and will affect hyphenation, 
spell checking, etc.

Exclude from ‘Update Panel’

This field will not be updated in the panel when using the ‘Update Panel’ function from 
the data panel’s pop-out menu.

Exclude from ‘Update Document’

This field will not be updated in the document when using the ‘Update Document’ 
functionality.

Exclude from ‘Synchronize with Document’

This field will not be included during a 'Synchronize with Document' operation, and 
so will not show as red or green in the panel.  This field's content can still be updated 
using the 'Update Document' menu option.
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Fill Down On Synchronize

This option will populate any empty fields in the column with data from the first non-
empty field above it in the data.  This option is commonly used when only the first 
record in a group contains the grouping information:

In this data set, the Parent Category and Child Category fields are only populated for 
the first record in the group.  It would not be possible to group the data using these 
fields as the "Group" function relies on all records in the group sharing the same value.

When "Fill Down On Synchronize" is selected for a field, if an empty field is encountered 
the last non-empty value will be used instead:

! Changes to this flag only take effect at the next 'Synchronize 
with Data Source' operation.

Flag Empty Pictures As Errors

When checked, the Replacement Image will not be imported for image fields that have 
no content and the field will not be shown as 'in error' in the panel.

Exclude From Status Flagging

When checked this field will not affect the record's status flag (shown in the status 
column in the data panel) after a 'Synchronize with Data Source'.  So, for example, if 
this field is updated during the 'Synchronize with Data Source' the record will not be 
shown as 'updated' (unless other fields have also been updated).

This option can be useful for fields that frequently change but are not important to the 
layout (e.g. time stamps).

CUSTOM FIELD PANE
This pane is only available when creating or editing Custom Fields.  For further 
information please see page "Custom Fields Reference" on page 124.
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CHAPTER 4

EASYCATALOG DATA PANELS  
INTRODUCTION 
The EasyCatalog panel is your view on the snapshot of data acquired by a Data 
Provider. Using a spreadsheet-style appearance, the data in the panel can be sorted, 
grouped and filtered to make working with large volumes of data easy.

Multiple panels can be open for the same data source, each with different filters, 
columns,  sort orders and groups applied to the same source data. 

Multiple data sources can also be open at once, allowing you to work on publications 
that require data from a number of sources.

Each EasyCatalog data panel sits alongside your other InDesign panels and may be 
docked, resized and hidden in the same way.

OPENING A NEW EASYCATALOG DATA PANEL 
➊ A new EasyCatalog data panel will be opened after creating a new data source from 
the File→New→EasyCatalog Panel menu. 

➋ ➊
➋ A new panel for an already-configured data source can be opened by selecting the 
data source in bottom section of the  File→New→EasyCatalog Panel menu.

➌ A new panel for the data source you’re curently working with can be opened using 
the ‘New Panel’ menu option from the data panel’s pop-out menu. 

Option Description

Exactly the Same A new panel will be created containing the same records and grouping as the 
existing panel.

Panel Selection Only the records selected in the panel will be present in the new panel.

All Items The new panel will contain all of the records for this data source.

Empty
A new, empty, panel is created.  To populate this panel, drag records from an 
existing panel to it or use the subset options to specify the data that should be 
used to populate it.
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PANEL OVERVIEW
The EasyCatalog panel shows a wealth of information and offers a variety of ways to 
manipulate your data. In addition to showing your data, each EasyCatalog panel shows 
status information for each field and offers sorting, filtering and grouping options.

➋➊

➐

➎ ➏

➌ ➍

➊ Work with multiple data panels 

Each EasyCatalog data source is in its own panel, and multiple panels can be open 
for a single data source.  This enables you to have multiple views of the same data, 
each sorted, grouped and filtered independently of the others.

➋ Reorder the data in the panel.

Sort the fields in the panel by clicking in the column header.  The first click will sort 
the column in ascending order; the second click with sort in descending order and 
a third click will sort the records into the order they appear in the data source.  The 
panel can be sub-sorted by holding shift while clicking in the column header.

➌ Quickly see what changed in your data.

The status column shows information about what happened to a record during the 
last ‘Synchronise with Data Source’ operation.

This record has been inserted.

This record has been removed from the source data, and has effectively been 
deleted.  This record should be removed from the document.
This record was updated in the source data.  The fields that have changed will 
be shown in the red dotted outline.

➍ Check the status of your document

The status of individual fields is indicated by their background colour.

One of the fields for this record, is placed. 

The field is placed in the document and its content matches the source 
data.

The field is placed in the document but its content differs to the source 
panel.

This field was updated when the data was last retrieved from the data 
source.

The field in the panel has been updated from the document and needs 
updating in the data source.

The field is placed in the document but its content differs to the source 
panel and the field was updated when data was last retrieved.

➎ The buttons at the bottom of the panel provide fast access to the most commonly-
used EasyCatalog functions:

Inserts the current panel selection into the document. A text insertion point, or 
a picture box selection, is required.

Filter the panel based to show only records that satisfy specified criteria.  See 
"Filtering Based On Field Content" on page 54.
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Display the ‘Data Source Information’ dialog. 

Compare the content of the document with the field content shown in the panel.  
Any mismatches will be shown in red.

➏ Quickly search your data 

The Quick Search text box can be used to filter the panel quickly. Click in the box 
and begin typing to filter the panel.  

➐ Structure your data

Records can be grouped together in the panel so that they can be paginated at the 
same time. Grouping the panel also allows the structure of the data to be defined, 
enabling headers, for example, to be inserted on each change of group. See 
"Grouping Your Data" on page 39.

➋

➊

➍

➌

➊ Click on the disclosure triangle to show the sub-groups and records within the 
group.

➋ The number of sub-groups or records immediately beneath is shown in brackets.

➌ If any of the fields in the group are ‘in error’, the status of the group will also be ‘in 
error’.  Otherwise, if all records have at least one field placed the status will be dark 
green; if only some records have at least one field the status will be light green. 

➍ The number of sub-groups or records immediately beneath is shown in brackets.

FINDING FIELDS IN THE DOCUMENT
Double-click on a placed field to find it in the document. Only fields on visible, unlocked, 
layers will be shown.

 Ҙ Placed Fields

If the field is shown as placed and not in error (indicated by a green field in the 
panel), double-clicking will locate the first occurrence of the field in the document.

 Ҙ Errors

If the field is placed but shown as being in error (indicated by a red field in the 
panel), double-clicking will locate the first erroneous occurrence of the field in the 
document.

EDITING DATA IN THE PANEL
Fields can be edited directly in the panel by right-clicking on the field and using the 
‘Edit Field Content’ option from the contextual menu that appears. Once edited the 
field will be shown with a blue dotted outline to indicate that your source data should 
be updated.

Fields can not be edited if they are:

 Ҙ Key Fields

A key field cannot be modified as this would break any links already placed in 
the document.  It would also not be possible to update your data source with a 
modified key field.

 Ҙ Custom Fields with a custom field function

The custom field function (see "Custom Fields Reference" on page 124) determines 
the content of the entire column, so it is not possible to edit an individual field’s 
content. Custom fields that have been created without a function specified can be 
edited manually.
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REORDERING ROWS AND COLUMNS
Reordering the data in your panel can assist when paginating, as the order of the 
records inthe panel will determine the order they are placed in the document.

SORTING COLUMNS

To sort the records by the data in a single column click in the column header. Click 
once to sort the records in ascending order; click again to sort in descending order; 
click again to revert the sort records in the order they appear in the data source.

 

!
The records will be sorted according to the field’s type, so 
it is important to ensure that you have configured numeric 
fields as being on of the ‘number’ field types in Field 
Options.  See “Field Options” on page page 22.

SUB-SORTING COLUMNS

Hold the shift key while clicking on the column header to sub-sort the data.

A number under the sort direction icon shows the order that the columns will be sorted 
in. 

MANUALLY REORDERING ROWS

Rows in the table may be reordered by dragging them into position. Table rows may 
also be dragged between panels – this is useful after creating a new, empty, panel.

Note that the automatic filtering will be removed from a panel once a row has been 
dragged – the filter is removed, although only the records that were visible when the 
filter was applied will remain.

REORDERING COLUMN POSITIONS

The positions, or order, of columns may be changed for each panel.

To reorder columns, simply drag them into position: click and hold the mouse button 
in the header area of the column you want to move. Drag the column into it’s new 
position – the position of the drop will be shown whilst dragging.

Reordering Columns Alphabetically

To sort the columns into order alphabetically, right (or Ctrl) click in the panel data area 
and select ‘Reorder Columns Alphabetically’ from the contextual menu that appears.

PREVENTING COLUMNS FROM SCROLLING

Columns can be prevented from scrolling horizontally allowing, for example, your key 
fields to be permanently visible in the panel.  Fixed columns are always shown at the 
left of the panel.

➊

➌ ➍

➋
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➊  Hold the Shift key while hovering over the divider between the status column and the 
first column.

➋  Drag the divider to the right. 

➌  All columns to the left of the divider will be fixed at the left of the panel and will be 
shown with a grey background.

➍  When scrolling the panel horizontally the fixed column will not move.

GROUPING YOUR DATA
Grouping enables you to group related items of data within the panel and define 
complex group and sub-group relationships which can either be used to make your 
data more manageable, or represent the physical layout of your publication. 

Groups are a powerful feature of EasyCatalog and are used extensively during 
pagination. 

To group your data, select the “Group” menu form the data panel’s pop-out menu.

GROUPING CONFIGURATION DIALOG

The dialog is split into two sections. ➊ The left shows a list of all fields from the current 
data source; ➋ the right shows the current grouping configuration.

➊ ➋

Grouping works by looking for common values in the fields shown in the “Grouping 
Configuration” list.  In the above example, all records with the same Parent Category 
and Child Category field content will appear in the same group in the panel.

ADDING A GROUP LEVEL
To add a field to the “Grouping Configuration”, either:

 Ҙ Double click on the field in the “Available Fields” list, or

 Ҙ Select a field in the “Available Fields” list and click the “Add” button.

New fields to group by can only be added at the bottom of the configuration.

REMOVING A GROUP LEVEL
To remove a field from the “Grouping Configuration”, either:

 Ҙ Double click on the field in the “Grouping Configuration” list, or

 Ҙ Select a field in the “Grouping Configuration” list and click the “Remove” button.

Any fields below in the grouping configuration will move up.

SORTING GROUPS IN THE PANEL

By default the groups in the panel will appear in ascending order - either alphabetically 
if the field you’ve grouped by is alphanumeric or numerically when the field is one of 
the ‘number’ field types.

The order of the groups can be modified by:
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 Ҙ Using the “Ascending” or “Descending” radio button

Select a field in the “Grouping Configuration” list and select either the ‘Ascending’ 
or ‘Descending’ radio button.

 Ҙ Using the “Override Default Sorting Prior To Grouping” option

The contents of another field in your data can be used to determine to the order of 
the groups in the panel.  For example, you may want to group by the ‘Category’ field 
in your data, but want the groups to be ordered by a ‘Category Order’ field.  If this 
is the case, select the name of the field that should be used to order the data in the 
‘Override Default Sorting Prior To Grouping Menu’ pop-up menu.

The order of the groups as they are presented in the source data can be preserved 
by selecting the ‘Data Source Order’ option.

DISPLAY ALTERNATIVE FIELD AS HEADER 

Use this option when you are grouping by a field, such as a group code or a sort-order, 
but require a more meaningful field to be displayed in the panel.  For example, you may 
want to group the data using a group code field but need a more meaningful ‘group 
name’ field to be displayed in the panel. 

LOCKING A PANEL
Panels can be locked to prevent any records being added, removed or reordered. 
Advanced Filters are also removed from the panel to prevent the content of the panel 
being affected by a field’s status changing.

To lock a panel, select ‘Lock Panel’ from the panel’s pop-out menu. 
Locked panels are shown with a padlock icon in the top right corner 
or the header.

Once a panel is locked the following options are no longer available:

 Ҙ Reordering records by sorting columns

 Ҙ Grouping/Ungrouping the panel

 Ҙ Advanced Filters

A locked panel can be unlocked by selecting ‘Unlock Panel’ from the pop-out menu. 
Note that filters will need to be reapplied to the panel after unlocking.

PANEL CONFIGURATIONS

SAVING A PANEL CONFIGURATION

The configuration of your panel, such as the way it is grouped, sorted, etc can be 
saved. Using configurations it is possible to define different views of the data which can 
be reapplied when required.

Configurations can either be stored as part of the data source or exported to a file to 
be applied to a different data source.  See ‘Exporting and Importing Configurations’ 
below.

➊  Select ‘Save As...’ from the Configuration sub-menu on the data panel’s pop-out 
menu.

➊

➋  Give the configuration a name at the top of the dialog that appears.
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➋

➌

➍

➌  Select the configuration options you would like to save in this configuration.  The 
options in this section affect the view of the data, so applying a configuration with 
this options will only affect the panel it is being applied to.  When applying the 
configuration only the attributes selected here will be applied.

Option Configuration options stored:

Grouping The options specified in the ‘Grouping Configuration’ dialog.

Sorting The columns that are being used to sort the panel.

Column Sizes, Positions and 
Visibility The position, size and visibility of the columns in the panel.

Subset Any filter/subset currently applied to the panel.

Subset List The list of filters/subsets shown in the ‘Saved Subsets’ menu.

Advanced Subset The Advanced Subset options currently applied to the panel.

Lock The current lock/unlocked status of the panel.

➌  The configuration options in this section apply to the data source, rather than the 
panel view.  Therefore by applying a configuration that has these setting stored, all 
panels for the data source may be affected.

Option Configuration options stored:

Field Options The options specified in the Field Options dialog for all of the fields in 
the data source.

Formatting Tags The custom formatting tags that have been defined using the 
Formatting Tags dialog.

Pagination Options The options specified on the “Paginate” dialog.

!
Custom field definitions will also be saved when 'Field 
Options' are stored in a Configuration.  Applying a 
configuration containing Field Options will remove any 
custom fields that are not part of the configuration.

LOADING A PANEL CONFIGURATION

The configurations you have saved will be shown at the bottom of the ‘Configuration’ 
sub menu from the data panel’s pop-out menu.

Configurations that are applied to the current panel will be shown with a check mark. 
It is possible to have multiple configurations applied to the same panel at the same 
time. For example, if one configuration only defines column sorting option and another 
defines grouping EasyCatalog will show them as both being applied if the panel is 
grouped and sorted correctly.
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It is also possible to show the available Configuration across the top of the panel to 
make switching between them easier:

➊  Right click in the data area of the panel.

➋  Choose ‘Panel Preferences’ from the contextual menu that appears.

➌  Check the ‘Show Configurations’ check box on the Panel Preferences dialog.

➌

➍  The available configurations are shown in tabs along the top of the panel. If the 
attributes of the configuration are applied to the panel the tab will be higlighted. 
Change to a different configuration by clicking on the relevant tab.

EXPORTING AND IMPORTING A PANEL CONFIGURATION

The Configuration sub menu also contains options to export the current panel 
configuration to a file (using the ‘Export...’ menu option), which can later be imported 
to a different data source (using the ‘Import...’ menu option). 

As with ‘Saving a Panel Configuration’ (above) you can decide which attributes to 
include in the configuration file.

DEFINING A DEFAULT CONFIGURATIONS

When a new panel is opened for a data source, EasyCatalog will simply display a list 
of records in their default order.  No sorting or grouping will be used as, by default, 
these options are panel specific.  However, a default configuration can be specified so 
that if a panel for the data source is opened in the future it will be sorted and grouped 
correctly.

➊  Once you have applied your grouping, sorting, etc options press the 
information button at the bottom of the panel.

➋  Use the 'Save As Default' button to save the current panel configuration 
as the default for this data source.  Any new panels that are opened will use these 
settings.

➋
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CLOSING PANELS

HIDING A PANEL

Use the close button in the top-left corner (Macintosh) or top-right corner (Windows) 
of the panel to hide the panel from view.  The panel is only hidden, and can be shown 
again using the ‘Window→EasyCatalog Panels’ menu option.  The panel configuration, 
such as sorting, grouping, etc, is retained while the panel is hidden.

CLOSING A PANEL

When you have permanently finished with a panel, use the ‘Close Panel’ pop-out 
menu option.  Once closed, the panel’s configuration (such as sorting, grouping, etc) 
will be lost unless you have saved it as the default configuration for the data source, or 
as a named configuration (see above).
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CHAPTER 5

INSERTING DATA  
INTRODUCTION 
EasyCatalog offers a number of pagination options - from the simple insertion of single 
fields into text, right through to designing complex ‘Product Styles’ and the automatic 
creation of page content.

‘EasyCatalog Libraries’ extend the functionality of InDesign libraries, and allow dynamic 
content to be used in the design. When an item is dragged from an EasyCatalog 
Library to the page, the content for the selected record is used to paginate it.

Through intelligent tracking of content, EasyCatalog can identify  those fields that are 
placed, if their content is up-to-date and, if  not, update it. 

Using the 'insert' button at the bottom of the panel, EasyCatalog can insert:

 Ҙ A text field into the document

If a single field is selected in the panel, and you have a text insertion point, 
EasyCatalog will insert the selected field content as text.

 Ҙ Picture content into a picture box

If a single field is selected in the panel and you have a picture box selected in the 
document, EasyCatalog will import picture content.

 Ҙ Tabular data

When multiple fields are selected in the panel and you have a text insertion point, 
EasyCatalog will insert a table into the document.

SINGLE FIELD INSERTION
The simplest of all pagination options, a single field can be inserted by simply selecting 
the desired field in the EasyCatalog panel and hitting the ‘insert’ button. 

Only one field can be selected in the EasyCatalog panel, as a multiple-field selection 
will insert a simple table (see below).

INSERTING TEXT

If you have a text insertion point in the document, the field content will be inserted. 
This method is useful for constructing documents where records do not appear in a 
structured manner and field text must be inserted into normal text runs.

The character style sheet which has been defined for a field (in Field Options) will be 
applied to the field text.

Green ‘Field Marker’ characters will also be inserted around the field content - these 
markers are non-printing and are used to designate where the field content is in the 
document. After a document synchronization, these field markers will appear in red when 
the document content does not match the data source content (see ‘Synchronizing’).

Text insertion point

Single field selection

Text insertion point
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The field has been inserted, enclosed in Field Markers

Working with Field Markers

Field markers are non-printing and zero-width, and are used to track the content of 
fields in the document.

Individual field marker characters can not be deleted - they can only be removed if both 
the start and end marker characters are included in the selection.

Field markers must always be deleted in pairs.  In this example, only the start of field 
marker is included in the selection.

InDesign will not allow the start of field marker to be deleted without the end of field 
marker to ensure the integrity of the data in the document.

Inserting Pictures

If an empty picture frame is selected, the picture will be imported for the selected field. 
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If an empty picture frame is selected, the picture will be imported for the selected field 
using the setting from the "Picture Content" pane in the field's Field Options dialog. 

The content of the field determines the name of the picture file that will be imported. 
To find the picture file, EasyCatalog will attempt to import the image from the following 
locations:

 Ҙ If the field contains a full path

The image will be imported from the path stored in the field content.

 Ҙ If the field contains only a filename

If the filename in the field does not have an extension (e.g. '.jpg'), the extensions 
specified in the 'Extensions' field will be added.  EasyCatalog will then attempt to 
import the image from the folder specified in the 'Content Location' path.  If the 
image does not exist there, EasyCatalog will attempt to import the file from the 
'Images' folder inside of the data source folder.

 Ҙ If the field is empty

If the field is empty, the Replacement Image will be imported if the 'Flag Empty 
Pictures As Errors' Advanced field option is on.  If this option is off, the image box 
will remain empty and the field will not be shown as 'in error'.

Once succesfully imported, EasyCatalog will show the key field value of the record at 
the bottom left of the image frame.  The picture will be scaled and aligned according 
to the values specified on the "Picture Content" pane in Field Options.  See page xxx.

Missing Images

In the event of the image file not being found in any of the above locations, the 
‘Replacement Image’ image will be imported (if specified in Field Options). In the 
event of the ‘Replacement Image' being imported, the field will be shown as being in 
error in the document and in the panel.

i If the correct image for a field can not be found, the 
‘Replacement Image’ specified in Field Options will be used.

SHOWING AND HIDING FIELD MARKERS

The appearance of the field markers when designing your document can be specified 
via the ‘Show/Hide Field Marker’ panel menu option. This viewing preference is a 
document-based preference - therefore, the visibility setting of the markers will remain 
with the document.

The visibility of the field markers does not affect EasyCatalog’s ability to update 
document content, or the user’s ability to delete them - the markers are there, but 
invisible. 

Field Markers will also not show when viewing your document in ‘Preview’ mode.
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RELINKING FIELDS TO NEW DATA SOURCES
Field Adoption allows fields on a document to be associated to a new data source.  
All fields in a document, or only fields on the ‘active’ layer, can be relinked to a new 
data source.

As fields are re-linked based on their names, it is important that your new data source 
contains fields of the same name as the data source that was used to create the 
document.  Also note that fields are associated to new records based on their key, so 
it is also a requirement that the new data source contains data with the same key fields.

Relinking Fields

 Ҙ Create your new Data Source

Either create your new data source, or open the panel for the datasource that you 
want to link the document to.

!
Records in the new data source should contain fields 
with the same names as the original data source, and 
use the same key field values.

 Ҙ Select ‘Adopt Fields’ from the panel’s popout menu

Only fields on the active layer will be adopted

Option Description

All All fields in the document will be linked to the new data source

Current Layer Only fields on the 'current' layer shown in the Layers panel will be relinked.  The 
active layer is represented with a pen icon in the Layers panel.

Panel Selection Only fields that can be relinked to the fields selected in the panel will be relinked.

Fields in the document will be linked to the new data source - fields which were relinked 
correctly will be shown as green or red in the new panel. 

Fields shown in red need updating in the document, so you should either correct them 
manually or use one of the ‘Update Document’ options.

If a record is found in the document that is not in the data source you're adopting to, 
you will be given the following three options: 



EasyCatalog User Guide Synchronizing- 48 -

Option Description

All All fields in the document will be linked to the new data source

Ignore The fields that cannot be found in the new data source will be ignored.

continued....

Option Description

As New The fields will be added to the data source as 'new' records (shown with a green arrow 
icon in the status column)

As Deleted The fields will be added to the data source as 'deleted' records (shown with a red 'deleted' 
icon in the status column). 

REPLACING FIELDS
EasyCatalog allows the content of one field to be 
substituted with the content of another from the 
same data source. Field replacement is useful for 
producing multiple versions of the same document,  
using different pricing for instance.

 Ҙ Replacing Fields Select ‘Replace Fields...’ 
from the panel’s popout menu.

 Ҙ Specify the field to search for and the field to replace it with. 

The panel will update to show that the old field (the ‘Search For’ field) has been 
replaced with the new field (the ‘Replace With’ field). Only fields on unlocked layers 
will be replaced.

REMOVING FIELD MARKERS
To remove field markers from the document - effectively unlinking it from the data - use 
the ‘Remove Field Markers’ menu.  

!
Records in the new data source should contain fields with 
the same names as the original data source, and use the 
same key field values.
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Option Description

All All of the fields in the document will be unlinked.

continued....

Option Description

From Panel Selection Only the fields that are selected in the panel will have their field markers 
removed from the document

From Document Selection Only the fields selected in the document will have their field markers removed.

TAGGING EXISTING CONTENT

MANUALLY

If you have an existing document document that you would like to link to a data 
source, use the ‘Markup Field’ keyboard shortcut. 

 Ҙ  Assign a shortcut key to the "Markup Field" option in InDesign's keyboard 
shortcut editor.

Use the InDesign Edit → Keyboard Shortcuts menu option:

 Ҙ  Highlight the document content you would like to mark up

 Ҙ  ➊ Select the field in the panel you want to link to

➊

➋
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 Ҙ  ➋ Press the keyboard shortcut you assigned above

➌

 Ҙ  ➌ The content in the document will be linked to the field selected in the 
panel.

AUTOMATICALLY, FROM TABLE CONTENT

If you have an existing document document containing tabular data that you would 
like to link to a data source, use the ‘Cell Finder’ keyboard shortcut. 

 Ҙ  Assign a shortcut key to the "Cell Finder" option in InDesign's keyboard 
shortcut editor.

Use the InDesign Edit → Keyboard Shortcuts menu option:
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 Ҙ  ➊ Select the table in the document that you would like to mark up

➊

➋

 Ҙ  ➋ Select a field in your data panel so that EasyCatalog knows which data 
source you're attempting to link to.

 Ҙ  ➌ Press the keyboard shortcut you configured above to show the 'Cell 
Finder' dialog.

➍

➎

➏

The dialog is split into three sections

 Ҙ ➍ A record identifier

EasyCatalog will search the table for the contents of the field specified in the 
'Contents of Field' text box.  This should be the name of the field that can be 
used to uniquely identify the record to link to (typically this would be the key field 
for the data source, but it can be any field whose content is in the table that will 
correctly identify the record we want to mark up).

 Ҙ ➎ Whether we want to add or remove content when cells are found

When a field is found in a cell, content can optionally be added before or after it.

 Ҙ ➏ How to find identify where the other fields in the table are

Once EasyCatalog has found the unique identifier for a record in the table row, it 
then needs to know how to find the fields you would like to mark up.
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Update Description

Each Row As Specified By 
The Header

EasyCatalog will use the content of the table header cells to 
determine the names of the fields to mark up.  This is the most 
common form of pick-up, although this will only work if the content 
of the header cells match your field names exact

Entire Row Specify a comma separated list in the 'Like' field to specify the name 
of the field in each column, starting from the left of the table.

Entire Column

This option assumes that the table has been configured vertically (so 
fields for an individual record run down the table, rather than across).  
Therefore in the "Like" field, the names of the fields used in each row 
are specified.

Adjacent Cells Specify a comma separated list of field names in the "Like" field which 
specify the columns immediately to the right of the record identifier field.

Columns on the Right
Specify a comma separated list of field names in the "Like" field that 
specify columns relative to the right of the table.  For example, if two 
fields are specified in the "Like" 

Horizontal Table Example

The field specified in the'Contents of Field' would be 'Stock Code', as this field can be 
used to identify the record used in each row of the table.

Update Option Like Result

Each Row As Specified 
By The Header

Nothing is required in the 
'Like' field as the table 
column headers define the 
fields used in each column.

As the contents of the table column header cells 
match the field names used in the data source 
exactly, the field in each column will be marked 
up automatically.

Entire Row
Stock 
Code,Manufacturer,Ex VAT 
Price

The contents of the 'Like' column determines 
the names of the fields used in each column.

Entire Column
This option is only used when marking up tables that have been populated vertically 
(fields for each record run down the table rather than across).  See the example 
below.

Adjacent Cells Manufacturer, Ex VAT Price

Specify the fields in the cells to the right of the 
'Contents of Field' field.  In this example we 
specified the 'Stock Code' field as the field we're 
looking for in the table, so the fields in the cells to 
the right are "Manufacturer" and "Ex VAT Price".

Columns on the Right Ex VAT Price

Here we've only specified a single field - 'Ex VAT 
Price'.  The 'Columns on the Right' option expects 
a list of fields relative to the right edge of the table.  
In this example, just the 'Ex VAT Price' field will be 
marked up.

Vertical Table Example 

In this example, the fields for each record are vertically down the table rather than 
horizontally. 

In this situation the Entire Column “Update” option is used.  The “Like” field defines 
the names of the field in each cell of every column.  In this example we enter “Stock 
Code,Manufacturer,Manufacturer Part Code,Ex VAT Price”.
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The cells in each column have been linked to the same record, as identified by the 
Stock Code field.
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CHAPTER 6

FILTERING DATA  
INTRODUCTION 
EasyCatalog makes working with large volumes of data easy - using a simple query 
builder from within EasyCatalog, your data can be filtered to show only the records you 
need to use.

Filters are applied to each EasyCatalog panel, so you can have multiple panels open 
for the same data source each with their own filter applied.

In addition to filtering on field content, Advanced queries can also be configured to 
show records and fields based on their current status (such as whether the record is 
placed, in error, etc).

Filter definitions can also be saved and re-applied as required.

FILTERING BASED ON FIELD CONTENT
Queries are defined by a simple field, operator, value configuration dialog - to apply a 
simple filter to a dialog, select ‘Show Subset...’ from the panel menu.

The use of filters is essential when dealing with large numbers of records, or when 
creating tables in InDesign (as the records, columns and ordering affect the way in 
which tables are populated or created on the page).

➊

➐ ➑ ➒

➌ ➍

➋ ➎

➏

➊ Search Entire Data / Search Currently Shown Items

When 'Search Entire Data' is selected, all data from the data source will be searched 
using this Subset; when 'Search Currently Shown Items' is selected only the records 
currently shown in the panel will be searched.

Filters are defined using a simple ➋ field, ➌ operator, ➍ value set up.  The available 
operators ('Less than', 'Greater than', etc) shown in ➌ the operator menu are 
determined by the field type (as defined in Field Options) for the field selected in the 
field pop-up. 

➎ Save As...

The filter definition can be saved and re-applied later from the data panel's pop-out 
menu.

You will be prompted for a name, which is the one that will be used on the ‘Saved 
Subsets’ menu on the EasyCatalog panel.

➏ Match All (logical ‘and’)

All of the search criteria must be satisfied to allow the record to pass through the 
filter. In the example above, ‘Parent Category’ must be equal to ‘Electrical’ and ‘Inc 
VAT Price’ must be less than 300.
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➏ Match Any One (logical ‘or’)

Any of the search criteria must be satisfied to allow the record through. In the above 
example, ‘Parent Category’ must be equal to ‘Electrical’ or ‘Inc VAT Price’ must 
be less than 300.

➊ More Choices / ➑ Fewer Choices

Query criteria can be added or removed using these buttons.  Up to a maximum of 
five criteria can be defined for a single subset.

➒ Show Entire Group

This option is only available for grouped panels.  When checked, the entire group 
will be displayed if any of the records within the group match the criteria specified.

FILTERING BASED ON STATUS
In addition to simply filtering by the value of field from the data source, ‘Advanced 
Subsets’ can be defined which include information about each record’s status, and are 
applied in addition to any other filters already applied to the panel.

➊

➋

➊ Show Records That Are Flagged As

The top part of the dialog allows records to be filtered based on their status after 
the last 'Synchronize with Data Source' operation (see "Getting the Latest Data" 
on page 57).

Option Description

Unchanged Show records that were not modified

New
Show the records that were created as a result of the synchronisation process 
- i.e. they were not present in the data snapshot before synchronisation, but are 
now.

Option Description

Deleted

Show the records that were removed during the synchronisation - i.e. records 
that were present in the data snapshot, but are not now. Note that records are 
not removed from the snapshot during synchronisation - they are marked for 
deletion until purged by the user.

Updated Show the records that changed during synchronisation.

➋ Show Records That 

The bottom part of the dialog mainly concerns filtering records based on their 
document status (for example, whether the record is placed in the document).

Option Description

Have Geometry Show the records that have geometry associated with them - see ‘Templates 
and Libraries’.

Have No Geometry Show the records that do not have geometry associated with them - see 
‘Templates and Libraries’.

Have Document 
Content Show the records that are placed on the current, front-most, document.

Have No 
Document Content Show the records that are not placed on the current document.

Have Errors Show the records that are placed in the document, and whose content is 
different in the document to the data source.

Have No Errors Show the records whose content is the same in the document and in the data 
source.
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SAVING FILTERS
Save a filter definition using the 'Save As...' button on the 'Subset' dialog. The ‘Saved 
Subsets’ menu option shows all previously saved filter definitions.  Filters can also be 
saved and exported as part of a panel configuration. For further information see "Panel 
Configurations" on page 40.

Applying a saved filter

To apply one of the definitions, select it from the menu. Note that any existing filter will 
be replaced with the saved definition.

Deleting filter definitions

All saved filter definitions can be removed by selecting the ‘Remove All’ menu option 
from the ‘Saved Subsets’ menu.

REMOVING A FILTER FROM A PANEL
A filter can be removed from a panel by selecting the ‘Show All’ menu option. Note 
that any filter definition will be lost, so be sure to save it before selecting ‘Show All’.

AUTOMATICALLY CREATING SUBSETS
Subsets can also be automatically generated using the "Create..." option on the 
"Saved Subsets" menu. 

This option will create a new subset for each unique value in the field selected in the 
pop-up.  This option is useful if, as shown in this example, you need to quickly switch 

between "Parent Categories". The filters that are created can be found on the "Saved 
Subsets" menu:

REMOVING A FILTER FROM A PANEL
A filter can be removed from a panel by selecting the ‘Show All’ menu option. Note 
that any filter definition will be lost, so be sure to save it before selecting ‘Show All’.
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CHAPTER 7

SYNCHRONIZING  
INTRODUCTION 
EasyCatalog offers bidirectional linking of data to the InDesign document - any changes 
made to the source data can be reflected to the document, and any changes made to 
the document can be sent back to the source of the data.

EasyCatalog can also ensure that the content in the document matches the content 
shown in the panel.

GETTING THE LATEST DATA
EasyCatalog works with snapshots of data - an internal picture of the data that was 
taken at a moment in time. When data changes at its source the snapshot needs 
updating.

By storing a snapshot of data, EasyCatalog can identify those records and fields that 
have changed through successive updates of the snapshot. This information is shown 
in the EasyCatalog panel to assist the user in making decisions on how to update the 
document.

To update the data snapshot, choose ‘Synchronize with Data Source’ from the 
EasyCatalog panel menu. 

The data will be retrieved from its original source and compared against the existing 
snapshot. All changes will be shown in the data source’s panels, and will remain until 
the next ‘Synchronize with Data Source’ operation.

➊
➋
➌

The status column in the panel will update to show what happened to each record 
during the last 'Synchronize with Data Source' operation.  Records that were ➊ 
inserted and ➌ deleted are represented by an icon in the status column; records that 
were updated show the ➋ updated icon and the updated fields have a red dashed 
outline.

The status column is reset each time a 'Synchronize with Data Source' is run.  Deleted 
records will remain flagged as 'deleted' until the 'Purge' button is used on the 'Data 
Source Information' dialog.

SYNCHRONIZING WITH A DIFFERENT FILE
File-based Data-sources Only

If the location of your data-file has changed, or you would like to select a new file, hold 
the shift key while selecting ‘Synchronize with Data Source’.  A file chooser dialog will 
appear which will allow you to re-specify the location of your data file.
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UPDATING THE DOCUMENT
The document can be updated with a single click - each EasyCatalog panel offers 
various options for updating the entire document, or parts of the document.

Each of these options will only update fields on current, front-most, document that 
differ to the data in the panel.

Any fields that are updated will have their field markers changed back to green to 
indicate that the field is no longer in error.

! Only fields on unlocked layers will be updated. Fields on 
hidden, unlocked, layers will be updated.

Option Description

All All fields in the document will be updated

Selection Only update the selected fields in the document.

With Panel Selection Only update the fields in the document that are selected in the panel

RE-APPLYING PAGINATION RULES

Hold down the shift key whilst selecting any of the above menu options to re-apply 
pagination rules such as 'Fit Box to Text'.  This option is only available when the 
Pagination Module is loaded.

UPDATING A SINGLE COLUMN

Right click (or Ctrl-click on Macintosh) in the column you would like to update in the 
document and select the 'Update All (field name) Fields In The Document' menu 
option.

UPDATING AN INDESIGN BOOK

EasyCatalog also supports updating all of the documents in an InDesign book.

The 'Update Document → All' menu can be found on a new 'EasyCatalog' menu 
option is provided from the book panel's pop-out menu.  This option behaves in the 
same was as other book operations - any open documents will be updated but not 
saved; any unopen documents will be opened, updated, saved and closed.

CHECKING FOR ERRORS
The content of the document can be checked to ensure that its content matches the 
data from the data source.

Any discrepancies found will be highlighted in the document with red field markers, and 
the field will also be shown in the red in the EasyCatalog panel.

Document content will be checked automatically when:

 Ҙ Opening a document
 Ҙ Switching between documents
 Ҙ After editing Field Options

This automatic checking can be disabled by turning off the 'Dynamically Update 
Panel' option in EasyCatalog's general preferences.

 Ҙ After updating the panel with new content

The document content will be checked after a 'Synchronize with Data Source', 
'Update Panel', or 'Edit Field Content' operation.  This can be disabled by turning 
off the 'Synchronize Panel After Updating Content' option in EasyCatalog's 
general preferences.
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To manually check for errors, use the 'Synchronize' 
button    on the EasyCatalog panel, or use 
the Synchronize with Document menu option. 

TEXT CONTENT

Text content must match exactly the content from the data source - numeric fields 
must also be in the correct format.

Text fields will be shown as being in error if:

 Ҙ The content in the document doesn't match the content in the panel

Minor modifications to the text, such as the insertion of additional carriage returns, 
tabs, etc,  are allowed if the 'Ignore White Space Changes' alphanumeric field 
option is enabled for the field. See "The Format Pane" on page 23.

 Ҙ All or part of the field is overset

Note: A field is not reported as being in error if the incorrect character style sheet is 
applied.

Field Markers are changed to red to enable erroneous fields to be identified in the 
document. The Field Markers are changed back to green when the document is 
updated via the ‘Update Document’ menu.
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PICTURE CONTENT

Pictures will be shown as being in error if:

 Ҙ There is no image in the box (provided that the 'Flag Empty Pictures As Errors' 
Advanced Field Option is switched on (see "Advanced Pane" on page 33).

 Ҙ An incorrect image is imported into the box

 Ҙ The image content has changed (the link needs updating)

 Ҙ The ‘missing image’ has been used, as the correct image for a field was missing. 

The field markers at the bottom right of the image frame will be green when the correct 
image is imported into the box; red when an incorrect, out-of-date, or missing image 
is placed.

QUICKLY FINDING ERRORS IN THE PANEL
The panel can be filtered to show only records containing fields that are 'in error' using 
an Advanced Filter (see "Filtering Based on Status" on page 55).

Alternatively, press the ➊ 'Show Me' button on the Data Source Information dialog 
(available from the ●i  button at the bottom of the panel).

➊

UPDATING THE PANEL FROM THE DOCUMENT
The link between document and data is bidirectional - therefore, any changes made to 
the document can be reflected back to the panel (and the original source of the data, 
such as the database). 

Note that if a field is placed in the document twice, the last occurrence of the field will 
be used as the content for the field. The front-most, current, document will be used to 
update the panel.

As with updating the document, updating the panel offers three options that determine 
the scope of the changes.
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Option Description

All All fields placed in the document will be used to update the data in 
the panel.

Selection Only the fields selected in the panel will be updated.

With Document Selection Only the fields selected in the document will be updated in the panel.

Fields that are updated in the panel will be shown with a blue dashed outline.

UPDATING A SINGLE COLUMN

Right click (or Ctrl-click on Macintosh) in the column you would like to update in the 
document and select the 'Update All (field name) Fields In The Panel' menu option.

UPDATING THE PANEL WITH PAGE NUMBERS
The page number(s) where each record appears can stored in one of the datasource’s 
fields using the ‘Update Panel→With Page Numbers’ menu option.

i Section page numbers are used to update the field content.  
Therefore, the format of the page numbers used will be 
defined by the document’s ‘Numbering & Section’ options.

➊ ➋ ➌ ➍

➎
➐➏
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➊ Search For: Field

Define which field(s) for a record should be used to determine the page a record 
is placed on, and whether only text fields, picture fields or both types should be 
searched for. For example, if a single record spans multiple pages you may only be 
interested in the page number that the 'Price' field is placed on.

Option Description

All All fields for a record will be searched for in the document.  When one is found, 
its page number will be used to update the 'Update' field.

Field Name The document will be searched for the specified field, and the page this field is 
placed on will be used to update the 'Update' field.

➋ Search For: Content Type

Option Description

All Both text and picture boxes will be searched for a field in the document for each 
record.

Text Only text-based fields will be searched in the document.

Picture Only picture boxes will be searched in the document.
 

➌ Update : Field

Nominate the field that should be updated with the page number the record is 
placed on.

➍ Update : Records

Option Description

All All records in the data source will be updated.

Option Description

Panel Selection Only the records selected in the panel will be updated.

➎ Populate With

Option Description

First Page The page number that the record first appears on will be used.

Last Page The page number for the last occurrence of the record will be used.

All Pages
A list of all pages numbers for all instances of the record will be stored in the field.

For example, if a record appears on pages 1,2,3 and 5 the field will be updated 
with “1-3, 5”. 

➏ Collate pages for all grouped records

If your data panel is grouped, this option will update all records in each group with a 
list of the page numbers for every record in the group.  This option would be used, 
for example, to get a list of pages that all records in a particular category appear on.  

➐ Only update records in current document

By turning this option on, only the records placed in the current document will have 
their page numbers updated. If this option is off, any records not placed in the 
current document will have their page number fields emptied.

UPDATING PAGE NUMBERS FROM MULTIPLE DOCUMENTS

Page numbers from multiple documents can be updated to the panel by storing them 
in an InDesign book:  

➊ Select any field or record in the panel you would like to update.

➋ From your InDesign book’s menu, use the ‘Update EasyCatalog Fields with Page 
Numbers’ menu option.

UPDATING THE PANEL WITH PAGE POSITION DATA
Each record in the panel can be updated with X and Y position and the Width and 
Height of each record in the document using the 'Update Panel → With Page 
Positions' menu option. 
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i The X and Y position of the frame containing the field will be 
used to update the panel (not the position of the field within 
the frame).

➊

➍

➋

➎

➌

❶ Search For: Field

Limit the update to searching for a specific field (rather than any field for the record) 
and whether only text fields, picture fields or both types should be searched for. 

Option Description

All All fields for a record will be searched for in the document.  When one is found, 
its position will be used to update the 'Update' field.

Field Name The document will be searched for the specified field, and its position be used 
to update the 'Update' field.

➋ Search For: Content Type

Option Description

All Both text and picture boxes will be searched for a field in the document for each 
record.

Option Description

Text Only text-based fields will be searched in the document.

Picture Only picture boxes will be searched in the document.
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➌ Update : X Field, Y Field, Width Field, Height Field

Nominate the fields that should be updated with the position of the 'Search For' 
field.

➍ Update : Records

Option Description

All All records in the data source will be updated.

Panel Selection Only the records selected in the panel will be updated.

➎ Relative To

Option Description

Page The co-ordinates used to update the X and Y fields will be relative to the top-left 
of the page the box is placed on.

Origin The co-ordinates used to update the X and Y fields will be relative to origin point 
of the ruler.

UPDATING YOUR SOURCE DATA

! Before updating your data source, you must first update 
the contents of the panel (see above).

Once the panel has been synchronized with the document, the original data source 
can be updated. The type of data source used will determine how it is updated.

Select ‘Update Data Source’ to update the original source of the data.

FILE-BASED DATA

A file ‘Save As’ dialog will be displayed. Enter a file name and select where you would 
like the file to be saved. The format of the file will be the same as the original input 
format.

!
A new file will be created, rather than updating the old file. 
When using an Excel spreadsheet, formatting, formulas, 
etc will not be output and could be lost.

DATABASE (ODBC) DATA

EasyCatalog also tracks the fields that have been updated - those that were changed 
in the data snapshot. The fields that will be updated are shown with a blue dashed 
outline in the EasyCatalog data panel.

Only the fields that have been changed will be updated on the database - resulting in 
faster update times through fewer transactions.

!
Only fields that have an update statement configured will 
be updated on the database.  Ensure that the 'Update Using 
Statement' check box is set in the Field Options.

An update SQL statement must be configured for each of the fields that will be updated.  
Further information on this can be found in the manual that accompanies the ODBC 
Data Provider.
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CHAPTER 8

DYNAMIC CONTENT
INTRODUCTION 
You have already seen how EasyCatalog can add data into to documents by inserting 
fields into text, tables and picture boxes. 

For publications that require templates to be designed in advance and for automatic 
pagination, EasyCatalog can also help - by showing where fields should appear and 
the style in which they should appear, EasyCatalog can automatically import and 
formatted data content.

DATA PLACEHOLDERS (FIELD SPECIFIERS)
EasyCatalog uses ‘Field Specifiers’ - special fields in templates and libraries that define 
where, and how, a field should appear when paginated. 

During the pagination process, Field Specifiers are replaced with field content - any 
styling information that has been applied to the Field Specifier will be retained in the 
paginated field content. Populated Field Specifiers are then tracked in the same way 
as normal fields.

Field Specifiers are not linked to a data source - they simply specify the name of a 
field to use. Therefore, templates and libraries can be used with multiple data sources, 
providing the field names exist in each of the data sources.

Field Specifiers have been designed to have as little impact as possible on the design 
process.

INSERTING FIELD SPECIFIERS
To insert a Field Specifier, select the required field from the ‘Field Specifiers’ menu on 
the EasyCatalog panel. Field Specifiers can be inserted into a text box, or an image 
frame can be tagged.

 

i To quickly insert Field Specifiers, hold the CTRL key 
(Windows) or Cmd  key (Macintosh) whilst double-clicking 
on the field's column header in the panel.
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TEXT FIELD SPECIFIERS

A text-based ‘Field Specifier’ will be inserted into the text at the current insertion point.

Field Specifiers behave in exactly the same way as normal fields, except they are 
surrounded by blue Field Marker characters. The Field Marker characters can not be 
deleted in isolation - the entire ‘Field Specifier’ must be removed from the document.

The default content of a text-based Field Specifier is the field’s name, and its default 
style is the Character Style sheet that has been defined in the field's Field Options. 

When populated, the text content of the Field Specifier tag will be merged with the 
field that is being placed.  Any formatting that has been applied to the Field Specifier 
will also be retained where possible, unless the field is a 'Formatted' (e.g. HTML) field.

This merging process offers a further powerful level of control over formatting, which is 
best explained using the example shown below.

By default, when inserting a field specifier, the field name will be used as the content 
between the blue marker characters.  However, this content can be changed to 
whatever we need (sometimes, for example, the name of the field is too long to fit in 
the available space).

Because the content of the field data is merged in to the document content, we can 
use this to show EasyCatalog how to format certain fields. In this example, we want 
to format the decimal part of the 'Price' field as superscript.  To do this, we can show 
EasyCatalog what a price typically looks like by changing the content between the 
markers and applying to correct formatting:
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Now, if we populate the field specifier with data from the panel, EasyCatalog will 
attempt to merge the data (£187.00) with the document content:

To achieve this EasyCatalog looks for common characters in the document content 
and the data source content.  In this case, the decimal point is present in both. 
EasyCatalog will therefore determine that the characters before the decimal point 
need to be replaced with '£187', and the characters after the decimal point '00'.  The 
formatting shown in the document has also been preserved, resulting in a superscript 
decimal part.

PICTURE FIELD SPECIFIERS

If a picture frame is selected, the frame will be tagged with the name of the field.  As 
with text-based Field Specifier, the field name will be shown with blue field marker 
characters to distinguish it from placed field data.

REMOVING FIELD SPECIFIERS

Field Specifiers can be removed from the document by using the "Remove Field 
Markers" menu option on the data panel's pop-out menu.

"Remove Field Markers" will remove the Field Specifier from image frames; for text 
Field Specifiers only the blue markere characters will be removed, leaving the name of 
the field in the text.

CONVERTING FIELD MARKERS TO FIELD SPECIFIERS

Field Specifiers that have been populated with data can be converted back to Field 
Specifiers using the "Convert To Field Specifiers" menu option from the data panel's 
pop-out menu.  This menu option is useful when you're unsure which field in the panel 
a field in the document is linked to.

 Ҙ Text-based Field Specifiers

The field's text will be replaced with the name of the field that the Field Specifier 
represents.

 Ҙ Picture Field Specifiers 

The picture content will be removed from the box and the name of the field will be 
shown between blue Field Specifier markers at the frame's bottom-left corner.
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POPULATING FIELD SPECIFIERS
Field Specifiers are populated by dragging and dropping data from the data panel to 
the box(es) containing Field Specifiers.  If boxes are grouped on the page, all boxes in 
the group will be populated with data from the record that is dragged.

DRAG

➊
➊ Data can be dragged by clicking and dragging from the left-most, status, column in 
the panel.

Formatting, such as font style and size, is retained wherever possible when populating 
the Field Specifier.  

TABULAR DATA

Field Specifiers inside of tables are populated differently to regular text-based Specifiers. 
When EasyCatalog encounters a table, it will attempt to populate it one-row-per-record 
that's selected in the panel.  There are a number of options available that control how 
tabular data is presented in InDesign, and further information on these can be found in 
the Tables chapter starting on page 101. 

DRAG
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EASYCATALOG LIBRARIES
EasyCatalog brings dynamic content to InDesign libraries by allowing Field Specifiers 
to be used in library designs. When dragging a library item to the page, the Field 
Specifiers will be replaced with the content for the currently-selected record(s) in the 
EasyCatalog panel.

EasyCatalog Libraries allow a number of Product Styles to be defined and stored 
in standard InDesign libraries. Using EasyCatalog libraries allows complex, module-
based pages to be created quickly. The selection of each individual module can be 
made by the user at production time.

CREATING AN EASYCATALOG LIBRARY

An EasyCatalog Library can be created by:

 Ҙ Selecting ‘New EasyCatalog Library’ from the File→New menu.

 Ҙ Creating a standard InDesign library, or opening an existing one, and setting the 
‘EasyCatalog Library’ menu option.

When EasyCatalog is loaded a new menu option, ‘EasyCatalog Library’ will be 
shown on each library’s panel menu. 

The ‘EasyCatalog Library’ setting will be preserved with the library file.

 Ҙ Drag your page items into the EasyCatalog Library

POPULATING AN EASYCATALOG LIBRARY WITH DATA

When items stored in an EasyCatalog Library are dragged to the document they will 
be populated with data from the selected record(s) in the panel.  All of the boxes 
inside of the library item will be populated with data from the same record(s). With the 

optional Pagination Module loaded, additional attributes can be specified on each box 
to control which record(s) will be used from the selection.

 Ҙ Select the record(s) to populate the library item with in your data panel

 Ҙ Drag the library item to the page

 Ҙ The Field Specifiers in the library item will be replaced with data from the 
selected record(s)

Further information on how tables inside of EasyCatalog Library items are handled can 
be found in the Tables chapter, starting on page 101.



EasyCatalog User Guide Dynamic Content- 70 -

EDITING A LIBRARY ITEM

To prevent the library item from being populated with data, hold the Alt key when 
dragging it to the document. Once edited, update the item in the library using InDesigns 
"Update Library Item" menu option from the library panel's pop-out menu.
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CHAPTER 9

AUTOMATIC PAGINATION

i The automatic pagination features shown in this chapter are provided by the "Pagination Module" which is an optional module that is purchased 
separately.

INTRODUCTION 
EasyCatalog provides advanced pagination features to allow thousands records to be 
paginated into the document in one operation.  

By providing an EasyCatalog Library of Product Styles, along with a series of simple 
rules, EasyCatalog is able to make decisions during pagination to determine which 
Product Style to use. 

PREPARING FOR PAGINATION
Configuring EasyCatalog for automatic pagination requires three stages, each of which 
is covered in further detail later:

➊  Configure the panel to reflect the structure of your publication, including 
defining the correct hierarchy

 Ҙ Acquire or import your source data

Optionally:

 Ҙ Filter your data to show only the records you would like to paginate

 Ҙ Group your data so that the panel represents the logical structure of your 
publication. For example, if your publication is arranged by Manufacturer, 

Make, and Model for instance, you would group the panel by Manufacturer, 
Make, and Model

 Ҙ Sort your data so that the records are shown in the order that you would like 
them to flow into the document

For more information see  "EasyCatalog Data Panels" on page 35.

➋ Create your Product Styles

Create an EasyCatalog Library that contains the Product Styles to use during 
pagination.  Multiple library items can be included in this library – for example, you 
could have a Product Style for a Manufacturer heading, a Product Style header for 
Make, etc. 

For more information see 'Create Your Product Styles' on page 73. 
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➌ Paginate

Use the ‘Paginate…’ menu to begin the automatic pagination.  Five different 
pagination types are available, depending on the type of publication being produced 
and the available data.

➊ CONFIGURE THE PANEL
By utilising EasyCatalog’s filtering, grouping and sorting features, you can configure 
an EasyCatalog panel to show both the structure and running order of records in the 
document.  By thinking of the EasyCatalog panel as a preview of your final publication, 
you can experiment with grouping, sorting and filtering to determine the flow of records 
into the document.

ACQUIRE OR IMPORT SOURCE DATA

Import your data using ‘File→New→EasyCatalog Panel’.  This is covered in detail in 
"Importing Your Data" on page 12.

The level of automation that is possible with EasyCatalog Pagination largely depends 
on the quality of the source data – for example, it should be possible from your data 
to correctly group the panel (if necessary) to reflect the structure of your publication.  
Also, EasyCatalog can only automatically choose the correct Product Style to use if 
this information is available in your data.

FILTER YOUR DATA

Use the ‘Subset…’ menu (See "Filtering Data" on page 54)) to show only the records 
that your would like to paginate.  This stage is optional, although it makes pagination 
easier when your data snapshot contains thousands of records.

GROUP YOUR DATA

This stage is also optional, and should be used when your data should appear 
hierarchically in the publication.  If your data is not hierarchical, you may skip this step.

Use the ‘Group…’ menu option to create a grouping that represents the logical 
structure of your document.  For example, if you require:

 Ҙ Parent Category Heading

 Ҙ Child Category Heading

 Ҙ Products

Use the ‘Group Configuration’ (see Chapter 4, ‘EasyCatalog Data Panels’) dialog to 
construct a hierarchy of Parent Category, Child Category.

As will be shown later, it is possible to create Product Styles that will be used at each 
level in the grouping hierarchy – so, for example, you could create a Product Style 
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for a Manufacturer heading, one for a Make heading, etc.  It is also possible to use a 
different heading style based on an indicator in your data.

SORT YOUR DATA

If your data also requires further sorting, use the panel sorting options to create the 
correct running order of records (see Chapter 5, ‘EasyCatalog Panels’)

➋ CREATE YOUR PRODUCT STYLES
Product Styles used during automatic pagination are created in the same manner as 
normal, drag and drop Product Styles (see Chapter 7, ‘Dynamic Content’).  When 
using Product Styles during automatic pagination however, further attributes need 
to be applied that identify when a Product Style should be used (at what level in 
the grouping hierarchy, for example) and whether any post-processing should occur, 
such as resizing boxes.  These attributes are applied to the Product Style using the 
‘Pagination Rules’ panel which is available from the ‘Window’ menu.

The most important Pagination Rule to apply is the "Paginate" rule.  This determines 
where in the grouping hierarchy the library item should appear.  For example, iin the 
gropuing shown above we may want to have a heading appear at the "Parent Category" 
grouping level.

USING THE PAGINATION RULES PANEL

The Pagination Rules panel is used to apply three types of atrributes:

 Ҙ When a Product Style should appear

For example, where in the panel's grouping hierarhcy the Product Style should 
appear.  It's possible, in the same library, to have multiple library items each of 
which have different "Paginate" attributes. During pagination EasyCatalog will 
evaluate this attribute to determine whether it is the correct time to insert the item. 

These types of attributes are applied to the outermost group box or, if you don't 
want to group the boxes, all boxes in the Product Style.

 Ҙ Attributes that affect how the box appears on the page

The Pagination Rules panel also allows attributes to be specified on individual 
boxes in the Product Style, and these attributes can be used to affect how the box 
is processed when it appears on the document. For example, there are a number 
of box fitting options; there is an attribute that can delete the box when it has no 
content, etc.

Further information on these attributes can be found in "Pagination Rules Reference" 
on page 114.

 Ҙ Actions

An 'action' is a simple 'if this then ...' attribute, which can be triggered when the 
contents of your data fields match the specified crteria.  For example, it's possible 
to specify that a box containing a "New" graphic should be deleted if one of your 
fields doesn't contain "New". 

PAGINATING ONE PRODUCT STYLE PER RECORD

If your Product Style consists of a single box, or multiple boxes that are grouped 
together, use the Pagination Rules panel to set the "Paginate" attribute to be "Once Per 
Record". If the Product Style conssist of multiple boxes that aren't grouped together, 
this attribute should be set on all of the boxes in the Product Style.

If the Product Style contains a table, it will be populated with data from the record being 
paginated.  This will result in one table per record rather than one table containing all 
of your records.  To populate a single document table with multiple records you would 
need to paginate a group of records (see 'Populating One Product Style Per Group', 
below).

PAGINATING ONE PRODUCT STYLE PER GROUP

If your Product Style consists of a single box, or multiple boxes that are grouped 
together, use the Pagination Rules panel to set the "Paginate" attribute to be "Once 
Per Group". When this attirubte is specified, the "Group Name" attribute should also 
be set.  The combination of these two attributes tell EasyCatalog which group level the 
Product Style should appear at.

A 'Group Data' Product Style will appear at the start of the specified grouping before 
any record data is output.
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Any tables inside of the Product Style will be populated with data from all of the records 
in the group.  How the data is used to populate the table can be controlled using a 

number of table, row, column and cell options.  Further information on these options 
can be found in the "Tables" chapter beginning on page 101.

➌ PAGINATE
EasyCatalog currently offers five types of pagination:

’INTO TEXT FLOW’

Product Styles are inserted, one after the other, into a text box. A Product Style can 
be inserted for each group and/or record shown in the panel’s hierarchy. 

These Product Styles are inserted as anchored boxes (where the style contains more 
than one box) or as text (where the style contains one text box). This type of pagination 
is the most widely used, and is suitable for all publications where records simply flow 
into the document one after another, such as a directory or price list.

‘AT POSITIONS SPECIFIED IN THE DATA’

Where your data contains positional data, such as a page number, x and y co-ordinates, 
EasyCatalog can use this information to automatically position Product Styles in the 
document.

‘AT PAGE GUIDE POSITIONS’

Product Styles can be automatically placed at the intersection of guides on each page.  
This option is useful for publications that follow a fairly rigid, grid-based, layout or where 
the paginated Product Styles will require some manual alteration once pagination has 
completed.

‘USING MASTER PAGES’

‘Master Pages’ pagination uses Product Styles placed on master pages rather than 
in an InDesign library.  The positions of the Product Styles are predetermined by the 
master page, the order that the items flow into the master page can be defined using 
the Pagination Rules panel.

‘TEMPLATE DOCUMENT’

‘Template Document’ pagination can be used to paginate one document per record 
or group in the panel.  This type of pagination is useful, for example, for producing 
technical data sheets or personalised output.  Template document pagination can 
output PDFs and/or InDesign documents, and can also print during pagination.
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'INTO TEXT FLOW' PAGINATION

Use this type of pagination if the data you are using contains information about exactly 
where on the page each Product Style is placed.  This type of pagination is often 
used in conjunction with planning systems that are capable of outputting geometry 
information.

This type of pagination requires a pagination library and a document to paginate into.  
The content of the pagination document is not important as the library items are placed 
exactly at the positions specified in the data.

 

Requirements

"Into Text Flow" pagination requires:

 Ҙ A Pagination Library

The Pagination Library contains the Product Styles to paginate, which are 
effectively templates for how each record and/or group should appear in the 
document.  Before adding the Product Styles to the Pagination Library, use the 
Pagination Rules panel to set, as a minimum, the "Paginate" attribute.

 Ҙ A document to paginate into

This document requires a text frame to paginate in to, and would typically be a 
"Primary Text Frame" on one of the document's master pages. Using a Primary 
Text Frame will enable EasyCatalog to insert additional pages when required.

Pagination Settings

"Asset Name"

If your data contains the name of a library item to use to paginate each record or 
group of records, specify the field containing this information here. During pagination, 
EasyCatalog uses the content of the field specified here to choose a library item to use.

"Break on Field Change" / "Break Type"

During pagination, EasyCatalog monitors the field specified in this pop-up for changes.  
Each time the value in the field changes, the break specified in the "Break Type" pop-
up is inserted into the text flow.  This option is useful, for example, for inserting page 
breaks each time a new "Category" starts in the data.
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"Restrict Vertical Cell Merging to Page Bounds"

If you are using any of EasyCatalog's automatic table cell merging options, this option 
prevents those merges from crossing page boundaries. 

"Update Furniture After Pagination"

Once pagination is complete, the "Update Furniture" operation will be performed which 
will populate any boxes on the document's master pages that are set to paginatie with  
"Furniture" data.

'AT POSITIONS SPECIFIED IN THE DATA' PAGINATION

Use this type of pagination if the data you are using contains information about exactly 
where on the page each Product Style should be placed.  This type of pagination 
is often used in conjunction with planning systems that are capable of outputting 
geometry information.

If your data is grouped in the EasyCatalog data panel EasyCatalog will attempt to 
paginate these groups by using Product Styles set to paginate at each grouping level. 
If the panel is not grouped (it contains only records) then a temporary grouping for 
the purposes of pagination will be used consisting of the page number, the X and Y 
co-ordinates.  This is to ensure that all records that are set at the same position in the 
document appear in the same Product Style, rather than being placed on top of each 
other.

Requirements

"At Positions Specified in the Data" pagination requires:

 Ҙ A Pagination Library

The Pagination Library contains the Product Styles to paginate, which are 
effectively templates for how each record and/or group should appear in the 
document.  Before adding the Product Styles to the Pagination Library, use the 
Pagination Rules panel to set, as a minimum, the "Paginate" attribute.

 Ҙ A document to paginate into

No special configuration of this document is required as the Product Styles will 
be placed at the positions specified in the data.

"X Position"/"Y Position"

Specify the name of a field that contains the left (X) and top (Y) position of the Product 
Style. Ensure that the correct measurement system is specified.  The X and Y postions 
are relative to the top-left postion of the page, which is at (0,0).

"Width"/"Height"

EasyCatalog can optionally resize the Product Style to the width and height specified 
by the fields selected in these pop-ups. The 'binding' Pagination Rule should be used 
in the Product Style to determine which boxes should resize or move to conform to the 
specified dimensions.

"Asset Name"

Specify the name of a field in your data that contains the name of the Product tyle to 
use. If your data does not contain this information, leave this pop-up as "Unspecified".
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"Apply Master Named In"

Specify the name of a field in your data that contains the name of a master page 
to apply when paginating each record or group. If your data does not contain this 
information, leave this pop-up as "Unspecified".

'AT PAGE GUIDE POSITIONS' PAGINATION

Use this type of pagination if you want your library items to be placed as single, 
'floating' objects on the page after pagination. Guide-based pagination uses page 
or spread guides on your page to determine where library items should be placed.  
The intersection of these page guides is used to place your library item or, if 'Collision 
Detection' is enabled, they are used only as a starting point to paginate.

Requirements

"At Positions Specified in the Data" pagination requires:

 Ҙ A Pagination Library

The Pagination Library contains the Product Styles to paginate, which are 
effectively templates for how each record and/or group should appear in the 
document.  Before adding the Product Styles to the Pagination Library, use the 
Pagination Rules panel to set, as a minimum, the "Paginate" attribute.

 Ҙ  A document to paginate into

Guide-based pagination uses the intersection of page guides to define the 
starting point for pagination, so this document should contain page guides on 
its master pages.  Multiple master pages, each with different page guide layouts, 
can be configured and applied using the "Apply Master Named In" option on the 
Paginate dialog.

"Direction of Flow"

Specify the order of how the Product Styles should flow onto the page.

When paginating 'Across/Down', pagination will start at the top left intersection and 
continue to the next intersection on the right.  Once the right margin is reached, 
pagination will continue at the next horizontal guide further down the page: 
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When paginating 'Down/Across', pagination will start at the top left intersection and 
continue to the next intersection below.  Once the bottom margin is reached, pagination 
will reutrn to the top of the page and continue at the next vertical guide on the page:

'Across/Down (Aligned)' will follow the same pattern as 'Across/Down' but will ensure 
that the top edge of each item in each row align.  This option is generally used when 
each item being paginated can be a different height:
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Across/Down Pagination Across/Down (Aligned) Pagination

"Asset Name"

If your data contains the name of a library item to use to paginate each record or 
group of records, specify the field containing this information here. During pagination, 
EasyCatalog uses the content of the field specified here to choose a library item to use.

"Apply Master Named In"

When starting pagination on a new page, or inserting a new page into the document, 
EasyCatalog applies the master page named in the specified field.  This option enables 
different master pages for different sections to be automatically applied.

"Break on Field Change"/"Break Type"

During pagination, EasyCatalog monitors the field specified in this pop-up for changes.  
Each time the value in the field changes, the break specified in the "Break Type" pop-
up is obeyed.  This option is useful, for example, for inserting page breaks each time a 
new "Category" starts in the data.

"Use next Position if item doesn't fit"

By default, pagination stops with an error if EasyCatalog cannot fit the library item 
being paginated at the current guide position. When this option is checked, pagination 
continues at the next guide position will be tried instead.

"Ignore Page Bounds"

EasyCatalog always ensures that library items placed in the document are within the 
page's margins.  When this option is enabled, pagination library items are allowed to 
extend outside of the right and bottom margins of the page.

"Restrict Vertical Cell Merging to Page Bounds"

If you are using any of EasyCatalog's automatic table cell merging options, this option 
prevents those merges from crossing page boundaries. 

"Collision Detection"/"Gutter"

Collision Detection prevents EasyCatalog from positioning your Product Styles over the 
top of existing page items, or Product Styles that have already been paginated.  When 
Collision Detection is switched on, EasyCatalog uses the page guide intersections as 
a starting point for pagination and Product Styles are positioned wherever possible 
without overlapping other page items.

Collision Detection should also be used when paginating items that are different sizes 
to prevent them from overlapping. The following example shows EasyCatalog placing 
Product Styles on top of each other when 'Collision Detection' is off; when it's on 
EasyCatalog will skip over guide intersections if another page item is already there. 
Boxes from master pages will be ignored by collision detection unless they have been 
overridden on the page being paginated on to.
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The optional gutter parameter ensures that EasyCatalog leaves sufficient space 
between Product Styles and any obstructions found.  This option is only available 
when ‘Collision Detection’ is on.

"USING MASTER PAGES" PAGINATION

Unlike the other forms of pagination, instead of defining a series of Product Styles in 
a Pagination Library ‘Master Pages’ pagination uses Product Styles defined on the 
document’s master pages.

Both the Product Style - and their positions - are defined by the document’s master 
pages.  The 'Position Index' attribute applied to each Product Style is used to determine 
the order that the data flows into the document.

Requirements

"At Positions Specified in the Data" pagination requires:

 Ҙ  A document to paginate into

The Product Styles for 'Master Pages' pagination are defined on the pagination 
document's master pages, so a Pagination Library is not required.
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Paginate

The document can either be paginated a page or spread at a time.

‘Page’-based pagination should be used when the Position Indexes of the Product 
Styles do not run across multiple pages on the master spread. 

When paginating 'Pages', the Position Indexes should start from '1' for the first record on each page.

‘Spread’-based pagination should be used when the flow of data should run across 
the spread.
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In this example the Position Indexes, and therefore the flow of data, go across the spread from left-to-right

Page No.

By default, the data is paginated in the order shown in the panel through the document.  
Specify the name of a field containing the page number to place the record or group 
of records on in this pop-up.

Page Field Contains

When using the 'Page No.' option, specify whether the content of the page number 
field contains page indices or section page numbers.  Page indices run from 1 thru the 
number of pages in the document; the "Pages Panel Name" option refers to the page 
number shown in the Pages Panel.

Layer

Each record or group of records in the panel can target a specific layer in the document.  
If your data contains this information, specify the name of the field containing the name 
of the layer to use in this pop-up.

Break On Field Change

When the content of the specified field changes, pagination continues on the next 
page or spread (depending on the setting specified by ➀ above).

Apply Master Named In

When pagination moves to a new page or spread, the master page specified by the 
content of the selected field is applied.

Positions Are

This pop-up defines whether each of the positions specified on the master pages is 
populated with record data or group data. When populating with group data select the 
appropriate group name in the pop-up.

Quantity

Each record or group of records can be paginated multiple times.  This option allows 
you to specify a field that contains the number of times each record or group of records 
should be paginated.

Rule

By default the boxes on the master page will be populated with data for the records 
or groups being paginated.  However, by specifying the name of a field that contains 
the name of a Formatting Rule to use, the positions become placeholders for where 
Formatting Rules should appear. During pagination EasyCatalog will place the specified 
Rule for each record or group at each position specified on the master page.

Unused Positions

By default, any positions that are not populated on the page or spread will be deleted 
after pagination.  Change this pop-up to 'Override' to override the master page item 
in the document but leave them unpopulated, or 'Remove Override' to any overriden 
postiions on the page.

TEMPLATE DOCUMENT

Use Template Document pagination when one document and/or PDF is required per 
record or group of records in the panel.  This type of pagination is typically used for 
producing technical data sheets or personalised documents.

Requirements
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"Template Document" pagination requires:

 Ҙ A template document

The Field Specifiers in this template document will be populated with data for the 
record or group of records being paginated.  This document will be opened for 
each record (or group) being paginated, populated and then output.

Positions Are

Change this popup to specify whether one document, PDF or print should be output 
per record selected in or per group.  When paginating with groups, any tables in the 
template document will be populated in the same manner as tables within Product 
Styles.

Template Document

Press the 'Choose' button to locate your template document. This document can 
either be an InDesign document or template document, and any Field Specifiers in this 
document will be populated with the data being paginated.

Output Folder

The folder specified here will be used during pagination when EasyCatalog is outptting 
either a document or PDF.  Custom field commands can also be entered in to this path 
and will be evaluated during pagination.  For example:

Macintosh HD:My Output:FIELDSTR(brand)

During pagination each PDF or document being output would be placed in a sub folder 
of the "Output" folder, and the name of this sub folder will be the content of the "Brand" 
field for the record(s) being paginated.

Filename

When outputting a PDF or InDesign document, EasyCatalog needs to build a unique 
filename for each file.  Custom field commands should be used in this field to specify 
how the filename should be constructed - e.g.

Data Sheet FIELDSTR('Product Code')

In this example, the content of the Product Code for the record(s) being paginated will 
be appened to the text 'Data Sheet' to form the output's filename.  A '.pdf' or '.indd' 
suffix will be added automatically depending on the type of output being produced.

Output Document

Check this option to output one document per record(s) being paginated to the output 
folder. Optionally check the 'Collate Documents in a Book' to automatically create an 
InDesign book in the output folder containing all of the documents that are produced.

Output PDF

Check this option to output one PDF per record(s) being paginated to the output folder.  
Ensure that the correct PDF profile is selected in the pop-up.

Print using Preset

Check this option to output each document to the default printer during pagination. 
Ensure that the correct print profile is selected in the pop-up.



EasyCatalog User Guide Automatic Pagination- 84 -

CHOOSING PRODUCT STYLES BASED ON FIELD CONTENT
During automatic pagination, the Pagination Module can select which library item to 
use from the Pagination Library based on the content of one of your fields in the data.

There are two ways of affecting the library item that is chosen:

USING THE ASSET NAME FIELD ON THE PAGINATION DIALOG

On the ‘Paginate...’ dialog, select the the field that contains the name of the library item 
to use.

Name each library item using the ‘Information’ button on the library panel.  The name of the library item 
should match the contents of one of your fields in the data.

Specify the name of the field containing the library style name in the Pagination dialog

USING THE ‘IGNORE’ PAGINATION RULE

If you have the Pagination Module installed, the Pagination Rule ‘Ignore’ can also 
be used to force the Pagination Module to ignore a library item and choose another 
when paginating the document.  Further information can be found in the Pagination 
Reference section.
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CHAPTER 10

PAGE HEADERS
INTRODUCTION 
EasyCatalog supports the automatic population of page headers based on the content 
of each page using a Pagination Attribute called ‘Furniture’.

Furniture page items are usually found on master pages, and are typically used for 
page headers, etc, that should contain summary information for the records placed on 
the page or spread.

For example, if you’re paginating a directory, using Furniture it is possible to create a 
page header that contains details of the last entry on a spread.

The options shown in this chapter are only available when the 
Pagination Module is installed.i

DEFINING FURNITURE
Furniture boxes are designed on the page using Field Specifiers, in exactly the same 
way as Product Styles are defined for EasyCatalog Libraries.  Typically, furniture page 
items will be included as part of the master page design to ensure that they are present 
on each page of the document after pages have been inserted by Pagination.

‘Furniture Data’ is an attribute that is applied to a page item using the Pagination Rules 
panel.  The record data to used to populate the page items must also be specified 
using the ‘Populate Using’ attribute.

Populate Using Description

First item on page
The box will be populated with the content of the first record on the page.  
The ‘first’ is determined to be the record that is nearest to the top-left corner 
of the page

Last item on page Populate with the content of the last record on the page.  The ‘last’ is 
determined to be the record closest to the bottom-right of the page.

First item on document Populate with the first record in the document - the record that’s closest to the 
top-left of the first spread.

First item on spread Populate with the first record on the spread. 

Last item on spread Populate with the last record on the spread.

Last item on document Populate with the last record in the document - the record nearest the bottom-
right of the last spread.

The ‘Populate Using’ attribute can also be applied to group boxes - each box in the 
group will be populated with the record data determined by the ‘Populate Using’ 
attribute.
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POPULATING FURNITURE
Furniture Data is usually updated after pagination or 
when the document is near completion as it does not 
automatically update if the document reflows.

 Ҙ Updaing document furniutre

Use the ‘Update Furniture’ panel menu option from 
your data panel's pop-out menu to populate all 
Furniture page items in the document.  

 Ҙ Updating Furniture in an InDesign Book

The "Update Furniture" menu option is also available 
from the "EasyCatalog" sub-menu on the book 
panel's pop-out menu.

 Ҙ Automatically updating Furniture after pagination

Check the "Update Furniture after Pagination" option 
on the "Paginate" dialog to automatically update the 
furniture boxes once pagination is complete.

If your Furniture page items are on a master page, they 
will be overridden on each document page prior to 
being updated. If furniture boxes have previously been 
overridden in the document, you have the option to 
remove the local page overrides and override the items 
again.

During the population of furniture page items, 
EasyCatalog will examine the content of each page in 
the document and populate the furniture boxes with the 
record determined by the "Populate Using" attribute.  

So, for example, if "Populate Using" is set to "First on 
Page", EasyCatalog will scan the page and populate the 
furniture box with data from the first record placed on 
the page. 

The box will be populated in the same way as boxes 
in Product Styles, so it's possible to assign Pagination 
Rules that apply a swatch, resize to fit the content, etc. 
Actions can also be applied to boxes, and these will be 
evaluated using the record being used to populate the 
box. For example, tabs down the outside edge of the 
spread can be achieved by including all possible tabs on 
the master page and use an action to delete the ones 
that do not apply.
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CHAPTER 10

FORMATTING RULES
INTRODUCTION 
EasyCatalog’s Formatting Rules provide an alternative to traditional pagination 
methods and offer much more flexibility when updating the document with new data.  
By using Formatting Rules instead of standard InDesign libraries EasyCatalog is able 
to dynamically update Rules in the document if the data changes or if the design of 
the Rule is modified.  This includes being able to automatically insert new data into the 
correct position in the document and delete data that should no longer be present.

Formatting Rules consists of two main configuration parts: Rules and Rule Sets.  A 
Rule defines how an individual piece of data (such as a record or a group of records) 

should appear and a Rule Set is a collection of Rules. A Rule Set is used to determine 
which Rules should be considered for placement in the document. the style in which 
they should appear, EasyCatalog can automatically import and formatted data content.

Some options shown in this chapter are only available when the 
Pagination Module is installed.i

ADVANTAGES OF USING FORMATTING RULES
Formatting Rules provide a number of advantages over using standard pagination:

 Ҙ There is a link between the Rules placed in the document and the Rules shown in 
the Formatting Rules panel.  This allows the design of a Rule to be updated and the 
document updated with this change. 

 Ҙ When placing a Rule Set, the configuration of the panel is also stored (such as how 
the panel is grouped, sorted, etc).  This allows EasyCatalog to:

 Ҙ Automatically insert new records by choosing the appropriate Rule from the Rule 
Set

 Ҙ Automatically delete old records as the position of each record  and group is tracked

 Ҙ Update placed Rules, including adding or removing rows from tables in items that 
are populated with group data.

 Ҙ Reorder placed Rules if the order of the data changes whilst retaining any formatting 
that has been applied.

 Ҙ Formatting Rules and Rule Sets are stored in the document itself, so no external 
pagination library is required.

 Ҙ A Pagination library can only contain one set of Product Styles, whereas Formatting 
Rules allows the user to define multiple Rule Sets, each containing a different 
combination of Rules.

WHAT ARE RULES?
A Rule can be considered to be equivalent to a library item in an EasyCatalog Pagination 
library, and they define both how and when a Product Style should appear in the 
document. 

Rules have a number of configuration options which specify:

 Ҙ Where in the data structure of the panel the Rule should be used

 Ҙ Whether the rule should be used selectively for only certain records or groups in 
the panel
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 Ҙ Appearance settings, such as whether the Product Style should be inserted as an 
anchored object.

Rules can either be dragged to the document and paginated with data in a similar 
manner to EasyCatalog Library items or, when included in a Rule Set, paginated into 
a text box.

WHAT ARE RULE SETS?
Rule Sets are collections of Rules, and can be considered to be equivalent to an 
EasyCatalog Pagination library. 

Rule Sets can be used to automatically paginate data into the document in a similar 
manner to flow-based pagination. When placing data in the document, the Rule Set is 
used to determine which Rules can be used. 

Multiple Rule Sets can be configured in the document, each containing different 
combinations of Rules.  This allows the same Rules to be used in different situations: 
for example, you could have a Rule Set for the main document pagination and another 
to paginate the index.

THE FORMATTING RULES PANEL
Formatting Rules and Rule Sets are controlled from the ‘EasyCatalog Formatting 
Rules’ panel, which can be found on the ‘Window’ menu within InDesign.

CREATING FORMATTING RULES
The first step in creating a new Rule is to create your Product Style in the document, 
using the techniques shown in "Dynamic Content" on page 65.  If you have already 
configured an EasyCatalog library, turn off the ‘EasyCatalog Library’ menu option on 
the library panel’s pop-out menu and drag each library item to the document.

To create a new rule, you can either:
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 Ҙ Select all the boxes in the document that make up the Product Style and use the 
‘Create Rule from Selection’ menu option on the Formatting Rules’ panel pop-out 
menu (or press the ‘Create Rule From Selection’ button at the bottom of the panel).

or

 Ҙ Drag the boxes the make up the Product Style to the top part of the Formatting 
Rules panel.

Drag

The new rule will be given a default name which can be changed by editing the Rule.
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EDITING FORMATTING RULES PROPERTIES
Rule properties can be edited by double clicking on the Rule name or by selecting the 
Rule in the list and using the ‘Edit Rule’ option on the panel’s pop-out menu.

The Rules dialog has three configuration panes:

GENERAL

➋

➍

➊

➌

This pane shows a preview of the Product Style, and is used to determine when in the 
data structure this Rule should be paginated.

➊  Name

Specify the name of the Rule.  This name must be unique and is used to identify the 
Rule.

➋  Data Source

Select the data source that you are intending to use this Rule with. This pop-up is 
used to ensure that the correct groups are available from the ‘Group Name’ pop-up.

The data source specified here does not affect the placement of data, as rules are 
not associated with a specific data source.

➌  Usage

This attribute specifies whether the Rule will be inserted once for every record in the 
panel, or it will be inserted for a specific group in the panel.

➍  Group Name

When ‘Usage’ is set to ‘Groups’, the name of the field that the panel is grouped by 
should be selected in the ‘Group Name’ field.  To ensure the correct fields are listed, 
change the ‘Data Source’ pop-up to the correct data source.

FILTERS

The Filters pane is used to specify criteria for when the Rule will appear during Rule Set 
pagination. Filters test the values of fields in the data source and can be used to ensure 
that Rules only appear when certain data conditions are met.

By default the Rule will appear for every record or group (as specified on the General 
pane) unless filters have been specified.
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➊
➋

➌ ➍

➊  Data Source

Select the data source that you are intending to use this Rule with. This pop-up is 
used to ensure that the correct groups are available from the ‘Field’ pop-up.

Filters are specified using a series of Field, operator and value criteria:

➋  Field

The field to be tested. Fields from the data source selected in the ‘Data Source’ 
pop-up will be shown here.

➌  Operator

The operator here is used to determine which test will be performed on the field 
selected in the Field pop-up.

➌  Field Value

The selected operator will use this value as part of the test

For example, if we only want this rule to appear when the ‘Ex VAT Price’ is greater than 
10 the following criteria would be used:

If a Rule Set contains multiple Rules that all pass their specified filter tests, the Rule 
with the most parameters that matched will be chosen.  In the event of a tie, the first 
matching rule will be used.
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ATTRIBUTES

The options shown on this dialog are only available when used with 
a licensed version of the Pagination Module.i

The Attributes pane is used to specify attributes that determine how the Rule should 
appear when placed during Rule Set pagination, and can also be used to apply post 
pagination rules such as deleting boxes if they are empty. The attributes shown on this 
pane are covered in more detail in the  ‘Pagination Attribute Reference’ chapter.
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DELETING RULES
Rules can be deleted by selecting them in the list and using either the trash can button 
at the bottom of the panel or the ‘Delete Rule’ menu option. Rules that are deleted will 
be removed from any Rule Sets that they are placed in, and the Rule will be deleted 
from the document during the next ‘Update Document’ operation.  

DUPLICATING RULES
Any Rules selected in the list can be duplicated using the ‘Duplicate Rule’ menu option 
from the panel’s pop-out menu. Duplicated rules will not be associated with a Rule Set.

MODIFYING A RULE'S PRODUCT STYLE
The Product Style for a Rule can be modified by dragging the Rule from the Formatting 
Rules panel to the document.

Once the changes have been made drag the Product Style from the document to the Rule in the panel or 
use the ‘Put Rule Away’ menu option.

Drag

To edit the Product Style associated with a Rule, drag the Rule from the Formatting Rules panel to the 
document.
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POPULATING A RULE WITH DATA
Rules can be populated with data in the same manner as InDesign page objects by 
dragging and dropping from the EasyCatalog data panel to the document.  

Drag

Drag the Rule from the Formatting 
Rules panel to the document

Drag

Drag data to the Rule 

The status indicator turns green to 
show that the data inside the Rule 

has not been modified and does not 
need to be updated

Placed Rules also show a status indicator which shows whether the Rule is up-to-date.  
A Rule is considered to be up-to-date when the data it contains has not been modified 
and the Rule itself has not been modified since it was placed. A Rule is considered to 
have been modified if any of its attributes have been changed in the Formatting Rules 
panel or if the Product Style associated with a Rule has been updated.

If the Rule has been populated with data, the Rule has not been modified since it was placed and the 
data has not changed it will have a green status.

If the Rule has been modified or the data has changed, the rule will be shown with a red status.

The yellow status indicator shows that the Rule has been placed in the document but has not been 
populated with data
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The Rule Status indicator will not check the content of each individual field to determine 
whether it matches the source data: the colour of the individual field markers should 
be used for this purpose.

If a Rule’s status indicator is red, use the ‘Inspect Rule Applied To Selection...’ menu 
option from the Formatting Rules’ pop-out menu.

➋
➊
➌

➍

➎

➊  Rule

The name of the placed rule

➋  Status

The current status of the placed rule. The status will be one or more of the following 
values:

Status Description

OK Neither the data or the Rule has changed since the Rule was placed in the 
document.

Data Source 
Unavailable

The data source is no longer available: it is not open, or has been removed 
from the workspace folder.

Rule Out Of Date The Rule has been modified since it was placed in the document.

Data Out Of Date The data has been modified since the Rule was placed in the document.

No Data Assigned The Rule has not been populated with data.

Rule Does Not Exist The Rule has been deleted.

➌  Data Source

The name of the data source from which the data was placed.

➌  Data Selection Criteria

The values shown here are used to identify the data that was used to populate the 
Rule.

➍  Latest Data

Using the criteria shown in ➍, this preview panel shows that data that will be used 
to populate the Rule during an Update Document operation.

UPDATING THE DOCUMENT

During the ‘Update Document’ operation Rules will be re-imported if the data for any 
of the records used to populate the Rule have changed or if the Rule itself has been 
modified.  When re-importing the Rule any local formatting modifications will be lost.
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CREATING RULE SETS
New Rule Sets can be created by pressing the ‘New Rule Set’ button at the bottom of 
the panel or by selecting the ‘New Rule Set’ menu option on the panel’s pop-out menu.  

Rule Sets are shown as folders in the bottom part of the Formatting Rules panel.  To 
show the Rules associated with a Rule Set use the disclosure triangle next to the folder 
icon.

ADDING RULES TO RULE SETS

To assign a Rule to a Rule Set, drag the 
Rule from the Rules list to the appropriate 
Rule Set.

Each Rule can be assigned to multiple Rule 
Sets.

Dr
ag

REMOVING RULES FROM RULE SETS

Select the Rule in the Rule Set that you wish to remove and use the ‘Remove Rule from 
Rule Sets’ menu option.  Changes to the contents of Rule Sets will be applied on the 
next ‘Update Document’ operation.
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POPULATING A RULE SET

Rule Set pagination is only available when using a licensed version 
of the Pagination Module.i

Once all Rules have been assigned to the Rule Set, the Rule Set can be paginated 
in the document.  Rule Set pagination behaves in a similar manner to flow-based 
pagination.  Rules are paginated into an InDesign text box either as anchored objects 
or as text (depending on the Rule’s ‘Insert’ attribute).  

Paginating a Rule Set consists of only two stages:

➊ Assign the Rule Set to a text box to paginate into:

To paginate a Rule Set, drag the Rule Set from the Formatting Rules panel to a text box on the document

Drag

 The Rule Set that has been applied
 to the text box is shown in the

bottom right
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➋ Drag the data to paginate from your EasyCatalog data panel to the text box:

Drag

Drag data from the data panel to the Rule Set box on the page to populate it

When paginating a Rule Set EasyCatalog stores both the data and it’s structure at 
the time of pagination. Modifications to the structure or order of data in the panel will 
not affect the order of records in the document.  The ‘Update Document’ operation 
will ensure that the data remains ordered and structured in the same form as when 
originally paginated.

UPDATING THE DOCUMENT

Rule Sets are updated as part of the ‘Update Document’ operation. However, different 
rules apply to what is updated and when:

 Ҙ  New records will be inserted in the correct position by choosing the appropriate 
Rule from the applied Rule Set

 Ҙ  Deleted records will be removed from the flow

 Ҙ  Updated records will be reinserted in the flow. Any local formatting made to the 
Rule will be lost during the update process.

 Ҙ  If a change to the data has resulted in the order of the data changing, the 
Rule will be moved into the correct position in the flow. Local modifications to 
formatting and content will be retained provided that the data for the Rule has 
not changed and the Rule has not been modified.

 Ҙ  If a Rule has been updated, all placed instances of the Rule will be updated. 
Local modifications to the formatting and content of the Rule will be lost.
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IMPORTING RULES
Rules can be imported from an existing EasyCatalog Library or from another document 
that has Formatting Rules configured.

IMPORTING FROM A LIBRARY

Use the ‘Import Library As Rule Set’ menu option from the Formatting Rules panel’s 
pop-out menu.

When importing from a library new Rules will be created for each library item and a new 
Rule Set will be created. The Rules will be created with the same name as the library 
items; the Rule Set name will be the name of the library.

IMPORTING FROM A DOCUMENT

Use the ‘Import From Document’ menu option from the Formatting Rules panel’s 
pop-out menu.

USING RULE SETS WITH PAGINATION
Rule Sets can also be used with Pagination instead of specifying a Pagination Library. 
 

 

On the ‘Paginate’ dialog specify whether you wish to paginate the contents of a library or a Rule Set

'INTO TEXT FLOW' PAGINATION

Flow-based Pagination will paginate into a text box in the same manner as paginating a 
Rule Set.  The Pagination Module will automatically assign the Rule Set that is selected 
in the pop-up to the text box being paginated into.  As the text box now has an 

assigned Rule Set, updating the document using the ‘Update Document’ menu option 
will follow the rules listed for updating Rule Sets.

'AT PAGE GUIDE POSITIONS' AND 'AT POSITIONS SPECIFIED IN THE 
DATA' PAGINATION

The Rule Set specified in the pop-up on the ‘Paginate’ dialog is used to determine 
which Rules to consider during pagination. As these types of pagination do not 
paginate into a text flow, the rules concerning the ‘Update Document’ operation are 
slightly different:
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 Ҙ  As pagination has not inserted into a text flow, the Rules will not reflow 
automatically when a new item is inserted for example. 

 Ҙ New Rules will not be inserted into the document automatically.

 Ҙ Rules for deleted records will not be removed from the document automatically

 Ҙ If a Rule has been modified in the Formatting Rules panel (or by changing the 
Product Style assigned to a Rule) it will be replaced in the document during the 
‘Update Document’ operation.

 Ҙ If data for a Rule changes the Rule will be replaced in the document. If the Rule 
has been set to paginate at a group level, for example, and the Rule contains a table 
it will be updated if new records have been added to the group. 

'TEMPLATE DOCUMENT' PAGINATION

If a Rule Set is placed inside of the template document used for 'Template Document' 
pagination, it will be populated with data for the record or group being paginated into 
the document.
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CHAPTER 11

TABULAR DATA  
INTRODUCTION 
EasyCatalog offers a number of ways of paginating tabular data - from simply manually 
inserting a new table where required though to building tabular data content by 
transforming XML or using LUA, a lightweight programming language. The type of 
tabular pagination you use is largely determined by the format of your source data.

 Ҙ Simple Tables

A table can be created by simply selecting the fields to insert in your data panel and 
pressing the insert button.  See page "Simple Tables" on page 101. 

 Ҙ Designed Tables

By including your table in a Product Style, formatting information can be applied 
to your table (such as cell style, row options, etc) to define how your table should 

appear.  Header rows for data grouping can also be included.  See page "Designed 
Tables" on page 102. 

 Ҙ Tabular Fields

EasyCatalog's tabular fields allow you to store tabular data in a single field.  This 
can be something as simple as tab delimited data, or it could be XML that is 
transformed using XSL into an HTML <table> structure.  We also support LUA, 
a lightweight programming language, to enable you to write complex scripts that 
build the final table structure.  See page "Tabular Fields" on page 109. 

SIMPLE TABLES
Simple tables are ideal for situations where you want to quickly insert a table and 
manually reformat it later. Inserting a simple table is as easy as selecting the records 
and fields to insert in the panel and hitting the ‘insert’ button. EasyCatalog will apply 
the default table style ‘[Basic Table]’ to the inserted table.

INSERTING A NEW TABLE

 Ҙ  Use the sorting and filtering options to re-order your data.

Prior to inserting your table, you need to ensure that the data in your panel is in the 
order you would like it to appear in the table. For example, if you want your records 
to be inserted in ascending price order ensure that the panel is sorted by the price 
field.

When inserting the table EasyCatalog will create columns of the same proportion 
as the columns in the panel.

 Ҙ Select the fields to insert in the table 

 Ҙ Ensure you have a text insertion point

New tables can only be inserted when you have a valid text insertion point that is 
not within an existing table.

 Ҙ Hit the ‘Insert’ button

INSERTING INTO AN EXISTING TABLE

When the insertion point is within an existing document table, data from the panel will 
be inserted into it. As much data as possible will be inserted into the table - it will not 
be expanded or contracted.
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DESIGNED TABLES
EasyCatalog allows you to design your tables using standard InDesign tools -- applying 
table, row, cell and column formatting. By including Field Specifiers in your table, it 
is possible to create tables that adapt to accommodate the amount of data you're 
paginating.

DESIGNING THE TABLE

Create your table using InDesign's standard tools, including Field Specifiers where 
the data should appear in the table.  By default, EasyCatalog will expand or contract 
the body area of the table so that there is one row per record being paginated.  Field 
Specifiers in the header and footer area of the table will be populated with data from 
the first record being paginated.

Field Specifiers Group Row - see 'Row Options', below

POPULATING THE TABLE

The table can be populated by dragging data from the panel to the table on the page, 
or by including the table in a Product Style that's stored in an EasyCatalog libary.

DRAG

ADJUSTING TO YOUR DATA

EasyCatalog also offers a number of options for controlling how the table presents 
and adapts to your data.  For example, empty columns can be deleted and the width 
of the remaining columns adjusted to maintain the original table's width. Using these 
techniques, it's possible to define a single table that adapts to the data that's being 
paginated.

ROW OPTIONS

The table's row options can be edited using the Table > Row Options menu from the 
data panel's pop-out menu.
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➊ ➋ ➌ ➍

➎
➊ Record/Group

Specifies whether this row should be inserted once per record (the default) or once 
for each group (specified in ➋ below).

➋ Populate with data from group:

Specifies the name of the group that this row should appear for. This row will be 
inserted each time the specified group appears in the panel.  In the example above, 
a new row is inserted for each "Manufacturer" group in the panel. 

➌ Insert

Insert Description

At the start of the 
group

This row will be inserted as a header row for the group.

Once Per Group

This row will be inserted each time the group appears in the panel.  This option 
changes the way 'delete empty columns' operates: when a row is set to 'At the 
start of the group' it will not be considered when determining whether the column 
in empty or not; when the row is set to 'Once per group' it will.

At the end of the 
group

This row will be inserted as a footer row for the group.

➌ Allow Single Instances

This option can be used to control whether a single instance of the nominated group 
can appear in the table.  For instance, if populating a table with data from a single 
"Manufacturer" it may not be necessary to include the Manufacturer's group row in 
the table.

➍ Delete

Delete Description

Never This row will not be deleted, regardless of whether it is empty or not

When Fields Are 
Empty

The row will be deleted when the fields it contains are empty. Any non-field 
content, such as static text will be ignored.

When Cells Are 
Empty

For the row to be deleted, every cell in the row must be empty.  This option will 
check both field and non-field content in the row and only delete it if it's empty.

 

COLUMN OPTIONS

The table's row options can be edited using the Table > Column Options menu from 
the data panel's pop-out menu.

➋

➊
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➊ Delete

Delete Description

Never This column will not be deleted, regardless of whether it is empty or not

When Fields Are 
Empty

The column will be deleted when the fields it contains are empty. Any non-field 
content, such as static text will be ignored.

When Cells Are 
Empty

For the column to be deleted, every cell in the column must be empty.  This option 
will check both field and non-field content in the column and only delete it if it's 
empty.

➋ Width

The width of the selected column(s) can be adjusted to accomodate the data that 
has been used to populate the table.  When adjusting the width of the columns, 
EasyCatalog will always attempt to ensure that the overall width of the table is 
within the parameters specified on the Table > Table Options dialog.

Width Description

Fixed This column will not be resized

Variable (Fill 
Space of Deleted 

Columns)

This column will be resized if other columns in the table are deleted.  The width of 
this column will increase to fill the space that was made available by deleting other 
columns.  By default, each 'Variable' column will receive an equal proportion of 
the avilable space.  To apportion space depending on the amount of text in the 
column use the  'Distribute Free Column Space' option on the Table Options 
dialog.

Fit to Content The width of the column will be adjusted to the width of the text within it, whilst 
obeying the minimum and maximum parameters specified.

Specified By Field The width of the column will be set to the width in the specified field.  The 
nominated field from the first record being used to populate the table.

TABLE OPTIONS

Options that apply to the table as a whole can be edited using the Table > Table 
Options dialog.  Complex data structures, such as XML, can also be used to populate 
a table, and this dialog contains the configuration options for determing where the XML 
data should be retrieved from and how it should be transformed.

➊

➋
➊ Width

Width Description

Fixed Width EasyCatalog will attempt to maintain the pre-pagination width of the table

Variable When paginting the table EasyCatalog will ensure that the final width is between 
the specified parameters when resizing columns.

➋ Column Resizing

The options specified here affect how much space is allocated to each 'Variable (Fill 
Space of Deleted Columns)' column.

Option Description

Evenly Every 'Variable' width column will be treated the same, and so each will receive 
an each proportion of the available space.

Proportionally, 
based on content

Columns will receive a portion of the available space based on how much content 
they have, so those columns with a lot of content will receive more space than 
those with less content.

POPULATING TABLES WITH COMPLEX DATA

By default EasyCatalog will populate the table one-row-per-record, expanding or 
contracting the table to accommodate the amount of data being paginated.  It is 
also possible to populate the table using complex data structures such as XML or 
tabular fields. The Table Options dialog allows alternative table population options to 
be specified:
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The default option for all tables is a 'Simple, Design Driven' table: that is, create one 
new row in the table for each record being paginated.  The table will expand vertically, 
adding new rows if there is too much data for the table or deleting rows if there is not 
enough.

POPULATING TABLES HORIZONTALLY

The 'Expand' pop-up can be used to specify that new columns should be created in 
the table for each record. If there is only a single column in your table prototype, this 
will be repeated for each record being paginted.  If there is more than one column, 
EasyCatalog will assume that the left-most column is a header column.  It will then 
create sufficient columns to paginate one column per record.  The header column will 
be populated with data from the first record being paginated.

POPULATING TABLES WITH XML DATA

EasyCatalog can populate the table with data formatted as in an HTML <table> 
structure.  If your source data is not in this format, XSLT can be used to transform 
it.  EasyCatalog is also able to generate XML from your data or from data stored in a 
separate data source.
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XML
HTML

<table>
External data 

source

XSLT

HTML
<table>

InDesign 
Table

Source Data
EasyCatalog requires your source data to be in an HTML <table> structure. If it's not, 

it can be transformed using XSLT

Source Data:

XML from Record(s)

EasyCatalog can create XML for the record or group of records being used to paginate 
the table.  This will be in the form of <group> and <record> nodes that represent how 
the data is structured in the panel.  The XML node names will be based on the names 
of the fields in the data source, with illegal characters replaced with underscores. 
EasyCatalog will generate XML for the record in the following format:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<group>
 <group name = "Parent Category">
  <group name = "Child Category">
   <group name = "Manufacturer">
    <record>
     <Stock_Code>2Z9B</Stock_Code>
     <Manufacturer>Sony</Manufacturer>
     <Manufacturer_Part_Code>ZR6B2</Manufacturer_Part_Code>
     <Description>Digital X AA Oxy-Nickel 2-Pack</Description>
     <Parent_Category>Batteries &amp; Chargers</Parent_Category>
     <Child_Category>Multipurpose Batteries</Child_Category>
     <Ex_VAT_Price>$2.25</Ex_VAT_Price>
     <Inc_VAT_Price>$2.64</Inc_VAT_Price>
     <Availability>Ordered Upon Request</Availability>
    </record>
   </group>
  </group>
 </group>
</group>

HTML/XML Content From Field

If one of the fields in your source data contains an HTML <table>, this field can be used 
without modification.  If your field contains XML data, it must first be transformed using 
XSLT to output an HTML <table>. Use the 'XML Transformation for XML Data' option 
(below) to edit the XSLT to transform the XML into HTML.

Query an exsiting data source.  Output:

! This option requires the Relational Module.

Data from another EasyCatalog data source can be queried by entering an SQL 
statement into the edit field. The data can be returned as an HTML <table> structure 
or as XML.
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XSL Transformation for XML Data

If the source data, specified above, for the table is formatted as XML it must first be 
transformed into an HTML <table> structure which can then be used to populate the 
table in the document.  Press the 'Edit...' button to edit the XSLT transformation for 
this table.

! This option requires the XML Data Provider Module.

XML

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<AttributeValues>
 <AttributeValue attributeId="quantity" orderNo="10">68</AttributeValue>
 <AttributeValue attributeId="order code" orderNo="7">GF 33</AttributeValue>
 <AttributeValue attributeId="id" orderNo="9">116</AttributeValue>
 <AttributeValue attributeId="description" languageId="de" 
orderNo="2">&lt;p&gt;AC99AFFF mit FG 50&lt;/p&gt;</AttributeValue>
 <AttributeValue attributeId="width" orderNo="13">4000</AttributeValue>
 <AttributeValue attributeId="height" orderNo="6">20</AttributeValue>
 <AttributeValue attributeId="diameter" orderNo="11">100</AttributeValue>
 <AttributeValue attributeId="price" orderNo="8">312,5</AttributeValue>
</AttributeValues>

XSLT

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
<xsl:template match="/">
<table>
  <xsl:for-each select="/AttributeValues/AttributeValue">
  <xsl:sort select="@orderNo" data-type="number" order="ascending" />
    <tr>
       <td><xsl:value-of select="@attributeId" /></td>
       <td><xsl:value-of select="text()" /></td>
    </tr>
  </xsl:for-each>
</table>
</xsl:template>
</xsl:stylesheet>

HTML
<table>

<?xml version="1.0" encoding="UTF-8"?>
<table>
 <tr>
  <td>description</td>
  <td>&lt;p&gt;AC99AFFF mit FG 50&lt;/p&gt;</td>
 </tr>
 <tr>
  <td>height</td>
  <td>20</td>
 </tr>
 <tr>
  <td>order code</td>
  <td>GF 33</td>
 </tr>
 <tr>
  <td>price</td>
  <td>312,5</td>
 </tr>
 <tr>
  <td>id</td>
  <td>116</td>
 </tr>
 <tr>
  <td>quantity</td>
  <td>68</td>
 </tr>
 <tr>
  <td>diameter</td>
  <td>100</td>
 </tr>
 <tr>
  <td>width</td>
  <td>4000</td>
 </tr>
</table>

➊ Example XML

An example of the XML that will be used to populate the table will be shown here, 
based on the record(s) selected in the panel. 
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➋ XSL Transformation

Enter the XSL transformation that should be used to tranform the XML into an HTML 
<table> structure. 

➌ Test

Use the 'Test' button to apply the XSL transformation to the XML.  The preview table 
➍ will be updated to show the table structure.

➋

➊

➌

➍
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TABULAR FIELDS
If your data contains data in a single field that should be output as a table in the 
document, EasyCatalog's 'Tabular Field' field type can be used.  Using tabular fields, 
it's possible to output data that would be too complex to represent  using a simple 
record/field type structure. Data in your tabular field can be presented to EasyCatalog 
as XML, HTML (in the form of an HTML <table> structure), or as delimted text (such as 
tab or comma-delimted data).  

Delimted text example:

Key Description Price Specifications See Also

AAA123 Red Widget 99.99 Width»10cm¶ Height»20cm¶ Depth»30cm AAA124»Blue Widget¶ AAA125»Yellow Widget¶ 
AAA126»Green Widget

In this example, the 'Specifications' and 'See Also' fields contain data in a tab-delimted 
format.  

XML example:

Here the 'Specifications' and 'See Also' fields contain data represented as XML.  This 
XML will need to be transformed using XSL into an HTML <table> structure before it 

can be output to the document.  Each tabular field has its own XSL transformation 
specified, so the format of the XML can be different in each field.

Key Description Price Specifications See Also

AAA123 Red Widget 99.99 <specifications>
<attribute name="Width">10cm</attribute>
<attribute name="Height">20cm</attribute>
<attribute name="Depth">30cm</attribute>
</specifications>

<alternatives>
<alternative code="AAA124">Blue Widget</alternative>
<alternative code="AAA125">Yellow Widget</alternative>
<alternative code="AAA126">Green Widget</alternative>
</alternatives>

HTML example:

Here the data in the 'Specifications' and 'See Also' fields are represented in an HTML 
<table> structure.  No further transformation of this data is necessary.

Key Description Price Specifications See Also

AAA123 Red Widget 99.99 <table>
<tr><td>Width</td><td>10cm</td></tr>
<tr><td>Height</td><td>20cm</td></tr>
<tr><td>Depth</td><td>30cm</td></tr>
</table>

<table>
<tr><td>AAA124</td><td>Blue Widget</td></tr>
<tr><td>AAA125</td><td>Yellow Widget</td></tr>
<tr><td>AAA126</td><td>Green Widget</td></tr>
</table>
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➋

➍

➐

➊

➌

➎

➏

➊ Source

Field Content Description

Field Content The contents of this field will be used to populate the table.  The format fo the 
content of this field can be specified in the "Field Content Type"

HTML This field contains HTML - more specifically, it contains an HTML <table> 
structure.  

Delimted Text
This field contains contains delimted data, such as tab-delimited or comma-
delimited data. The field and record separators can be specified using the 
'Confgure...' button.

➋ Field Content Type

Field Content 
Type Description

XML This field contains XML.  The XML needs to be transformed to an HTML <table> 
structure using XSLT.  This XSLT can be specified using the 'Configure...' button.

HTML This field contains HTML - more specifically, it contains an HTML <table> 
structure.  

Delimted Text
This field contains contains delimted data, such as tab-delimited or comma-
delimited data. The field and record separators can be specified using the 
'Confgure...' button.

➌ Configure

The purpose of the "Configure" button depends on the type of content specified in the 
Field Content Type popup.

HTML

HTML contents needs to be transformed into an HTML <table> structure, so the 
"Configure" button is used to define the XSL transformation that should be used to 
achieve this.

Delimted Text

Specify the character used to define the characters used to separate rows and columns 
in the source data:

InDesign metacharacters, such as ^p and ^t can be used in these fields.
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➍ Additional Processing

EasyCatalog also includes support for a lightweight programming language called 
'LUA'. LUA can be used to process the contents of the table and offers sophisticated 
processing capabilities.  For example, data in the table and be re-ordered and filtered, 
rows and columns can be added or deleted, etc. It's also possible to combine the 
content of multiple fields using LUA.

Further information on the LUA programming language can be found here: https://
www.lua.org

Before being used to populate the document, the LUA script will be called. An object 
called ‘table’ is passed to the script, which can then be manipulated. For example, the 
following code returns a rotated version of the original table:

newtable = table:rotate();
newtable:present();

!
After processing the contents of the table in LUA, always 
use the present() method on the table to populate the field 
with the tabular content.

➎ Preview

If a field was selected in the panel before showing the 'Field Options' dialog, the 
Preview pane will update to show how the contents of the field will be ouput using 
the current configuration settings.

➏ Column ID / ➐ Row ID

The Column and Row ID fields are used to determine how fields in the document 
should be linked to fields in the panel.

By default, a field's position in the table (row and column number) will be used so, for 
example, the field in row 2 column 3 in the panel will always appear in row 2, column 3 
of the document table. This has implications if the data in the tabular field is re-ordered, 
as the data in the document table will also be re-ordered.

Alternatively, if the tabular field contains a header row and/or a header column at the left 
of the table these fields can be specified which will ensure that data in the document 
will be updated correctly even if columns or rows are re-ordered in the soruce data.

INSERTING SINGLE TABULAR FIELDS

Individual cells can be inserted into the document using the same process as a regular 
field - by double clicking on an unplaced field or 
by selected an already-placed field and pressing 
the insert icon in the panel.

When the field is insered into the document, a Computed Field command will be 
applied which ensures that data from the correct cell in the tabular field is used to 
populate and update the field.

➋
➊

Field content is inserted into the document using a regular field/Field Specifier marker 
(❶) character with a Computed Field function applied (➋). The TABLESTR custom field 
command is used to specify which cell in the tabular field to retrieve data from.

http://www.lua.org
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INSERTING TABULAR FIELDS TABLES

The entire table can be inserted into the document by selecting the field (❶) and using 
the insert button (➋):

➊

➋

POPULATING TABLE PROTOTYPES

Tabular fields can also be used to populte existing, designed, document tables.  These 
tables can also be used in EasyCatalog libraries and Formatting Rules.

Start by designing your table in the document (❶), applying formatting such as row 
stokes, cell strokes, etc as required.  

➊

Field Specifiers are not included in the table - the content of the table is determined by 
the content of the tabular field. The Table Options dialog is used to tell EasyCatalog to 
populate the table using the contents of a named (➋) tabular field (➌).
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➌
➋

EasyCatalog will not add columns to the finished table - sufficient columns should 
be provided to accommodate all of the potential columns in the tabular field.  Empty 
columns can subsequently be removed, and the other columns resized, using the 
EasyCatalog Table > Column Options dialog.

Attribute Option Description

Preserve Header/
Preserve Footer

✓
The header and the footer defined in the table protoype will always 
be retained even if the tabular field contains header and footer rows.  

The header and footer defined by the tabular field will be used in 
preference to the header and footer rows in the table prototype.

Expand

Vertically The table will expand vertically to accommodate the number of 
records in the tabular field.  Additional columns will not be added.

Horizontally
The data in the tabular field will be rotated, with additional columns 
added to the table as necessary to accommodate the data. 
Additional rows will not be added.

When Populating

Reuse Existing 
Table

The existing table prototype in the document will be populated with 
data, maintaining the attributes applied to the rows and cells. 

Create New 
Table

The table is used purely as a placeholder, and will be re-created 
based on the content of the tabular field. Formatting information 
for the table can be included in the HTML table structure that was 
used to populate the table, or formatting can be applied using LUA 
on the "Additional Processing" dialog in Field Options.
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CHAPTER 12

PAGINATION RULES REFERENCE

The Pagination Rules panel is only available as part of the Pagination Module which must be purchased separately. i
INTRODUCTION 
This chapter provides a reference for the attributes available on the Pagination Rules 
panel.  Using this panel, it is possible to specify  both processing instructions (such 
as whether to use a Product Style during pagination) and layout instructions (such as 
fitting each box to the depth of the text).

➲ If the ‘Pagination Rules’ panel is not visible, show it by 
selecting Pagination Rules from the Window menu.

USING THE PAGINATION RULES PANEL
The Pagination Rules panel is split into two sections: the top portion ➊ shows the 
attributes assigned to the currently-selected box in the document; the bottom 
section ➋ shows the ‘actions’ that have been defined for the box.
➊ Attributes

Pagination attributes define either:

 Ҙ Processing Instructions

Some of the attributes in the panel define when the Product Style should be used 
during pagination.  For example, the "Paginate" attribute is used to determine 
whether the Product Style should appear once for every record in the panel or 
once per specified group.

 Ҙ Attributes that affect how the box appears or behaves  

Attributes are available to change the appearance of the item during pagination.  
For example, attributes are available to resize a box to fit its content; apply a swatch 
based on the content of one of your data fields, etc.

➋ Actions 

Actions are simple rules that are evaluated at pagination time and can be used, for 
example, to delete a box based on the contents of one of the fields being paginated.

➊

➋
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EDITING ATTRIBUTES
To modify any of the properties shown in the panel, double click on it or select it and 
use the ‘Edit…’ menu on the pop-out menu.

Some of the attributes shown in the panel are dependant on other  attributes or the 
current document selection.

FILTERING THE PAGINATION RULES PANEL

The attributes shown in the panel can be filtered to show only the attributes that are 
applicable to the type of pagination you'll be using.  Select the pagination type on the 
"Filter" menu option on the Pagination Rules panel's pop-out menu.

PAGINATION RULES REFERENCE
Paginate

Pagination Types Flow-based, Guide-based, Postional

Apply to Outermost/group box

Dependant Attributes None

Apply this attribute to the outer-most box in the Product Style (if the Product Style 
consists of multiple boxes, group them together and apply this attribute to the group 
box).  This attribute is used to associate the Product Style with a level in your panel 
grouping hierarchy.

The configuration of this field is mandatory for all types of automatic pagination.

Paginate... Description

Once Per Record The Product Style should be used each time EasyCatalog wants to insert an 
individual record into the document.

Once Per Group

Apply this attribute to Product Styles that should be used when paginating 
groups.  You must set the ‘Group Label’ field to specify which group the Product 
Style should be used for.  For example, to specify that the Product Style should 
be used to paginate the ‘Manufacturer’ group, set the Group Label attribute to 
‘Manufacturer’.

Paginate... Description

Furniture Data
This attribute is typically applied to page headings that contain information about 
the first or last record on a page or spread.  See the ‘Furniture’ chapter for more 
information.
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Paginate Once Per Group
In this example, the panel is grouped by ‘Parent Category’, ‘Child Category’ and ‘Manufacturer’.  Product 

Styles can be defined to paginate each of these levels.

Paginate Once Per Record

The Product Style will 
be inserted for each 

record in the panel when 
‘Paginate Once Per 

Record’ is set.

If the ‘Group Label’ is set to 
‘Child Category’ the Product 
Style will be used to paginate 
each Child Category group.  If 
the Product Style contains a 
table, it will be populated with 
all sub-groups and records 
within the Child Category 

group.

Group Name

Pagination Types Flow-based, Guide-based, Postional

Apply to Outermost/group box

Dependant Attributes None

This attribute specifies the point in the panel grouping hierarchy to use this library item.  
For example, if this library item should be inserted once for each ‘Manufacturer’ group, 
‘Manufacturer’ should be specified in this attribute.

When using the Relational Module, the Group Name attribute 
should always be set when paginating records or groups as a 
Relational panel can contain records in multiple groups.!

 

Insert

Pagination Types Flow-based

Apply to Outermost/group box

Dependant Attributes None

This option affects whether the Product Style will be anchored in the pagination text 
flow or if the text content of the Product Style will be inserted.

Attribute Description

As Inline This option will insert the Product Style as an anchored box in the pagination text 
flow – this is required if your Style consists of more than one box.

Frame Contents
This option must only be used when the Product Style consists of one text 
box. Instead of anchoring the Product Style in the text flow, EasyCatalog will 
copy the text content from the text box and paste it into the pagination text flow.
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‘Insert’ Flow-based Pagination Rule
‘Frame Contents’ will insert the contents of the Product Style into the pagination text flow.

‘As Inline’ will anchor the Product Style into the pagination text flow.

Each record has been inserted as an anchored box into the pagination text flow.

Paragraph Style

Pagination Types Flow-based

Apply to Outermost/group box

Dependant Attributes Insert ‘As Inline’

The Paragraph Style Sheet named here will be applied to the Product Style when it is 
anchored in the pagination text flow.  Using InDesign’s paragraph style sheets allows 
typographical controls, such as ‘space before’, ‘keep together’, etc to be applied to 
each anchored Style.

Note that the Paragraph Style Sheet specified here must be present in the document 
being paginated into.

Append Return

Pagination Types Flow-based

Apply to Outermost/group box

Dependant Attributes Insert ‘As Inline’

When inserting the Product Style ‘As Inline’, this option specifies whether to add a 
carriage-return after the anchored item.

Force Break

Pagination Types Flow-based, Guide-based
Not all options available with both types of pagination.

Apply to Outermost/group box

Dependant Attributes None

This option specifies whether the Product Style should be inserted on a new page, or 
in a new column or frame.

Option Description

No Break The Product Style will be inserted after the previous Product Style.

Page

Flow-based and Guide-based Pagination Only

EasyCatalog will ensure that the Product Style is being placed onto a new page.  
A page-break character may be inserted before the Product Style to ensure this 
is the case.

Column

Flow-based Pagination

The Product Style will be inserted in a new column. A column-break character 
may be inserted before the Product Style to ensure this is the case.

Guide-based Pagination

The ‘Direction of Flow’ selected on the Paginate... dialog affects how this attribute 
is applied:

 

When paginating ‘Down and Across’, pagination will move to the next vertical 
column.  When paginating ‘Across and Down’, pagination will move to the next 
horizontal row.
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Option Description

Frame
Flow-based Pagination Only

The Product Style will be inserted in a new frame.  A frame-break character may 
be inserted before the Product Style to ensure this is the case.

Prevent Break

Pagination Types Flow-based

Apply to Outermost/group box

Dependant Attributes Insert At ‘Frame Contents’

This option specifies whether the Product Style should be allowed to break across 
pages, columns or frames.

Option Description

Don’t Prevent 
Breaking

The Product Style will be allowed to break across any frame, page or column.

Over Columns The Product Style will not be allowed to break across a column.  If it does, a 
column-break character will be inserted before the Product Style content.

Over Pages The Product Style will not be allowed to break across a page.  If it does, a page-
break character will be inserted before the Product Style content.

Over Frames The Product Style will not be allowed to break across a frame.  If it does, a frame-
break character will be inserted before the Product Style content.

Fitting

Pagination Types Flow-based, Guide-based, Positional
Not all options available with all types of pagination.

Apply to Any box in the Product Style

Dependant Attributes None

Fitting options are provided to automatically adjust the size of each box within the 
Product Style to accommodate a variable amount of data.  For example, the depth of 
a text box can be automatically resized to the depth of its text.

Fitting Option Text Boxes Picture Boxes

None The size of the box will remain fixed.

Fitting Option Text Boxes Picture Boxes

Frame To Content

If there is only one line of text 
in the box, both the width 
and depth of the box will be 
adjusted to the size of the 
text.  Where there are multiple 
lines of text, only the depth 
will be adjusted.

The Field Options will be used to initially import 
the image into the box, then both the width and 
depth will be adjusted to the size of the picture 
content.

Content To Frame

The text content will be 
resized until it fits within the 
box.  Constraints can be 
specified in the ‘Minimum/
Maximum Text Scale/Size’ 
attributes.

The picture content will be resized to fit the 
frame.

Frame Depth To 
Content Depth

The height of the box will 
be resized to the height of 
the text.  The width will be 
unaffected, regardless of the 
number of lines of text.

The Field Options will be used to initially import 
the image into the box, then the height of the 
picture box will be resized to the height of the 
picture box.  The width will be unaffected.

Grow and Flow

The depth of the text box will 
expand to accommodate the 
amount of text, constrained 
to the bottom margin of 
the page.  If the box is still 
overset, the Product Style will 
be inserted again on the next 
page and any boxes marked 
as ‘Grow and Flow’ will be 
linked together.

This setting does not affect Picture boxes.

Frame Depth to Field 
Depth

The depth of the box will be 
specified by one of the other 
fields for the record being 
used to paginate.  When this 
option is selected a ‘Field 
Name’ attribute will appear: 
enter the name of the field 
that contains the frame depth 
here. Ensure that the field 
contains the measurement 
system - e.g. 10mm.  Use the 
Field Suffix field option to add 
this if necessary.

The frame will be resized to the height specified 
by the nominated field, then the Field Options 
will be used to import the image content within 
this box.

Frame to Content 
Depth and Width Both the width and heigh of the frame will be adjusted until the content fits.
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Fit Content To Frame

Fit Content To Frame will automatically adjust the size of the box’s text content until it 
fits.  Both the point size and horizontal scale can be adjusted until the text fits.

Maximum and Minimum parameters can be specified for point size and horizontal scale adjustment.  
All parameters a percentages based on the size of the text in the box prior to fitting.

Example:

Assuming that before fitting the text box contains 10pt text, the Minimum Text Size is 
set to 50 and the Maximum Text Size is set to 150:

If the text is overset, the size of the text will be reduced until all of the text fits in the 
box with a minimum point size of 5pt (50% of 10pt).  Otherwise, the text size will be 
increased until it fits the box exactly, up to a maximum of 15pt (150% of 10pt).

‘Grow and Flow’ (Guide-Based Pagination Only)

The ‘Grow and Flow’ fitting option provides the ability for a Product Style to be split 
when pagination reaches the bottom of the page. 

 When applied to a text frame, the ‘Grow and Flow’ fitting option will expand the text 
box vertically until all of the text fits in the box, or until the page’s bottom margin is 
reached.  In this instance, the Product Style will be inserted at the start of the next 
page and any frames with the ‘Grow and Flow’ fitting attribute applied will be linked  
together, allowing their text content to flow across the page boundary.

'Grow and Flow' is only applicable when using "At Page Guide Postion" 
paginationi

Grow and Flow

If the text in the box is overset, the frame’s height will be 
expanded until either the text fits or the frame is as deep as 

the page.  If the page’s bottom margin is reached, the Product 
Style will be inserted on the following page and the boxes with 

the ‘Grow and Flow’ attribute set will be linked together.
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Release Anchored Objects

Pagination Types Flow-based, Guide-based, Positional

Apply to Any box in the Product Style

Dependant Attributes None

After pagination, a ‘Release’ will be performed on all anchored boxes within any boxes 
with this attribute applied. Once released, the anchored boxes become standard 
InDesign frames which can be moved independently of their original anchor location.

Ungroup

Pagination Types Flow-based, Guide-based, Positional

Apply to Any box in the Product Style

Dependant Attributes None

By applying this attribute to a group box, an ‘Ungroup’ will be performed after 
pagination.  This option is useful where you want to manually edit the document after 
pagination and do not want to manually go through the document ungrouping each 
Product Style.

Usage

Pagination Types Flow-based, Guide-based, Positional

Apply to Outermost/group box

Dependant Attributes None

Applied to the outer-most box in Product Style, this option allows different Product 
Styles to be used depending on the record or group’s position within its parent group.

First Instance

Regular

Last Instance

Single Instance

A style can also be defined for use when there is 
a single record or group within the group. 

Different styles can be defined that are used to 
paginate the first record in the group; the last 

record in the group and everything inbetween.
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Position Index

Pagination Types Flow-based, Guide-based, Positional

Apply to Any box in the Product Style

Dependant Attributes None

Position index can be used to force the n’th record or sub-group to populate a box 
within the Product Style. 

Each box within the Product Style can be 
assigned a ‘Position Index’.  All boxes within 
a group box will be populated with the same 
record or group, unless a Position Index  is 

specified in any of the child boxes.

When dragging a group 
of records, the first 

record will go into the 
box set with Position 

Index 1, the second into 
Position Index 2, etc.

Position Index 4

Position Index 2

Position Index 1

Continuation

Pagination Types Guide-based

Apply to Outermost/Group Box

Dependant Attributes None

By setting the ‘Continuation’ attribute to ‘Yes’, the Product Style will be used whenever 
pagination moves to a new page.  

Option Description

No This item will not be used when pagination continues on a new page.

Yes This item will be used when pagination continues on a new page.

Grow and Flow This item will be used when a Grow and Flow item is about to continue paginating 
on a new page.

Remove Blank Lines for Empty Fields

Pagination Types Flow-based, Guide-based, Positional

Apply to Any box in the Product Style

Dependant Attributes None

This attribute will remove any lines in the textual content of the box that contain only 
empty fields.  This attribute is useful when paginating data that contains optional values 
that should not be paginated if empty.

Strip White Space

Pagination Types Flow-based, Guide-based, Positional

Apply to Any box in the Product Style

Dependant Attributes None

White space (tabs, spaces, etc) at the end of the text content in the box will be stripped 
after pagination.  This attribute is useful for removing unwanted extra carriage returns.
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Apply Object Style From Field

Pagination Types Flow-based, Guide-based, Positional

Apply to Any box in the Product Style

Dependant Attributes None

The Object Style specified by the contents of the nominated field will be applied to this 
box during pagination.  

This object style is applied only during pagination, so will not change during an ‘Update 
Document’ operation if the contents of the nominated field change.

Apply Swatch From Field

Pagination Types Flow-based, Guide-based, Positional

Apply to Any box in the Product Style

Dependant Attributes None

During pagination, EasyCatalog will apply a fill to the frame using either the specified 
swatch or an RGB/CMYK value.  

The colour used will be determined by the contents of the specified field.  The field can 
either contain:

 Ҙ The name of a swatch to apply to the box 

 Ҙ A hexadecimal value that specifies an RGB colour to use

The hexadecimal value should be in the format:

#RRGGBB

Where RR is a hexadecimal value for the red component of the colour; GG is the 
green component and BB is the blue.

For example, to apply a red colour to the box the nominated field should contain:

#FF0000

 Ҙ A CMYK value

A CMYK value can be specified using the following format, where 'NNN' is a value 
in the range 000 - 100:

#cNNNmNNNyNNNkNNN

For example, to apply magenta to the box the following value would be used:

#c0m100y0k0

Apply Swatch To Stoke From Field

Pagination Types Flow-based, Guide-based, Positional

Apply to Any box in the Product Style

Dependant Attributes None

During pagination, EasyCatalog will apply a stroke to the frame using either the 
specified swatch or an RGB/CMYK value.  See 'Apply Swatch From Field' (above) for 
further information on what the specified field should contain.

When Frame Is Empty

Pagination Types Flow-based, Guide-based, Positional

Apply to Any box in the Product Style

Dependant Attributes None

Specify an action to take when the box is empty.

Option Description

Do Nothing The box will remain in the document empty.

Delete The box will be removed from the document.

Page Orientation

Pagination Types Flow-based, Guide-based, Positional

Apply to Outermost/Group Box

Dependant Attributes None

Specifies whether this library item should be used on left-hand pages, right-hand 
pages or either.  The use of this attribute allows you to define different library items that 
should be used on left or right pages.

Option Description

Left This library item will be used on left-hand pages only.

Right This library item will be used on right-hand pages only.

Any This library item can be used for any type of page.
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Populate Tables

Pagination Types Flow-based, Guide-based, Positional

Apply to Any box in the Product Style

Dependant Attributes None

Specifies whether the table should be populated one row per record or one column 
per record.

Option Description

Horizontally The table will be expanded or contracted horizontally: columns will be added or 
removed from the table to accommodate the amount of data being paginated.

Vertically The table will be expanded or contracted vertically: rows will be added or removed 
from the table to accommodate the amount of data being paginated.

No Expansion The dimensions of the table will not be adjusted at all and it will be populated as-is 
without any adjustment.

Keep With Next

Pagination Types Guide-based/Flow-based Paginatioin

Apply to Outermost/Group Box

Dependant Attributes None

This option is especially useful for paginating headers that should not become 
separated from the first item in the group.

Guide-based Pagination:

This attribute works in a similar manner to the Pagraph keep option, and will attempt 
to keep this library item with the one that is paginated next.  

Option Description

Yes Where possible this library item will be kept with the next-paginated item.

No

Unspecified
This item will not be kept with the next-paginated item.

Into Text Flow Pagination

This attribte will apply InDesign's 'Keep' paragraph option to the paragraph that the 
Product Style is inserted into.

Option Description

Yes InDesign's "Keep With Next" attribute will be applied to the inserted paragraph.

No InDesign's "Keep With Next" attribute will be turned off on the inserted paragraph..

Unspecified

In the case of "Into Text Flow" pagination, this option will not adjust the keep 
options applied to the paragraph that's inserted.  This allows, for example, the 
keep option to be determined by the paragraph style that's already applied to the 
paragraph.

Repeat

Pagination Types Guide-based

Apply to Outermost/Group Box

Dependant Attributes None

Specifies whether this item should repeat at the start of each new colum or page.  
Within a single library, different items may be specified that repeat at the start of each 
new page and column.

Option Description

Never This item will not be repeated.

Every Column This item will be repeated at the start of each new column.

Every Page This item will be repeated at the start of each new page.

Include in Collision Detection

Pagination Types Guide-based

Apply to Any box in the Product Style

Dependant Attributes None

This attribute determines whether the box will be included in the 'Collision Detection' 
operation during "At Page Guide Position" pagination.  By default, EayCatalog will 
ensure that the new Product Style it places does not collide with any box in the previous 
Style.  This attribute allows some boxes to be excluded from this collision detection.
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CHAPTER 13

CUSTOM FIELDS REFERENCE
INTRODUCTION 
Custom Fields provide a way to add new fields to the source data, the value of which 
can be computed using  predefined functions.  

Typical applications for Custom Fields include the ability to create summary data (such 
as the sum of all values in a given field) and data manipulation (e.g. extracting the first 
character from a field).

Custom Fields behave in exactly the same way as other EasyCatalog fields, and Field 
Specifiers for Custom Fields can be inserted into Product Styles where appropriate.

This chapter lists the functions that are available, and gives an example of their use.

CREATING A NEW CUSTOM FIELD
New Custom Fields can be created in the EasyCatalog data panel by right-clicking (or 
Ctrl-clicking on Macintosh) in the data area of the panel and selecting “New Custom 
Field”. 

Custom Fields are configured using the 'Custom Field' pane on the Field Options 
dialog.

Custom Fields can also be used with Relational Data sources, although 
they must be created in the appropriate child data source.i
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TYPES OF FUNCTIONS
Functions in this reference have been split into five categories:

 Ҙ String Manipulation

String manipulation functions are available to enable you to extract characters from 
a field, change the case of a field or determine the length of a field.

String manipulation is often necessary when the source data needs to be 'cleaned-
up' before insertion into the document.

 Ҙ Math Functions

Several math functions are available that operate on either a record-by-record 
basis or on groups of records. Many functions, such as 'SUM' offer a group-based 
equivalent (e.g. 'GROUPSUM').

 Ҙ Logic Functions

Logic functions can be used to make decisions based on the content of your data.  
For example, you could output a field only if the price field is greater than a specified 
value.

 Ҙ Utility Functions

Utility functions have been provided to, for example, determine whether an image 
exists. This information could then be used later to make decisions during pagination.

 Ҙ Group Functions

Group functions operate on groups of records and are often used to produce 
summary information for multiple records.  For example, there is a group function 
- 'GROUPRTOTAL' - that creates a running total of a specified field within a group.

As Custom Fields are defined at the data source level, the visible structure of the 
data in your panel is not important and cannot be used to determine the order of 
records used by the group functions. Therefore, all group functions typically have 
two parameters: a group path and a field to sort the records by.  The group path 
parameter defines the fields use to group the data.

When using group functions, the Custom Field for all records in the group will 
typically (but not always) be populated with the same value.

Example

GROUPLIST('Parent Category:Child Category','Manufacturer', 'Manufacturer',',',',', 
' and ')

The 'GROUPLIST' function will populate the Custom Field with a list of all unique 
values in a specified field.  In this example, we want to create a comma separated 
list of all manufacturers within each Child Category group. 

COMBINING FUNCTIONS 
Multiple functions can be used within the same Custom Field statement to create 
complex operations:

IF(FIELDVAL('Price'),'>=',1,CONCAT('£',FIELDVAL('Price')), 

CONCAT(FIELDVAL('Price'),'p'))

In this example, if the 'Price' field is greater than or equal to 1 the price will be prefixed 
with a pound symbol; otherwise it will be suffixed with a pence symbol.

PARAMETER TYPES 
Each function shown in this reference chapter will expect its  parameters to be of a 
specific type.  These parameter types are:

Type Description

Field Specify only the name of the field. Usually, the field name would be enclosed in single 
quotes. e.g: LEFTSTR ('Description',5)

String Either specify a string literal or use the FIELDSTR command to retrieve the contents of 
another field. e.g.: LENGTH(FIELDSTR('Manufacturer'))

Number Either specify a numeric literal or use the FIELDVAL command to retrieve the numeric 
contents of another field.IF(FIELDVAL('Price')...

...
Some functions show a parameter of type '...', which indicates that the function accepts 
any number of parameters.  Typically, the type of these additional parameters is the same 
as the preceding parameter.
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WHAT IS THE DIFFERENCE BETWEEN FIELDSTR AND 
FIELDVAL? 
The two most commonly used functions are FIELDSTR and FIELDVAL. If they are 
being used as arguments to another function, as a general rule use FIELDVAL if the 
function is expecting a numeric argument; use FIELDSTR if it's expecting a string. 

FIELDSTR will return the formatted content of the given field - including any prefixes, 
suffixes, number formats, etc. FIELDVAL will return the raw numeric content of the 
field excluding number formatting, prefixes, etc.

STRING FUNCTIONS

SUBSTR

This function is used to extract specific characters from another field.

Parameter Type Description

Field Name Field The name of the field to extract characters from.

Start Index Integer The index of the first character, starting at 0.

Length Integer The number of characters to extract.

Example:

SUBSTR (Manufacturer,3,8)

Manufacturer SUBSTR(Manufacturer, 3, 8)

Apple Computer le Compu

LEFTSTR

This function returns characters from the left (start) of the given field.

Parameter Type Description

Field Name Field The name of the field to extract characters from.

Length Integer The number of characters to extract.

Example:

LEFTSTR (Manufacturer,5)

Manufacturer LEFTSTR (Manufacturer,5)

Apple Computer Apple

RIGHTSTR

This function returns characters from the right (end) of the given field.

Parameter Type Description

Field Name Field The name of the field to extract characters from.

Length Integer The number of characters to extract.

Example:

RIGHTSTR (Manufacturer,3)

Manufacturer RIGHTSTR (Manufacturer,3)

Apple Computer ter

PARTSTR

This function can be used to extract a specific element from a delimited field.

Parameter Type Description

Field Name Field The name of the field to extract characters from.

Part No. Integer The element number to retrieve (numbered from zero).

Delimiter String The character(s) used to delimit each part of the string.

Example:

PARTSTR(images, 2, ',')

Images PARTSTR(images, 2, ',')

Picture 1, Picture 2, Picture 3 Picture 3
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EAN13

This function can be used to translate from an EAN13 code into the correct glyphs in 
the free 'eanbwrp36tt' font.  

Parameter Type Description

Field Name Field The name of the field to containing the EAN13 code.

Example:

EAN13('Stock Code')

The output from this function should be placed in the document and the 'eanbwrp36tt' 
font applied to its content.

EAN8

This function can be used to translate from an EAN8 code into the correct glyphs in 
the free 'eanbwrp36tt' font.  

Parameter Type Description

Field Name Field The name of the field to containing the EAN8 code.

Example:

EAN8('Stock Code')

The output from this function should be placed in the document and the 'eanbwrp36tt' 
font applied to its content.

LOWER

Converts the contents of the given field to lower case.  

Parameter Type Description

Field Name Field The name of the field to convert.

Example:

LOWER('Manufacturer')

Manufacturer LOWER('Manufacturer')

Apple Computer apple computer

UPPER

Converts the contents of the given field to upper case.  

Parameter Type Description

Field Name Field The name of the field to convert.

Example:

UPPER('Manufacturer')

Manufacturer UPPER('Manufacturer')

Apple Computer APPLE COMPUTER

CONCAT

This function will concatenate (join) the values of all of its arguments together.

Parameter Type Description

Argument String A value to concatenate to the result.

... This function can have as many arguments as required.

Example:

CONCAT(FIELDSTR('Price'),', Available in ',FIELDSTR('Availability'))

Price Availability CONCAT(FIELDSTR('Price'),', Available in 
',FIELDSTR('Availability'))

10.99 2 days 10.99, Available in 2 days

5.99 1 week 5.99, Available in 1 week

REGEX

Performs a regular expression search and replace.

Parameter Type Description

String to Search String The string to search within

Regular Expression String The regular expression statement to search for

String to Replace String The string to replace when a match is found.

Example:

REGEX(FIELDSTR(Stock Code), '^(....)(...)(..)','\1.\2.\3'))
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Stock Code REGEX

AAAA12345 AAAA.123.45

BBBB67890 BBBB.678.90

CCCC12345 CCCC.123.45

DDDD67890 DDDD.678.90

STRIPWHITESPACE

Strip white space from the given string.

Parameter Type Description

String String The string to remove white space from

Strip All Boolean When TRUE, remove all white space from the string; when FALSE 
only remove white space from the start and end of the string.

Example:

STRIPWHITESPACE(FIELDSTR('Category'))

TITLECASE

Change the case of the given string to Title Case.

Parameter Type Description

String String The string to process

Example:

TITLECASE(FIELDSTR('Body Copy'))

Body Copy TITLECASE(FIELDSTR('Body Copy'))

this sentence should appear in title case
This Sentence Should Appear In Title Case

SENTENCECASE

Change the case of the given string to sentence case.

Parameter Type Description

String String The string to process

Example:

SENTENCECASE(FIELDSTR('Body Copy'))

Body Copy SENTENCECASE(FIELDSTR('Description'))

this sentence should appear in 
sentence case

This sentence should appear in sentence case

LENGTH

Returns the length of the given string.

Parameter Type Description

String String The string to return the length of

Example:

LENGTH(FIELDSTR('Body Copy'))

Body Copy LENGTH(FIELDSTR('Manufacturer'))

Apple Computer 14

INDEXOF

Returns the character index of the first instance of one string within another, or -1 if the 
first string does not contain the second.

Parameter Type Description

Search In String A string to search within

Search For String A string to search for

Start Index Integer (Optional) The character index to start searching at (default: 0).

Example:

INDEXOF(FIELDSTR('Manufacturer'), 'Apple')

Manufacturer INDEXOF(FIELDSTR('Manufacturer'), 'Apple')

Apple iMac 0

I like Apples 7

Dell Computer -1

Apple iMac by Apple, Inc. 0

Manufacturer INDEXOF(FIELDSTR('Manufacturer'), 'Apple', 3)

Apple iMac 0

I like Apples 7



EasyCatalog User Guide Custom Fields Reference- 129 -

Manufacturer INDEXOF(FIELDSTR('Manufacturer'), 'Apple', 3)

Dell Computer -1

Apple iMac by Apple, Inc. 14

LASTINDEXOF

Returns the character index of the last instance of one string within another, or -1 if the 
first string does not contain the second.

Parameter Type Description

Search In String A string to search within

Search For String A string to search for

Start Index Intgeger (Optional) The character index to start searching at (default: 0).

Example:

LASTINDEXOF(FIELDSTR('Body Copy'), 'Apple')

Body Copy LASTINDEXOF(FIELDSTR('Body Copy'), 'Apple')

Apple iMac 0

I like Apples 7

Dell Computer -1

Apple iMac by Apple, Inc. 14

Body Copy LASTINDEXOF(FIELDSTR('Body Copy'), 'Apple', 3)

Apple iMac 0

I like Apples -1

Dell Computer -1

Apple iMac by Apple, Inc. 0

COUNTOF

Returns the number of times one string appears within another.

Parameter Type Description

Search In String A string to search within

Search For String A string to search for

Example:

COUNTOF(FIELDSTR('Body Copy'), 'pl')

Body Copy COUNTOF(FIELDSTR('Body Copy'), 'pl')

Apple iMac 1

I like Apples 1

Dell Computer 0

Apple iMac by Apple, Inc. 2

CONTAINSANY

Tests to see if the 'Search In' string contains any of the strings specified by the 
subsequent parameters.

Parameter Type Description

Search In String A string to search within

Search For String A string to search for

... String Multiple 'Search For' parameters can be specified.

Example:

CONTAINSANY(FIELDSTR('Body Copy'), 'A', 'iMac')

Body Copy CONTAINSANY(FIELDSTR('Body Copy'), 'A', 'iMac')

Apple iMac TRUE

I like Apples TRUE

Dell Computer FALSE

Apple iMac by Apple, Inc. TRUE

CONTAINSALL

Tests to see if the 'Search In' string contains all of the strings specified by the subsequent 
parameters.

Parameter Type Description

Search In String A string to search within

Search For String A string to search for

... String Multiple 'Search For' parameters can be specified.

Example:

CONTAINSALL(FIELDSTR('Body Copy'), 'A', 'iMac')
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Body Copy CONTAINSANY(FIELDSTR('Body Copy'), 'A', 'iMac')

Apple iMac TRUE

I like Apples FALSE

Dell Computer FALSE

Apple iMac by Apple, Inc. TRUE

CHAR

Inserts a character with the given unicode value into the string.

Parameter Type Description

Character Code Integer The unicode value of the character to insert. Hexadecimal values 
should be prefixed with '%'.

Example:

CHAR(65)

CHAR(65)

A

CHAR(%41)

CHAR(%41)

A

URLENCODE/URLDECODE

URL-encodes or URL-decoded the given string.

Parameter Type Description

String String The string to URL-encode or URL-decode

Example:

URLENCODE('This is a test')

URLENCODE('This is a test')

This%20is%20a%20test

URLENCODE('This%20is%20a%20test')

URLDECODE('This%20is%20a%20test')

This is a test

DISTINCTLIST

Creates a delimited list containg only the unique values from the parameters passed 
to the function.

Parameter Type Description

Separator String The separator to use in the list

... String A string to add to the list.  If its value has already been added it will 
not be added again.

Example:

Field A Field B Field C

Apple iMac Dell Computer Apple iMac

DISCTINCTLIST(',',FIELDSTR('field a'), FIELDSTR('field b'), 
FIELDSTR('field c'))

Apple iMac, Dell Computer

REMOVEBLANKLINES

Removes empty paragraphs from the given text.  Only paragraphs ending with a hard 
return are removed. This function is useful for combining the contents of multiple fields 
and ensuring that empty paragraphs do result from the concatenation.

Parameter Type Description

Text String The text to process

Example:

Field A Field B Field C

Apple iMac Dell Computer

A simple concatenation of these fields would be:

CONCAT(FIELDSTR('Field A'),'^p',FIELDSTR('Field B'),'^p',FIELDSTR('Field 
C'))
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This would result in an empty paragraph if any of the fields are empty. 

CONCAT(FIELSTR('Field A'),'^p',FIELSTR('Field B'),'^p',FIELDSTR('Field 
C'))

Apple iMac¶
¶

Dell Computer

The REMOVEBLANKLINES function will remove any empty paragraphs:

REMOVEBLANKLINES(CONCAT(FIELSTR('Field 
A'),'^p',FIELSTR('Field B'),'^p',FIELDSTR('Field C')))

Apple iMac¶
Dell Computer

FIELDSTR

Returns the string contents of the given field.

Parameter Type Description

Field Name Field The field to retrieve

Example:

FIELDSTR('Field A')

FIELDVAL

Returns the numeric value of the given field. A numeric value is only retrieved for fields 
defined as one of the numeric types such as 'Number' or 'Currency'.

Parameter Type Description

Field Name Field The field to retrieve

Example:

FIELDVAL('Field A')

LITERAL

The LITERAL function should be used to supply a string to a function that is expecting 
a field name.

Parameter Type Description

String literal String This string will be passed as-is.

As an example, the LEFTSTR command expects a field name as the first parameter.  
If, however, you want to pass a fixed string to this function the LITERAL command 
should be used:

LEFTSTR(LITERAL('abcdefg'),2)

I2OF5

This function can be used to convert a numeric code into the interleaved 2-of-5 barcode 
format. The characters output by this function should be formatted in the document 
using the 'Dobson2OF5' font.  

Parameter Type Description

Code String The numeric code to convert to Interleaved 2-of-5 format.

Example:

I2OF5(FIELDSTR('mycode'))

CODE128

This function can be used to convert a purely numeric code into a Variant C Code 
128 barcode, or an alphanumeric string into a Variant B code 128 barcode.  The 
glyphs produced by this function should be formatted in the document using the 
'Code128bWin' or 'Code128bWinLarge' fonts.

Parameter Type Description

Code String The string to convert to a Code 128 barcode.

Example:

CODE128(FIELDSTR('mycode'))
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MATH FUNCTIONS

MUL

Multiply one field by another.

Parameter Type Description

LHS Number A number to multiply

Factor Number The number to multiply by

Example:

MUL(FIELDVAL(Price),10)

Price MUL

10.00 100.00

15.00 150.00

17.50 175.00

DIV

Divide one field by another.

Parameter Type Description

LHS Number A number to divide

Factor Number The number to divide by

Example:

MUL(FIELDVAL(Price),10)

Price DIV

10.00 1.00

15.00 1.50

17.50 1.75

MOD

The “MOD” operation finds the remainder of the division of one number by another.

Parameter Type Description

LHS Number A number to divide

Factor Number The number to divide by

Example:

MOD(FIELDVAL(Price),10)

Price MOD

10.00 0.00

15.00 5.00

17.50 7.50

SUM

This function returns the sum of all of its arguments.

Parameter Type Description

Argument Number A value to use as part of the sum.

... ... This function can have as many arguments as required.

Example:

SUM(FIELDVAL('Price'), 10)

Price SUM

10.00 20.00

15.00 25.00

17.50 27.50

MATH FUNCTIONS
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SUB

This function will subtract the values in the second and subsequent parameters from 
the first parameter..

Parameter Type Description

Argument Number A value to use as part of the sum.

... ... This function can have as many arguments as required.

Example:

SUB(FIELDVAL('Price'), 10, 5)

Price SUB

20.00 5.00

25.00 10.00

27.50 12.50

MIN

This function returns the lowest value in its arguments.

Parameter Type Description

Argument Number A value to test.

... This function can have as many arguments as required.

Example:

MIN(FIELDVAL('Price'),10)

Price MIN

5.00 5.00

10.00 10.00

15.00 10.00

17.50 10.00

MAX

This function returns the highest value in its arguments.

Parameter Type Description

Argument Number A value to test.

... ... This function can have as many arguments as required.

Example:

MAX(FIELDVAL('Price'),10)

Price MAX

5.00 10.00

10.00 10.00

15.00 15.00

17.50 17.50

AVG

This function returns the numerical average of its arguments.

Parameter Type Description

Argument Number A value to test.

... This function can have as many arguments as required.

Example:

AVG(FIELDVAL('Price'),10)

Price AVG

5.00 7.50

10.00 10.00

15.00 12.50

17.50 13.75
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DECTOFRAC

This function will attempt to convert the given decimal value into a fraction.

Parameter Type Description

Value Number The decimal value to convert to a fraction

Format Boolean Specifies whether to add HTML formatting to the result string around the 
numerator and demoninator.

Example:

DECTOFRAC(0.5,FALSE)

DECTOFRAC(0.5,FALSE) DECTOFRAC(0.5,TRUE)

1/2 <sup>1</sup>/<sub>2</sub>

LOGIC FUNCTIONS

COMPARESTR

This function can be used to compare the contents of a field with a value or the contents 
of another field.

Parameter Type Description

Field Name Field The name of the field to evaluate.

Value String The value to compare against the contents of the field.

True Value String (Optional) If the contents of the field matches the given value, this 
parameter will be used as the output of this command.

False Value String (Optional) If the contents of the field does not match the given value, this 
parameter will be used as the output of this command.

Example:

Comparing a field with a fixed value:

COMPARESTR(Description, 'abcdefg', 'Match', 'No Match')

If the 'Description' field contains 'abcdefg' then 'Match' will be output; if the field does 
not contain 'abcdefg' then 'No Match' will be output.

Compare a field with another field:

To compare against the value of another field, use the FIELDSTR command as the 
second parameter to the COMPARESTR command.

COMPARESTR('Short Description', FIELDSTR('Long Description'), 
'Match', 'No Match')

In this example, the contents of the 'Description' field will be compared with the 
contents of the 'Long Description' field.

IF

Unlike the 'COMPARESTR' command, the 'IF' command also allows an operator to be 
specified to make more complex comparisons.

Parameter Type Description

Operand String The first field or value to compare

Operator String

The operator to use in the comparison - valid operands are:

Operand String The second field or value to compare.

True Value String (Optional) The value to output if the comparsion evaluates to true.

False Value String (Optional) The value to output if the comparison evaluates to false.

Example:

To compare the contents of a field against a fixed value:

IF (FIELDSTR(Price), '<', '100', 'Less than 100', 
'Greater than 100')

To compare the contents of a field against the contents of another field:

IF (FIELDSTR(Price), '=', FIELDSTR('Sale Price'), 'Prices Match', 
'No Price Match')
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AND

This function will return TRUE if the values of all of its arguments are true.

Parameter Type Description

Argument String A value to test

... ... This function can have as many arguments as required.

Example:

AND(IF (FIELDSTR(Price), '>', 10), IF (FIELDSTR(Availability), 
'=', 'TRUE'))

Price Availability AND

10.00 TRUE FALSE

15.00 TRUE TRUE

17.50 FALSE FALSE

OR

This function will return TRUE if the values of any of its arguments are true.

Parameter Type Description

Argument String A value to test

... ... This function can have as many arguments as required.

Example:

OR(IF (FIELDSTR(Price), '>', 10), IF (FIELDSTR(Availability), 
'=', 'TRUE'))

Price Availability OR

5.00 TRUE TRUE

6.75 FALSE FALSE

10.00 TRUE TRUE

15.00 TRUE TRUE

17.50 FALSE TRUE

NOT

Returns the logical opposite of the first parameter.

Parameter Type Description

Argument Boolean A value to test

Example:

NOT(FIELDSTR(myflag))

myflag NOT(FIELDSTR(myflag)

TRUE FALSE

FALSE TRUE

GROUPLIST

GROUPLIST will take values from the nominated field and create a delimited list.  

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String The name of a field to sort the values by

Value Field String The name of the field that contains the values we want to create a list of.

First 
Separator String (Optional) The first separator to use in the delimited list.

Regular 
Separator String (Optional) The separator to use between entries in the delimited list.

Last 
Separator String (Optional) The separator to use between the penultimate and last item in 

the delimited list.

Example:

GROUPLIST('Parent Category:Child Category','Price', 
'Price',',',',', ' and ')

In this example, the field will be populated with a comma delimited list of all Price fields 
in each 'Child Category' group, sorted by 'Price'.

Price GROUPLIST

15.00 10.00, 15.00 and 20.00

10.00 10.00, 15.00 and 20.00

20.00 10.00, 15.00 and 20.00
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GROUPSUM

GROUPSUM will create a mathematical total of the contents of a nominated field within 
a group.

Parameter Type Description

Group Path String The grouping configuration to use

Value Field String The name of the field that contains the values we total.

Example:

GROUPSUM('Parent Category:Child Category','Price')

This command will total all of the Price fields within the Child Category grouping.

Price GROUPSUM

15.00 45.00

10.00 45.00

20.00 45.00

GROUPRTOTAL

GROUPRTOTAL will create running total of the values in a group.  Unlike GROUPSUM, 
this function will populate each record in the group with the total up to that point in the 
group.

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String The name of the field to sort the records by in the group..

Value Field String The name of the field that contains the values we total.

Example:

GROUPRTOTAL('Parent Category:Child Category','Price','Price')

Price GROUPSUM

10.00 10.00

15.00 25.00

20.00 45.00

GROUPAVG

GROUPAVG will create a mathematical average of the contents of a nominated field 
within a group.

Parameter Type Description

Group Path String The grouping configuration to use

Value Field String
The name of the field that contains the values we want to average.

Example:

GROUPAVG('Parent Category:Child Category','Price')

This command will return the average all of the Price fields within the Child Category 
grouping.

Price GROUPAVG

15.00 15.00

10.00 15.00

20.00 15.00

GROUPMAX

GROUPMAX will return the maximum numerical value of a nominated field within a group.

Parameter Type Description

Group Path String The grouping configuration to use

Value Field String
The name of the field that contains the values we find the maximum value 
in.

Example:

GROUPMAX('Parent Category:Child Category','Price')

This command will return the maximum value of the 'Price' field in the Child Category 
group.

Price GROUPMAX

15.00 20.00

10.00 20.00

20.00 20.00
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GROUPMIN

GROUPMIN will the minimum numerical value of a nominated field within a group.

Parameter Type Description

Group Path String The grouping configuration to use

Value Field String
The name of the field that contains the values we find the minimum value 
in.

Example:

GROUPMIN('Parent Category:Child Category','Price')

This command will return the minimum value of the 'Price' field in the Child Category 
group.

Price GROUPMIN

15.00 10.00

10.00 10.00

20.00 10.00

GROUPFIRST

GROUPFIRST will return the first value of a nominated field within a group.

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String The field to sort the records in the group by.

Value Field String The field that we want to retrieve the value from.

Example:

GROUPFIRST('Parent Category:Child Category','Price', 'Price')

This command will first sort the 'Price' field into ascending 'Price' order and return the 
first value.

Price GROUPFIRST

10.00 10.00

15.00 10.00

20.00 10.00

GROUPLAST

GROUPLAST will return the last value of a nominated field within a group.

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String The field to sort the records in the group by.

Value Field String The field that we want to retrieve the value from.

Example:

GROUPLAST('Parent Category:Child Category','Price', 'Price')

This command will first sort the 'Price' field into ascending 'Price' order and return the 
last value.

Price GROUPLAST

10.00 20.00

15.00 20.00

20.00 20.00

GROUPSEQUENCE

Each record in the nominated group will receive the next value from a given list of 
values.

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String The field to sort the records in the group by.

Value Field String A colon-delimited list to populate each record in the group with.

Example:

GROUPSEQUENCE('Parent Category:Child Category','Inc VAT Price', 
'A:B:C:D')

This function will evaluate to 'A' for the first record in the Child Category group; 'B' 
for the second, etc. Once all vaues in the list have been exhausted, EasyCatalog will 
continue with the first, second, etc.

Inc VAT Price GROUPSEQUENCE

10.00 A
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Inc VAT Price GROUPSEQUENCE

15.00 B

20.00 A

17.50 C

19.00 D

GROUPCOUNTUNIQUE

This function returns the number of unique values in a nominated field within a group.

Parameter Type Description

Group Path String The grouping configuration to use

Field String The field to count the number of unique instances in

Example:

GROUPCOUNTUNIQUE('Parent Category:Child Category','Price')

Price GROUPCOUNTUNIQUE

10.00 3

15.00 3

15.00 3

17.50 3

17.50 3

This function will evaluate to the same value for every record in the group.

GROUPCOUNT

This function returns the number of records in each group.

Parameter Type Description

Group Path String The grouping configuration to use

Example:

GROUPCOUNT('Parent Category:Child Category')

Price GROUPCOUNT

10.00 5

15.00 5

Price GROUPCOUNT

15.00 5

17.50 5

17.50 5

This function will evaluate to the same value for every record in the group.

GROUPSERIES

This function can be used to populate the custom field with a numerical series within 
each group.

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String The name of the field to sort the records in the group by

Start Integer An integer to start at

Increment Integer A value to increase the integer by for each record in the group.

Example:

GROUPSERIES('Parent Category:Child Category', 'Price', 10,100)

Price GROUPSERIES

10.00 10

15.00 110

15.00 210

17.50 310

17.50 410

GROUPONCHANGE

This function will evaluate to TRUE each time a nominated field within a group changes 
value, FALSE otherwise.

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String The name of the field to sort the records in the group by

Field String The field to evaluate

Example:
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GROUPONCHANGE('Parent Category:Child Category', 'Price', 'Price')

Price GROUPONCHANGE

10.00 TRUE

15.00 TRUE

15.00 FALSE

15.00 FALSE

17.50 TRUE

17.50 FALSE

GROUPISFIRST

This function returns 'TRUE' for the first 'n' number of records in the specified group.

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String A field to sort the records by within the group.

Number of 
records Integer The number of records to return 'TRUE' for.

Example:

GROUPISFIRST('Parent Category:Child Category', 'Price', 2)

Price GROUPISFIRST

5.00 TRUE

10.00 TRUE

15.00 FALSE

17.50 FALSE

GROUPISLAST

This function returns 'TRUE' for the last 'n' number of records in the specified group.

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String A field to sort the records by within the group.

Number of 
records Integer The number of records to return 'TRUE' for.

Example:

GROUPISLAST('Parent Category:Child Category', 'Price', 2)

Price GROUPISLAST

5.00 FALSE

10.00 FALSE

15.00 TRUE

17.50 TRUE

GROUPSERIESONFIELDCHANGE

Populate a group with a numerical series that increments each time a given field 
changes value.

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String A field to sort the records by within the group.

Field Name Field Name Each time the value of this field changes, the value returned by this function 
will be incremented.

Start Value Integer An integer to start from

Increment Integer Each time the specified field changes value, the value returned by this 
function will be incremented by the amount specified by this parameter.

Example:

GROUPSERIESONFIELDCHANGE('Parent Category:Child Category', 
'Price', 'Price', 1, 10)

Price GROUPSERIESONFIELDCHANGE

5.00 1

5.00 1

10.00 11

15.00 21

17.50 31

GROUPNUMBERSEQUENCE

Compiles a list of numbers into a page range-style list.

Parameter Type Description

Group Path String The grouping configuration to use
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Parameter Type Description

Number 
Field String The name of the field containing the numbers to collate

Example:

GROUPNUMBERSEQUENCE('Parent Category:Child Category', 'Page')

Page GROUPNUMBERSEQUENCE

1 1, 3-5,7,10

3 1, 3-5,7,10

4 1, 3-5,7,10

5 1, 3-5,7,10

7 1, 3-5,7,10

10 1, 3-5,7,10

GROUPXREFFIELD

This function will search within each group for a record whose field content matches a 
given value, and will return the value of another field for the found record.

Parameter Type Description

Group Path String The grouping configuration to use

Search Field Field The name of the field to search in

Search Value String The value to search for in the 'Search Field'

Return Field Field The name of the field to return from the matching record.

Example:

GROUPXREFFIELD('Parent Category:Child 
Category','PartNo',FIELDSTR('XRefPartNo'),'Page')

This example will search for a record whose 'PartNo' field contains the value of this 
record's 'XRefPartNo' field. When one is found, the contents of its 'Page' field will be 
returned. Unlike XREFFIELD, however, this function will only search within each group 
(not the entire data source).

GROUPCROSSTABLEHEAD / GROUPCROSSTABLEVALUE

These two functions are used to build cross tables that have a finite number of columns.  
A cross table is a matrix-style table that contains both a variable number of rows and 
columns, and is typically used to produce a matrix of product options and prices.

Consider the following data that contains two products - 'AAA123' and 'BBB321'. 
Both products are available in a number of colours, but 'BBB321' is only available is 
red and green (no blue).

To paginate a table that contains product codes vertically and colours horizontally, a 
function is required that will cross reference these two fields.

PRODUCT CODE RED BLUE GREEN
AAA123 $10.00 $20.00 $20.00
BBB321 $15.00 - $25.00

To achieve this we need to create custom fields for each of the possible columns 
and also a field for each column header.  For example, if we know that there will be a 
maximum of three colours we would create three header fields and three value fields.  
Using custom fields we can then determine what the values of these new fields should 
be:

GROUPCROSSTABLEHEAD

The GROUPCROSSTABLEHEAD function is used to determine the headers for each 
column in the table.  The value returned by this function will also be used as a parameter 
to the GROUPCROSSTABLEVALUE function to determine the value to display in each 
table cell.

Parameter Type Description

Group Path String The grouping configuration to use.  This will limit the scope of this function 
to the specified grouping.
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Parameter Type Description

Sort Field String A field to sort the records by within the group.  This will determine the 
order that the columns will appear in.

Cross Field String The field that should be used in each column of the table.

Header Index Integer The index number of this header.

Like all 'GROUP' functions, the scope of this function can be limited to the nominated 
grouping.  This could be used, in this example, to prevent colours from products 
belonging to one department affecting the colours from another. In this example, all 
products are in the same parent group so we do not need to specify a group path.

So, assuming that we only ever have three possible colours per product, we could 
create three new custom fields with the following Custom Field functions:

Field Name Custom Field

col1 GROUPCROSSTABLEHEAD(,,colour,0)

col2 GROUPCROSSTABLEHEAD(,,colour,1)

col3 GROUPCROSSTABLEHEAD(,,colour,2)

In this example, we are not interested in a particular group (as we want the table to 
list all available colours from any product), or in sorting the records.  This function will 
look at all unique values in the 'colour' field and pick one (0 = the first colour; 1 = the 
second, etc).

GROUPCROSSTABLEVALUE

The GROUPCROSSTABLEVALUE function is used to determine the value to display in 
each table cell.

Parameter Type Description

Group Path String The grouping configuration to use.  This will limit the scope of this function 
to the specified grouping.

Sort Field String A field to sort the records by within the group.  This will determine the 
order that the columns will appear in.

Cross Field String The field that should be used in each column of the table.

Search Field String The field value to find in the 'Cross Field' field

Value Field String The field to use in the table

Empty Value String The value of this parameter will be used if the Search Field cannot be 
found.

The 'GROUPCROSSTABLEVALUE' function is used to determine the value that should 
appear at each intersection of the table.  This function should be used in conjunction 
with the 'GROUPCROSSTABLEHEADER' function to determine the cross references.

Field Name Custom Field

col1value GROUPCROSSTABLEVALUE('product code','','colour','col1','price','-')

col2value GROUPCROSSTABLEVALUE('product code','','colour','col2','price','-')

col3value GROUPCROSSTABLEVALUE('product code','','colour','col3','price','-')

In essence, this function is searching the 'colour' field for the value shown in the 
'col1'/'col2'/'col3' field. When found, the value in the 'price' field will be used; if it's not 
found then the literal value of the last parameter will be used ('-') instead.

In this example, we want to restrict the search for colours to a single product, so have 
specified 'product code' as the group path.

Using a combination of these two commands gives the following result in the panel:

This data panel can now be used to create a table such as:
PRODUCT CODE RED BLUE GREEN
AAA123 $10.00 $20.00 $20.00
BBB321 $15.00 - $25.00

Using EasyCatalog's Table Column Options, any empty columns can be deleted after 
populating the table.  So, for example, if one group only has two colours the third, 
empty, column could be deleted.
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UTILITY FUNCTIONS

SNIPPETDEPTH/SNIPPETWIDTH

Returns the depth or width in points of the given snippet.  The path provided for 
the snippet file can either be a fully qualified path or, if just the filename is provided, 
EasyCatalog will look inside of the workspace 'Assets' folder.  Any Field Specifiers in 
the snippet will be populated with data for each record; Pagination Rules such as fitting 
to content will also be applied.

Parameter Type Description

Filename String The filename of the snippet to measure

SNIPPETDEPTH('Snippet 1.idms')

SNIPPETDEPTH('Macintosh HD:Users:InDesignUser:Snippet 1.idms')

GROUPSNIPPETDEPTH

Returns the depth in points of the given snippet.  The path provided for the snippet file 
can either be a fully qualified path or, if just the filename is provided, EasyCatalog will 
look inside of the workspace 'Assets' folder.  

Unlike SNIPPETDEPTH, GROUPSNIPPETDEPTH will populate the snippet with data for 
the each group (as definied by the group path).

Parameter Type Description

Group Path String The grouping configuration to use

Sort Field String The name of the field to sort the records by in the group..

Filename String The filename of the snippet to measure

Example:

GROUPSNIPPETDEPTH('Parent Category:Child Category','Price', 
'Snippet 1.idms')

GROUPSNIPPETDEPTH('Parent Category:Child Category','Price', 
'Macintosh HD:Users:InDesignUser:Snippet 1.idms')

GOOGLEQRCODEURL

Generates a Google Charts URL which will generate a QRCode with the given content.

Parameter Type Description

Width Integer The required width of the QR Code image in pixels (maximum 500).

Height Integer The required height of the QR Code image in pixels (maximum 500).

Text String The content to encode within the QR Code

Example:

GOOGLEQRCODE(500,500,'http://www.65bit.com')

CALLSCRIPT

This function will return the result of executing the ExtendScript in the given file.

Parameter Type Description

Filename String
The name of the ExtendScript file to execute.  This can either be the full 
path to a script or, if the script is stored in the 'Scripts' data source folder, 
just the filename.

Example:

CALLSCRIPT('myscript.jsx')

The script itself will be passed the contents of the other fields for this record in an array 
called 'myRecord'. An example script to concatenate the contents of "field b" to "field 
a" would be:

myRecord["field a"] + myRecord["field b"];

DOESIMAGEEXIST

Tests to see whether an image exists for the given field.  The specified field's picture 
field options will be used to determine the path to the image.

Parameter Type Description

Field Field The name of the image field

Example:

DOESIMAGEXIST('mypicturefield')
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If the image exists this function will return TRUE; if it doesn't the function will return 
FALSE.

GETNTHPOPULATEDPARAM

Returns the n'th non-empty parameter.

Parameter Type Description

Field Index Integer The index of the parameter to return, starting from zero.

Example:

GETNTHPOPULATEDPARAM(0,'a','','c','d','','e')

GETNTHPOPULATEDPARAM(0,'a','','c','d','','e')

a
 

GETNTHPOPULATEDPARAM(1,'a','','c','d','','e')

c

XREFFIELD

This function will search the data source for a record whose field content matches a 
given value, and will return the value of another field for the found record.

Parameter Type Description

Search Field Field The name of the field to search in

Search Value String The value to search for in the 'Search Field'

Return Field Field The name of the field to return from the matching record.

Data Source String

(Optional) The name of another EasyCatalog data source to search 
within. This option applies to the Search Field and Return Field 
parameters; the Search Value will be retrieved from fields in the current 
data source.

Example:

XREFFIELD('PartNo',FIELDSTR('XRefPartNo'),'Page')

This example will search for a record whose 'PartNo' field contains the value of this 
record's 'XRefPartNo' field. When one is found, the contents of its 'Page' field will be 
returned.

EVALUATEXPATH

Evaluates an XPath expression using the XML fragment in the given field.

Parameter Type Description

Field Field The name of the field containing the XML fragment to evaluate

XPath String The XPath to evaluate

Separator String It the XPath evaluates to multiple nodes, the values will be separated 
by the string specified here.

Example:

EVALUATEXPATH(Options, '//Option1/@col1', ',')

APPLYXSLT

Applies an XSLT transformation to the XML fragment in the given field.

Parameter Type Description

Field Field The name of the field containing the XML fragment to apply the XSL 
transformation to.

XSL Filename String
The name of the XSL transformation to apply.  The XSL transformation 
file should be stored in the 'XSLT' folder inside of the workspace 
folder for the data source.

Example:
APPLYXSLT(Options,'myxslt.xsl')
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Example XSLT
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
 <xsl:template match="/">
  <html>
   <body>
    <table>
     <xsl:for-each select="//Option1[position() = 1]">
      <tr>
       <th><xsl:value-of select="@col1"/></th>
       <th><xsl:value-of select="@col2"/></th>
      </tr>
     </xsl:for-each>
     <xsl:for-each select="//Option1[position() &gt; 1]">
      <tr>
       <td><xsl:value-of select="@col1"/></td>
       <td><xsl:value-of select="@col2"/></td>
      </tr>
     </xsl:for-each>
    </table>
   </body>
  </html>
 </xsl:template>
</xsl:stylesheet>
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